Canon

RAW Image Processing, Viewing and Editing Software

Digital Photo Professional
Ver. 3.10
Instruction Manual

Content of this Instruction Manual

DPP is used for Digital Photo Professional.

In this manual, the screens used in the basic
operation instructions are from Windows 7, with
some portions using screens from other
versions of Windows.

» indicates the selection procedure of the menu.

Example: [File] menu » [Exit].
Square brackets are used to indicate items such

as menu names, button names and window
names that appear on the computer screen.

Text inside < > indicates a key on the keyboard.

**indicates a reference page.
Click to move to the relevant page.

"2 : Marks helpful information when a problem
arises.

U@/
@ : Marks information that should be read

N1/
I

before use.

Marks additional information you may find
helpful.

: Marks tips for using the software skillfully.

Switching Between Pages

Click on arrows on the bottom right of the screen.

@ : next page

€D : previous page

: return to a page you had previously
displayed

Click on the chapter headings on the right side
of the screen to switch to the contents page of
that chapter. Also, click the item you want to
read about on the table of contents to move to
the relevant page.

Help and Shortcut Keys

For information about using DPP, refer to Help
from the [Help] menu.

Refer to the [Troubleshooting] » [Shortcut Key
List] in the Help for a list of shortcut keys which
are helpful for quick operation.
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Introduction

Digital Photo Professional (hereinafter, “DPP”) is a high-performance
RAW image processing, viewing and editing software for EOS DIGITAL
cameras. It is often thought that RAW images are difficult to handle
compared with ordinary JPEG images, but using DPP, you can perform
advanced edits and print RAW images with ease.

RAW Images and Their Features
What is a RAW Image?

A RAW image is image data that has recorded output data of imaging
sensor. Because image processing does not occur inside the camera
when a photo is taken and the photo has been recorded in the special
form of “RAW image data + Image processing conditions information at
the time of shooting”, special software is needed to view or edit the
image.

* “RAW” means “in a natural condition” or “not processed or refined”.

What is RAW Development?

If described in terms of film, the concept of a RAW image is a shot
image not yet developed (latent image).

With film, the image appears for the first time when it is developed. In
the same way, for RAW images too, you cannot view them as images on

your computer unless you perform subsequent image signal processing.

Therefore, even though it is digital, this processing is called
“development”.

When is RAW Development done?

DPP automatically carries out this “development” processing when
RAW images are displayed in DPP.

As a result, RAW images displayed in DPP are images whose
development processing has been completed.

With DPP, you can view, edit and print RAW images without having to be
particularly conscious of the development processing.

What Advantages Does a RAW Image Have?

RAW images are recorded in the format “RAW image data + Image
processing conditions information at the time of shooting”. When you
open a RAW image in DPP, the image is automatically developed and
you can view the image as an image to which image processing
conditions at the time of shooting have been applied.

Even if you perform various adjustments to the image you have opened
(it undergoes automatic development processing each time), only the
image processing conditions (development conditions) change and the
“original image data itself” remains unaffected. Consequently, image
deterioration is not a problem and it is the perfect image data for users
who want to get creative with their images after they have been shot.
In DPP, the “Image processing conditions information” that can be
adjusted is called a “Recipe”.
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Main Features of DPP

Following are the main tasks you can perform with images you have
downloaded to your computer.

View and organize RAW images

Real-time adjustment of a RAW image

Various image adjustments while maintaining the original image
Freely apply a Picture Style
View your image before and after adjustment in the same window

Trimming and adjusting the angle of an
image

Change image size

Correction of lens aberration
Automatic/manual dust erasure processing

Convert from a RAW image to a JPEG or

TIFF image and save
Process large numbers of RAW images in batches
Transfer the image to image editing software

Print a RAW image
View and organize JPEG and TIFF images

Real-time adjustment of JPEG and TIFF
images
Various image adjustments while maintaining the original image

Print JPEG and TIFF images

Color management compatibility
CMYK simulation for commercial printing

System Requirements

Introduction

oS Windows 7*1, Windows Vista*2
Windows XP Professional/Home Edition*3
PC with one of the above OS preinstalled Contents at
Computer | . Upgraded machines not supported a Glance
CPU 1.3GHz Pentium or higher*4
RAM Minimum 1GB*® Basic
Disbla Screen resolution: 1024 x 768 pixels or more Opsration
play Color quality : Medium (16 bit) or more
*1 Compatible with 32-bit/64-bit systems for all versions except Starter Edition Advanced
*2. Compatible with 32-bit/64-bit systems for all versions except Starter Edition Operation
*3 Compatible with Service Pack 3
*4 Core2 Duo or higher is recommended Advanced
*5 For Windows 7 64-bit systems, minimum 2GB Image Editing
and Printing
Supported Images S
This software supports the following image types. Large Numbers
of Images
Image type Extension
RAW images* shot with EOS DIGITAL cameras, .CR2 Editing
RAW images | excluding EOS DCS1 and EOS DCS3 TIF JPEG/TIFF
RAW images*2 shot with PowerShot cameras .CRW Images
JPEG images E%(ggig, 2.21 or 2.3-compatible JPEG JPG, .JPEG
: : : : Reference
TIFF images | Exif-compatible TIFF images .TIF, .TIFF
*1 Compatible with RAW images shot with EOS D6000 or EOS D2000
that have been converted to RAW images using the CR2 Converter
and have the “.CR2” extension. el

*2

For information on CR2 Converter, refer to Canon’s web site.

* Only models where Digital Photo Professional is listed in the “Data Type”
item in the “Specifications” section near the end of the Camera User Guide.

* Use the dedicated CameraWindow application to download images from a
PowerShot camera to a computer. See the Software Starter Guide for details.

* Lens aberration correction can only be used with some camera and lens models.

» Automatic dust erasure processing and other EOS DIGITAL specific
functions cannot be used.

* RAW images shot with the PowerShot Pro1 are also supported, but
they cannot be edited with the DPP RAW image adjustment function.
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Downloading Images to Your Computer Erase dust shot with the image - p.69, p.71
Download images by connecting your cameraand ~ _, 0.7 Erase unwanted parts of an image = p.73 Contents at
computer ' Auto correct RAW images with the Auto Lighting Optimizer =» p.61 a Glance
Download images using a card reader =p9 Adijust brightness of shadows/highlights - p.57
— . Reduce image noise - p.62 . Bi:zit? .
Viewing and Checking RAW Images Correct lens aberration = p.63 Skt
Quickly enlarge parts of an image =>p.11 Use a Picture Style file - p.59
Sort images (check marks, rating) =»p.18, p.19 Edit efficiently - p.34 Advanced
. . . ’ Operation
Display an image shot simultaneously as a RAW - p.22 Edit an image while comparing the image before and
image and JPEG image as a single image after adjustment = p.53
Display the images in the thumbnail list display at high ; Nl i Advanced
resolution - p.23 Synchronize multiple images - p.54 Image Editing
L . . Display an area beyond the set range as a warning and Printing
Check shooting information such as the shooting date =» p.10, p.23 indicator (Highlight/Shadow warning) =¥ p.55
L. . . Restore an adjusted image to its condition at the time - D43 Processing
Editing RAW Images (Adjusting) of shooting P- La;sf!m:ggsers
Adjust brightness/darkness = p.12, p.26 L —
Use automatic adjustment - p.33 Printing Editing
Change the Picture Style = p.26 Print well on a Canon printer =» p.43, p.76, p.77 JITEG/TIFF
Sharpen the modulation and contrast of colors . . mages
(contrast) - p.29 \Ilzvilg:]ftrj)l:)i/n:&pgroduce the color of the subject - p.43,p76, p.77 —
Make skin tone look healthier (color tone) =>p.29 Print with the shooting information - p.74 S
Make the image colors more vivid (color saturation) = p.29 Print a thumbnail list of images -p75
,'leke an Image stharp i(shar;l)ness) wral < p3 Approximate the color seen on screen with your =082
just an image to make color tone more natura rinting results -
(white balance) = p.27 g J Index
Change an image to black-and-white or sepia tones Conversion of Images e
(monochrome) = p.30
. . . ) Convert a RAW image to a JPEG image ->p.42, p.88
Trim an image and adjust the angle of an image = p.38 Edit in Photosh > 073, 0.89 @ @
it in Photosho .73, p.
Specify an aspect ratio that matches the size of the - .38 P _ P P
paper on which an image is to be printed P Perform batch processing = p.88 @‘
Edit (adjust) a JPEG image =>p.92 —
‘ % “'C; y .;;\Z “, > 7, ,‘ 4




1 Basic Operation

The basic operational flow — from how to download to your computer
images shot with a camera to checking, editing, saving and printing a
downloaded RAW image — is explained here.

)
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Starting up DPP

Introduction

Double-click the desktop icon. Main Window Display
| ' In the main window, you can use tabs to select either the [Folder]
Double-click window or the [Collection] window. The [Folder] window displays the C:'(';tfa";zeat
& : images in folders on your computer, while the [Collection] window (p.36)

displays images selected randomly by the user from one or more folders
and gathered together.

Unless noted otherwise, the [Folder] window will be described as the
main window from this point on.

[Folder] window Advanced
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Downloading an Image to Your Computer
EOS Utility

I, EOS Utility

Connect the camera and computer with the cable provided and
download the images saved on the memory card inserted in the camera.
For downloading images, start up the camera software “EOS Utility”
from DPP and use.

Select the save destination for the images.
Select the save destination in the folder area on the left of the
main window.
When creating a folder, refer to p.50.

ital Photo Professional -

I File Edit View Boockmark Label Adjustment Tools indow Help

Select all Clear all Rotste left  Rotate right

Folder Collection{0)

Bl Desktop
5 Libraries
‘=] Documents
1 Music

‘e

Connect your camera and computer and turn the

camera on.

Control Camera

Monitor Folder

Accessories

Preferences...

. sample Pictures

Start up EOS Utility.

Connect the camera and your computer with the interface cable
provided with the camera and turn the camera on.

For detailed instructions on connecting your camera and
computer, refer to the “EOS Ultility Instruction Manual” (PDF
electronic manual).

Select the [Tools] menu » [Start EOS Utility].

Tools

Start Quick check tool Alt+Q
Start Trimming/Angle Adjustment tool Alt+C
Start Stamp tool Alt+5
Start Rename tool Alt+R

[ startEOS Uil Alt+0
Sync folder with EQS Uiility
Transfer to Photoshop Alt+P
Preferences... Ctrl+K

EOS Utility starts up.

The capture window for EOS Ultility appears.
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Click the [Main Window] button.
B o oo =]

-
F

(=13

8] s |
m =100
- em RO
]
o 5 (17 | & ]
Standard
3.0,0,0
r Defined style
0,0

Paripheral illumin. comect.

Live View shoot. ..

Other Functions. .

The main window for EOS Utility appears.

Download images.

I, EOS Utility - EOS XXX
|

Starts to download images CIiCk

Lets you select and download images

Control Camera

Camera settings/Remote shooting

Monitor Folder

Preferences

Downloading of images begins.
The downloaded images are saved in the folder selected in step
1 and are displayed in the main window of DPP.

The downloaded images are sorted by date into folders and
saved.

-Z\@E Advantages of using EOS Utility to download images

Using EOS Utility to download images makes it easier to organize your
images as they are downloaded, sorted and saved into folders by date.

5

You cannot start up EOS Utility in the [Collection] window
(p.6, p.36).
When EOS Utility has been started up from DPP, you cannot use
the following functions.
* Quick check window view (p.16)
* Trimming and adjusting the angle of an image (p.38, p.100)
* Dust erasure processing (copy stamp function)
(p.69 to p.73, p.103 to p.107)
* Batch change file names (rename function) (p.90)
* Printing with shooting information (p.74)
* Printing a thumbnail list (contact sheet printing) (p.75)
* Printing using Easy-PhotoPrint EX or Easy-PhotoPrint
(Plug-in printing) (p.43, p.46)
* Transferring images to Photoshop (p.73)
* Batch saving images (batch processing) (p.88)
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Downloading Images Using Your Card Reader

You can also download images to the computer using a third-party card
reader.

Load the memory card into the card reader.

Open [My Computer] » [EOS_DIGITAL] and drag the
[DCIM] folder to the [Desktop].

@ Digita! Photo

Adjustment Tools Window Help

The [DCIM] folder is downloaded to your computer.
All images are saved in folder units inside the [DCIM] folder.

Display the images downloaded to your computer.
In the [DCIM] folder copied to your desktop, select the folder
where the shot images are saved.

=3 Floppy Disk Drive (A)
1 Local Disk (G
£ DVD RW Drive (D)
dowsT_0S (E)

B in, £

El e EOS_DIGITAL (F:)
B )0 DCIM

€l Network

=]
100CANON|

102CANON

Images in the folder are displayed in the main window of DPP.

Y
N

== Checking before downloading images

By selecting the memory card folder directly in DPP, the images in the
folder are displayed in DPP and you can check the shot images.

@ Copying to your computer may take time when there is a large
number of shot images saved in the memory card.
For details on the [DCIM] folder structure and the file names of
shot images, refer to “Folder Structure and File Names in the
Memory Card” in the “EOS Utility Instruction Manual” (PDF
electronic manual).
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Viewing an Image
Images downloaded to your computer are displayed as a thumbnails list

in the main window. You can double-click an image to open the edit
window and display the image at large size.

View Images as Thumbnails in the Main Window

. . Rotate selected image
Main window

...........

SRGS [ Adobe RGS

Click to select the image
Display thumbnails of all the images inside the
folder selected in the folder area on the left

® Images displayed with the ["® ] icon are movie files and cannot
be played back in DPP. Please use “ZoomBrowser EX”, which is
compatible with EOS DIGITAL movie files.
If the message [Insufficient memory.] appears, there are too many
images in one folder. Decrease the number of images in one
folder such as by dividing them into smaller folders.

|§| When aspect ratio information is attached to the shot image with the
EOS-1D Mark IV, EOS-1Ds Mark Ill, EOS-1D Mark Ill, EOS 7D, EOS
60D or EOS 600D, the image is displayed as a trimmed image (p.38,
p.100).
For a list of main window functions, refer to p.112.

Changing the Size of Thumbnail Images

You can change the size of the thumbnail images displayed in the main
window and display them with shooting information attached.

Select the [View] menu » desired item.

View

Edit in Edit image window Ctrl+Right Arrow
View collections Alt+G

Tool palette Chrl+T
Tab

Folder view

Toolbar

Rating Ctrl+0

ol NN RN

Large thumbnail Ctrl+1
@  Medium thumbnail Crl+2
Small thumbnail Ctrl+3

Thurmbnail with information Ctrl+4

Sort >

The display changes to the selected item.
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Enlarge and View an Image in the Edit Window Enlarging and Viewing a Specific Area
Double-click the area you want to enlarge.

06L.CRa] S0

T R I Double-click
— e
-

The edit window appears.

Tool palette

o — The area you double-clicked is enlarged to 100% (actual pixel

size). If you wait for a while, it changes to a clearer display.
Double-click again to revert to the full view.

To change the display position, drag on the image or drag the
enlargement display position of the tool palette.

Tool palette enlargement display position

Change the enlargement
display position by
dragging

It may take time for the image to redraw itself.
Click the [[g]] in the upper right of the edit window to close the
edit window.

|§| By selecting the [View] menu P [AF Point] in the edit window, you can

display the AF points selected in the camera at the time of shooting.

However, AF points are not displayed for images whose image size

has been changed and then been converted and saved (p.42, p.121), N . . . . 0
images for which you selected an effect other than [Shot settings] as @< To display an image in an enlargement ratio other than 100%
correction of fisheye lens distortion aberration, or images which have Select the [View] menu » [200% view] or [50% view].

had settings specified during RAW processing on the camera for

distortion correction and chromatic aberration correction.

For a list of edit window functions, refer to p.115. @ You can change the enlargement ratio when you double-click (p.80).
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Adjusting an Image o
You can perform a variety of image adjustments, such as adjusting the
brightness or changing the Picture Style of an image using the tool About the Tool Palette
palette of the edit window. You can easily restore an image to its original You can adjust images with the tool palette by switching between the
settings with the [ ]] button even if you have made the wrong [RAW], [RGB] and [NR/Lens/ALO] tab sheets according to your editing Cg'gfa"'fgeat
adjustment. Try out the various adjustments. requirements.
As an example, the procedure to adjust the brightness of an image is Because adjustment made with the tool palette (it undergoes automatic
explained here. development processing each time) only changes the image processing
conditions, the “original image data itself” remains unaffected.
Tool palette Therefore, there are no problems with image deterioration that arise with
e editing and you can readjust your images any number of times.
—— — =] Reverts the image to See Chapter 2 onwards for more detailed information on the various Advanced
| Brightness adjustment . . . Operation
the original settings functions of the tool palette.
0.00
' white balance adjustment [E= || Drag the slider left or
e = = right . Ad d
Shot settings hd Tune... inti
: In DPP, all the adjustment contents (image processing conditions and Printing
[rcture ste =) information) made with the tool palette is saved to an image as data 5 :
=] “ C rocessing
(e jfr— | called a “Recipe” (p.85). e i
' of Images
Editing

JPEG/TIFF

/ Images

-10.0 8.0 60 40 -20 00 20 40
Dl i Reference
Highlight: (0} il
Shadow: (D) 1
|_' Linear

Color tone:{0) {1
Color saturation: (0) { Index
|Unsharp mask - |

Strength:(0) 0

Fineness:{0) 0

Thresheld: (0) 0 @ @

The image brightness changes in real time according to the

amount of adjustments. @

2 The tool palette d t displ
= © tool paletie does not cisplay @ For a list of tool palette functions, refer to p.116.

Select the [View] menu » [Tool palette]. 12



Saving an Image

If you perform the save operation described here, you can save all the
adjustment contents (recipe) made with the tool palette to the RAW
image.

Select the [File] menu » [Save].

File
[ Save Ctrl+5 )
Save As... Ctrl+5Shift+5
Convert and save... Ctrl+D
Print... Ctrl+P
Print with detailed setting... Ctrl+Alt+P
Contact Sheet Prints... Ctrl+Shift+P
Plug-in printing 2
Info Ctrl+I
Close Chrl+W

Your adjustment contents (recipe) are saved to the image.

Saving

With DPP, you can perform the following types of saving according to
your requirements. For detailed information on each saving method,
refer to Chapter 2 onwards.

Save (p.41)

Add adjustment contents (recipe) made with the tool palette to a RAW
image and save.

Save as (p.41)

Add adjustment contents (recipe) made with the tool palette to a RAW
image and save as a separate RAW image. The original RAW image
remains unaffected.

Add thumbnail to image and save* (p.23)

Create a new thumbnail image for the main window and save to each
image.

The quality of images in the main window improves and images
redraw themselves more quickly.

Convert and save (p.42)

Convert adjusted RAW image to a JPEG or TIFF image and save.
The original RAW image remains unaffected.

Batch process (p.88)

Convert in batches adjusted multiple RAW images to JPEG or TIFF
images and save.

The original RAW images remain unaffected.

* Option available in the main window.
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Printing an Image

You can print images with a printer. As an example, the procedure to
print one image on one sheet of paper is described here.

Select the [File] menu » [Print].

File
Save Ctrl+5
Save As... Ctrl+5Shift+5
Convert and save... Ctrl+D
[ Print.. cuiep )
Print with detailed setting... Ctrl+Alt+P
Contact Sheet Prints... Ctrl+Shift+P
Plug-in printing 2
Info Chrl+1
Close Ctrl+W

The printer’s print settings dialog box appears.

Print.
Specify the optimum settings for photograph printing in the
printer’s print settings dialog box and click the [OK] button.
Printing begins.

Printing
With DPP, you can perform the following types of printing according to
your requirements. For detailed information on each printing method,
refer to Chapter 2 onwards.

Print one image (p.49)

Print using a Canon inkjet printer (p.43, p.46)

Print with a high-end Canon printer (p.76)

Print with shooting information (p.74)

Printing a thumbnail list (contact sheet printing) (p.75)

Exiting DPP

In the main window, select the [File] menu P [Exit].

File
Open in Edit window Ctrl+0
Open in Edit window (enlarged)
Save Ctrl+5
Save As.. Ctrl+Shift+5
Add thumbnail to image and save Ctrl+Shift+ T
Convert and save... Ctrl+D
Batch process... Ctrl+B
Create new folder...
Print... Ctrl+P
Print with detailed setting... Ctrl+Alt+P
Contact Sheet Prints... Ctrl+Shift+P
Plug-in printing
Add te collection Ctrl+G
Remove from collection Ctrl+Shift+G
Clear collection
Delete Del
Info Ctri+I
Exit Alt+F4

DPP exits.

@ A confirmation dialog box for saving the images appears when you
try to exit DPP without saving the adjusted image. Click the [Yes to
all] button to save the adjustment contents (recipe) to all the images

adjusted.
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D Advanced Operation

A more advanced operation — from efficiently checking images, to
various ways of editing an image, printing a RAW image using a Canon
printer and sorting images — is explained here.

Efficiently Checking/Sorting Images.........cccccc.oco... 16
Sorting IMages.......coooeeeiiiiiiieee e 18
Attaching Check Marks..........cccccceeeeeiiiicciiiiiieeeee. 18
Setting Ratings ........vvvveeiiieiiiiiiiiieeee e, 18
Sorting Images in the Main Window .......................... 19
Attaching Check Marks in the Main Window ......... 19
Setting Ratings in the Main Window ...................... 19
Arranging Images in the Main Window ...................... 20
Arranging by TYPE ..o 20
Arranging Freely ... 21
Displaying a RAW Image and JPEG Image as a Single
=T =SS PPPPPRRR 22
Improving the Quality of an Image in the Main Window ... 23
Checking Image Information.................ccccccuuvvnnneen... 23
Editingan Image ........ccooovviiiiii e 25
About the RAW Tool Palette...........ccccoovvvvvveeeeineennn, 25
Editing with the Tool Palette in the Main Window.. 25
Adjusting Brightness.........ccccceeeiiiiiiiiiiiiiieeeeeee e 26
Changing a Picture Style ..........cccccccooeoiiiiiiiiiiiiiiee. 26
Picture Style File..........ccoooiiieieeee 27
Adjusting Color Tone by Changing White Balance.... 27
Adjusting Color Tone Using Click White Balance...... 28
Adjusting Contrast ..........ccccieeiiiiiiiiie e 29
Changing Color Tone and Color Saturation............... 29
Adjusting Monochrome ...........ccccccveeiiciiieeeeece. 30
Adjusting Image Sharpness.........cccccoecceeeeeeiiiiienennnn 31

Detailed Setting of Image Sharpness..................... 32
Automatically Adjusting Brightness and Color (Tone
CUIrVe ASSIST) ... 33

Editing Efficiently ..., 34
Editing in the Edit Image Window............cccccovveeeeenen... 34
Changing the Thumbnail Display Position to a Horizontal
POSItION......uiiiiiiiiiee e 36
Gathering and Editing Images in the Collection Window ... 36

Trimming and Adjusting the Angle of an Image....... 38

Applying Adjustment Contents to Other Images...... 41

Saving Editing ReSults...........cccovvviiiiiiiiiiiiiiee e 41
Saving Editing Contents to a RAW Image................... 41
Saving as a JPEG or TIFF Image........ccccccveeeeeeeeeennne. 42

Re-Editingan Image........cccccoo i, 43

Printing an Image ..., 43
Printing Photographs with Canon Inkjet Printers
Compatible with Easy-PhotoPrint EX ........................ 43
Printing Photographs with Canon Inkjet Printers
Compatible with Easy-PhotoPrint............cccccccccooos 46
Printing Photographs with a Printer other than Canon
Inkjet Printers...........oooioiiii e 49

Organizing IMages ........cceeeeeiieiiiieeeeeeecee e 49
Deleting an Unwanted Image ..............cccccvivieeennnnennn. 49
Creating a Folder for Saving Images...........ccccvvvuueeee 50
MOVING IMAgES ......eveiiieiiiiiiie e 50
Moving Images in Folders ..............ccc 51
Registering Frequent-Use Folders (Bookmark
Registration) ..........ccccoooiiiiii e 51

Organizing Bookmarks ...........cccccccoeeeeiiciviveeeneen... 51
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Efficiently Checking/Sorting Images

You can enlarge images displayed as thumbnails in the main window Double-click the area you want to enlarge.

Introduction

and efficiently check each image. You can attach check marks and sort ‘ S —
images into five groups. |
Contents at
. ] . . a Glance
Dlsplay the qmck check window.  EaaamEe @ ¢ | Double-click ]
Click the [Quick check] button. =
Basic
Operation
7y )
1 Rotste right Quick Stamp Trimming Ad% ed
= El-'leclé = Angle Op ion
Rating & & » » = o
The area you double-clicked is enlarged to 50% view.
g ; P ; Advanced
% B To change the display position, drag on the image. Image Editing
_ _ Double-click again to revert to the full view. and Printing
The quick check window appears. To exit, click the [OK] button.
Click the [Next] or [Previous] button to switch Processing
. Large Numbers
between images to be checked. of Images
Quick check window —
R Editing
JPEGI/TIFF
ccccc Images
..... Reference
Index
} @ When [AF Point] is checkmarked, you can display the AF points @ @
_ selected in the camera at the time of shooting. However, AF points
All the images displaved in the main window can be checked in are not displayed for images which have had their image size changed @‘
9 piay and then been converted and saved (p.42, p.121), or which have had =

the quick check window. settings specified during RAW processing on the camera for distortion

correction and chromatic aberration correction. 16
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-@> Convenient functions of the quick check window

To check only selected images

You can use the quick check window to check only selected images
by selecting the desired images from those displayed in the main
window and then performing step 1.

Switch between images using the keyboard

You can also switch between images by pressing the <—> or <«>
key.

Switch between screens using the keyboard

You can also switch between full screen display/normal screen
display by pressing the <Alt> + <Enter> keys.

Operate using the menu

Each operation can also be performed with the menu which appears
when you right-click with the mouse on an image.

@ The enlargement ratio when an image is enlarged is half (50%) of
the 100% (actual pixel size).
You can change the enlargement ratio to 100%, when an image is
enlarged (p.80).
For a list of quick check window functions, refer to p.119.
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. . Introduction
Sorting Images Settlng Ratlngs .
Display the image you want to rate, and then click

You can sort images by attaching check marks or setting ratings

(indicated with [ ] marks) for each subject or theme. any one of the [ = ]. :%fanncszea
Rating —
Attaching Check Marks Basic
Display the image you want to attach a check mark Operation
to, and then click any one of [[%] to [=]. (=8 & & 8) — Click (changes to [ ] after

clicking [ = ])
Check mark . ; ) Advapced
The rating is set and an icon corresponding to the selected [ # ] Opegdtion

appears in the upper left of the window.

(Window shown with a rating of three [ ]) Advanced
Click To set [Reject], click the [Reject] button. Click the [Reject] button Image Editing
again to cancel. and Printing
The selected check mark appears in the upper left of the window. Rating icon
Processing
R : _ Large Numbers
Check mark e e of Images
Editing
JPEGITIFF
Images
_ _ _ Reference
: To cancel the rating, click the same [ # ] as when the setting was
Click the [Clear] button to remove the check mark. made on the right of the window.
Index

set to an image, it may not be possible to check the image
information in third-party software.

@ As the file structure of the image data is changed when a rating is @ @

|§| The values of check marks attached to images in DPP version 3.8 @
or earlier are maintained as they are. ﬁl You can also set ratings (including [Reject] setting) from the menu
You can also attach check marks from the menu that appears by that appears by right-clicking with the mouse on an image in the
right-clicking with the mouse on an image in the main window. main window.

18



Sorting Images in the Main Window

You can also sort images in the main window by attaching check marks
or setting ratings (indicated with [E4] marks) for each subject or theme.

Attaching Check Marks in the Main Window

Select the images you want to attach a check mark
to, and then click any of [+ ] to [] in the toolbar.

B ®9®» ® & & 2

Sckectal Cearall Rolate kot Robate rght Quick Stamp  Trimming
n

check

Click

—— Select

IMG_0002.CR2  [ros] IMG_0003.CR2

frame.

Check mark

@ MG 000LCR2 IMG_000Z.CRZ IMG_0003.CR2

Click the check mark in the toolbar again to remove the check
marks.

Setting Ratings in the Main Window

Select the images you want to rate, and then click
any of the [m] in the toolbar.

Click (changes to [E1] after clicking [H])

&N (S ) 7

— Select

IMG_000ZCR2  * IMG_D003.CR2 IMG_0004.CR2

The rating is set and an icon corresponding to the selected [Ei]
appears in the image frame.
(Window shown with a rating of three [E3] as an example)

vV ® O & 2

Rotate left  Rotate right

Stamp — Trimming Baich
Angle process

ating Je W W o o

Rating icon

IMG_0002.CR2 i IMG_0003.CR2 3 IMG_0004.CR2

@

To cancel the rating, click the same [Ei] as when the setting was
made in the toolbar.

[Reject] cannot be set with the toolbar. Set [Reject] with the
[Label] menu or the quick check window (p.18).
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=@> To select multiple images in the main window

Click on desired images while holding down the <Ctrl> key. To select
multiple consecutive images, click on the first image, and then click on
the last image while holding down the <Shift> key.

-Z\@/E To display more thumbnails in the main window

You can display a large number of images by setting the size of
thumbnail images to small (p.10). Then, by selecting the [View] menu »
[Rating] and removing check marks so that ratings no longer appear in
the image frame, you can display still more thumbnail images in the main
window.

@ The [Label] menu can also be used to attach check marks and set
ratings.
By selecting the [Edit] menu » [Check mark] or [Rating] » image
selection criteria, you can refine criteria for selecting
checkmarked or rated images.
You can display and change the rating settings set in DPP with
other bundled software and on the EOS 60D, EOS 600D, or EOS
1100D camera.
« EOS Utility version 2.9 or later:
Ratings set in DPP are displayed on image thumbnails in the
viewer window. However, [Reject] is not displayed and you
cannot change rating settings.
» ZoomBrowser EX version 6.6 or later:
Ratings set in DPP are displayed in the main window (Preview
Mode) and viewer window. You can also change rating settings.
* On an EOS 60D, EOS 600D, or EOS 1100D camera:
Ratings set in DPP are displayed in the playback screen. You
can also change rating settings. However, you cannot display or
change settings for [Reject].

Reversely, you can also display and change with DPP the rating
settings set for still images in ZoomBrowser EX version 6.6 or
later and on an EOS 60D, EOS 600D, or EOS 1100D camera.

Arranging Images in the Main Window

You can arrange images in the order of the types of check marks you
have attached to images, or in the order of date and time at which the
images were shot. You can also freely arrange images by moving them
individually.

Arranging by Type

Select the [View] menu » [Sort] » desired item.

Edit in Edit image window Ctrl+Right Arrow

View collections Alt+G

Tool palette Ctrl+T
v Tab

v Folder view

v | Toolbar

v Rating Ctrl+0

Large thumbnail Ctrl+1
®@  Medium thumbnail Ctrl+2
Small thumbnail Ctrl+3

Thurmbnail with information Ctrl+4

Sort M Rating: Descending order

Rating: Ascending crder

File name

Shooting Date/Time
RAW priority

Check markl

Check mark2

Check mark3

Check mark4

Check mark5

The images are arranged in the order according to the selected
item.
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Sort item

Rating: ascending
order

Rating: descending
order

File name

Shooting Date/Time

RAW priority

Check mark1 -
Check mark5

Description

Sorted in order of fewest [« ].

Sorted in order of most [ ].

Images are sorted by file name in alphanumeric
order (0to 9 = Ato 2).

Images are sorted by shooting date and time
from the earliest.

Images are sorted in the following order: RAW
images - JPEG images — TIFF images.

Images with check marks take priority and are
sorted in number order.

-:@/3 Check mark sorting order

When check marks from 1 to 5 have been set, the images are sorted as

follows:

Check mark1 selected: 1-2—->3->4-5
Check mark2 selected: 2>3->4->5->1
Check mark3 selected: 3-4->5->1->2
Check mark4 selected: 4-5->1->2-3
Check mark5 selected: 5»>1-»2->3->4

Arranging Freely

Drag and drop the image to the desired location.

Nomber ofseisctedmges: 1

The image moves to the desired location.

You can also select multiple images (p.20) and move them.

The order of rearranged images is maintained until you exit DPP
or select another folder in the folder area.

Select the [View] menu » [Sort] » [File name] to revert to the
order before the images were rearranged.

Ny

5@5 Maintaining the order of rearranged images

You can maintain the order of rearranged images even if you exit DPP
or select another folder in the folder area.
Maintain order without changing image file names
You can use the [View settings] tab sheet in the [Preferences] to
maintain the order of images without changing the image file names
(p-80).
Maintain order and change image file names
You can use the rename function to maintain the order of images and
change the image file names all at once in the order they were
rearranged (p.90).
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Displaying a RAW Image and JPEG Image as a Single Image

You can display and handle a RAW image and JPEG image shot
simultaneously as a single image. In particular, you can halve the
number of images displayed in the main window and you can streamline
the checking of a large number of images shot simultaneously.

Select the [Tools] menu P [Preferences].

Select the [View settings] tab sheet and checkmark
[Display only CR2 images for CR2 and JPEG files of
the same name].

| General settings l | View settings ‘l Tool palette | Color management |

Grid pitch

84 Pixels(8-258)

Image selection status

[¥] images opened in Edit window remain selected in main window

Magnification in Edit window

@ Fit to window 50% _) 100% 200%

Magnification when the Edit/Edit image window is double-diicked

) 50% @ 100% ) 200%

RAW and JPEG

[ [C1Display, only CR2 images for CR2 and JPEG files of the same name: ]

Sort order in main window

[T Retain sort order

Highlightshadow Alert
Highlight 255 (192-255) -
Shadow 0 (0-64) -

Quick check toal display

9 50% ) 100% {moiré reduction off)

OK Cancel

The main window display updates and the simultaneously shot
RAW image and JPEG image are displayed as a single image
with the [GZXB] mark (p.114).

? RAW images with the extension “.CR2” can be displayed as a
single image

Images that can be displayed as a single image are images shot with a
camera that shoots RAW images with the extension “.CR2” and JPEG
images simultaneously. Images that have been simultaneously shot with
a camera that shoots RAW images with the extension “.CRW” or “.TIF”
cannot be displayed as a single image.

—I@/i- When a single image is displayed

Image displayed

The RAW image is displayed in all windows.

Edited image

The content which has been adjusted with any of DPP’s functions (the
tool palette etc.) will be applied to the RAW image only.

However, if you have used the following functions, the adjustments
will be applied to both the RAW image and the JPEG image.

* Deleting an image (p.49)

* Moving or copying an image (p.50)

» Checkmarks (p.18, p.19)

* Rating (p.18, p.19)

* Rotating an image (p.112, p.119, p.120)

+ Attaching a thumbnail to an image and saving (p.23)

Images added to the [Collection] window

When you add a RAW image and JPEG image displayed as a single
image to the [Collection] window, the single image is marked with the
[ 23] mark. However, because the RAW and JPEG images are
actually added individually, the number of images shown on the
[Collection] tab sheet increases by 2 (p.113).

@ In step 2, if you uncheck [Display only CR2 images for CR2 and
JPEG files of the same name], the RAW image and JPEG image
are displayed as separate images.

Introduction

Contents at
a Glance

Basic
Operation

Advanced
Image Editing
and Printing

Processing
Large Numbers
of Images

Editing
JPEGI/TIFF
Images

Reference

Index

00
©

22




Improving the Quality of an Image in the Main Window
Create a new thumbnail image for the main window and save to each
image.

The quality of images in the main window improves and images redraw
themselves more quickly.

With all the images selected, select the [File] menu »
[Add thumbnail to image and save].
File

Open in Edit window Ctrl+O

Open in Edit window (enlarged)

Save Ctrl+5
Save As.., Ctrl+Shift+5

[ Add thumbnail to image and save Ctrl+Shift+T ]
Convert and save... Ctrl+D)
Batch process... Ctrl+B

Create new folder...

Print... Ctrl+P
Print with detailed setting... Ctrl+Alt+P
Contact Sheet Prints... Ctrl+Shift+P
Plug-in printing 3
Add to collection Ctrl+G
Remove from collection Ctrl+5Shift+G

Clear collection

Delete Del

E\@/E The extent of the improvement in quality

The quality is improved for any JPEG or TIFF image. While the image
quality improves regardless of the thumbnail size (p.10), selecting [Large
thumbnail], with its larger display size, shows the improvement more
clearly than [Medium thumbnail] and [Small thumbnail].

@ A large number of images may take some time to add.

Checking Image Information

Select the image for which you want to check the
image information.

Click the [Info] button.

igital Photo Professional - [EX S\CA \Pictures\Photo'x

ile Edit Wiew Bookmark Label Adjustment Tools Wi

2@® ®®

Selectall

=) Documents

The image information window appears (p.24).
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Select a tab sheet and check information.

IMG_0001.CR2

-'| Shooting Information |Memdata|

[Shooting Information] tab sheet
=

[Metadata] tab sheet

Item

File Name

Camera Model
Firmware

Shooting Date/Time
Owner's Name
Shooting Mode

Tw{ Shutter Speed )
Av( Aperture Value )
Metering Mode
Exposure Compensation
IS0 Speed

Auto ISO Speed
Lens

Value

IMG_0001.CR2

Canon EQS XXX

Firmware Version Xxx
FOOOL AR A A K|

Shutter-Priority AE
1/1600

8.0

Evaluative Metering

a

400

OFF

EF70-200mm ff4L USM

m

Focal Length 188.0mm
Image Size HRA K
Image Quality RAW

Flash Off

FE lock QFF

White Balance Mode Auto

AF Mode Manual focusing
Picture Style Landscape
Sharpness 4

Contrast o

Saturation a

Color tone 0

Color Space sRGE

Long exposure noise reduc... :Off

High 150 speed noise redu... 0:5tandard
Highlight tone priority 0:Disable

Auto Lighting Optimizer 3:Disable
Peripheral illumination corr...  Disable

Dust Delete Data No

File Size HRRA KB i

IMG_0001.CR2 =

([ shooting nformon | Metacta |

[Desmpn‘on

|

[Document Title]
RHREHAHH

[Authar]
KA

[Author Tite]
X

[Description]
KN

[Description Writer]
KN

[Keywords]
XXHHHKIH

[Copyright Status]
KO

[Copyright Notice]
Peessvess

[Copyright info URL]
KN

-

Shooting information is displayed in the [Shooting Information]
tab sheet, while IPTC* information appended to the image in
Photoshop CS3 or later after shooting is displayed in the
[Metadata] tab sheet. IPTC* information provides additional
comments on images, such as captions, credits and the shooting
location. The information is sorted into 5 different categories and
can be viewed by selecting [Description], [IPTC Contact], [IPTC
Image], [IPTC Content] or [IPTC Status] from the list box in the
[Metadata] tab sheet.

* International Press Telecommunications Council (IPTC)

The contents of the [Shooting Information] tab sheet will vary
depending on the camera model.

B03
Switching displays
If a different image is selected in the main window when the image
information window is displayed, the image information for that image
will be displayed.

Difference with the [Thumbnail with information]

Detailed shooting information for each image is displayed in the
image information window. However, if you want to only check the
main shooting information, you can check it for each image in [View]
menu » [Thumbnail with information] (p.10).

Convenient uses in the main window
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Editing an Image

This section explains how to adjust an image using the tool palette in the
edit window.

You can easily restore an image to its original condition with the []
button even if you have made the wrong adjustment. Try out the various
adjustments.

How to make adjustments using the [RAW] tool palette functions, and
how to adjust automatically with the [RGB] tool palette are explained in
this section.

Edit window Tool palette

MG 000LCR2
Fie Edit = " [Re | persio]

The image changes in real time according to adjustments
performed with the tool palette.

To revert to the condition before the last operation performed on
the tool palette, select [Undo] in the [Edit] menu or press <Ctrl> +
<Z> keys.

|§| You can rotate an image in the [Adjustment] menu.
You can adjust an image while comparing the image before and
after adjustment (p.53).
You can synchronize multiple images and edit while comparing
them (p.54).
Refer to p.115 for a list of edit window functions, and p.116 for a
list of tool palette functions.

About the RAW Tool Palette

You can adjust images with the tool palette by switching between the
[RAW], [RGB] and [NR/Lens/ALO] tab sheets according to your editing
requirements.

Adjustments similar to those that can be performed with the functions of
your camera can be performed using the functions of the [RAW] tool
palette. When the camera settings were incorrect during shooting, or
when the shooting result is not what you visualized, you can get closer
to what you envisaged with the [RAW] tool palette which is similar to the
camera.

All functions other than [RGB] tool palette automatic adjustment, and
each function of the [NR/Lens/ALO] tool palette are explained in
Chapter 3.

Editing with the Tool Palette in the Main Window

By clicking the [Tool Palette] button (p.112) in the toolbar on the main
window, the same tool palette that appears in the edit window is
displayed and you can edit images.
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Adjusting Brightness

The brightness of an image can be adjusted. Move the slider to the right
to make the image brighter and to the left to make the image darker.

RAW [RGB [ NR/Lens/aLO| Reverts the image to

| Brightness adjustment (5 ]}+— the original settings
' I 0.00 Enter a numerical value
|White balance adjustment| |

@ 1 & 3 Register...

|5hot settings v| | Tune... |

Drag the slider left or right

@ The adjustment range is —2.0 to +2.0 (in 0.01-stop increments when
entering a value).

Changing a Picture Style

If the image you shot is different to what you visualized, you can change
the Picture Style to get closer to what you envisaged.

Even if you have saved the image (p.41) with [Monochrome] (p.30)
selected, you can still change to another Picture Style at any point by
simply selecting a Picture Style other than [Monochrome].

Reverts the image to
the original settings
Select

Picture Style

|Siandard

-10.0 80 60 40 -20 0.0 20 40
Contrast:(0) {1

Highlight: () {

Shadow: [D}_ 1
|| Linear

Caolor tone:({0) I

Color saturation:{0) {

|§| Even if the RAW image is from a camera that does not have
Picture Style settings, you can still set a Picture Style as long as
the RAW image is compatible with DPP (p.3).
You can retain the [Color tone], [Color saturation], [Contrast],
[Unsharp mask] and [Sharpness] settings, even if you change the
Picture Style (p.81).
[Auto] is only applied to images shot with the EOS 600D.
When changing a Picture Style with several images selected, you
can select [Auto] if images shot with the EOS 600D are included.
However, [Auto] is actually applied only to images shot with the
EOS 600D.
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Picture Style Description

Standard The image looks vivid.

Ordinarily, this setting is suitable for most images.

The color tone will be adjusted to suit the scene.
The colors will look vivid, especially for blue skies,
greenery, and sunsets in nature, outdoor, and
sunset scenes.

Auto

For nice skin tones.

Effective for close-ups of women and children. By
changing the [Color tone], you can adjust the skin
tone (p.29).

For vivid blues and greens.
Effective for making images of landscapes
impressive.

Portrait

Landscape

For natural colors and subdued images.
Effective for base images which are to undergo
adjustment.

Neutral

When the subject is photographed under a color
temperature of 5200K, the color is adjusted
colorimetrically to match the subject’s color.
Effective for base images which are to undergo
adjustment.

Faithful

For black and white images.
You can also adjust with [Filter effect] or [Toning
effect] (p.30).

Displayed when selecting an image shot with the
Picture Style file registered in the camera.

In the list, the name of the Picture Style file is
displayed in ().

The name of the Picture Style file applied in DPP
is displayed in [ ].

Monochrome

(Picture Style file
registered in the
camera)

[Picture Style file
applied in DPP]

Picture Style File

A Picture Style file is an extended function file of Picture Style. Refer to
p.59 for how to use Picture Style files.

Adjusting Color Tone by Changing White Balance

If the color tone of the photographed image does not appear natural,
change the white balance to make it appear natural. You can make the
color tone natural by setting the light source at the time of shooting an
image of, for example, pale-colored flowers.

RAW |RGB | NR/Lens/ALO|
| Brightress adjustment - |
(] 0.00
I|'n"'.|'hite balance adjustment =] Reverts the image to
2] G E = the original settings
|Shnt settings hd Tune... |
Select

? The color tone does not become more natural even when the
white balance is changed

If the color tone of the image does not appear natural after changing the

white balance, adjust the white balance using click white balance (p.28).

Ny

@< Tune with color tone

To make further fine adjustments to color tone after adjusting the white
balance, you can use [Color tone] (p.29) to get closer to your
requirements.

@ You cannot register the adjustment results as personal white
balance (p.87) when you have selected [Shot settings] from the list
box.

@ Refer to your camera’s Instruction Manual for details on each white
balance setting.

Introduction

Contents at
a Glance

Basic
Operation

Advanced
Image Editing
and Printing

Processing
Large Numbers
of Images

Editing
JPEGI/TIFF
Images

Reference

Index

00
©

27




Adjusting Color Tone Using Click White Balance

You can adjust white balance using a selected part of an image as the
standard for white to make the image appear natural. Using click white
balance is effective when using it in parts of an image where white color
tone has changed under the influence of a light source.

RAW |RGB | mRjLens/aLo| i
| Brightness adjustment [?”
I 0.00
White balance adjustment a”l
1 2 3 Register... Click
[Shot settings v] [ Tune... ]

Click on a point that is to be the standard for white.

CR2 ] szl (1 00t0cre )
A oo [ pensiao]
=]
0 om
[T &
DG el
Qoo ] [ |
Picture Stle [E3)]
sandart 5 D
!

\

Click
The coordinates of the cursor position and  Reverts the image
the RGB values (8-bit conversion) to the original

settings

The color of the image is adjusted with the point you selected as
the standard for white.

If you click on another point in the image, the white balance is
adjusted again.

To finish click white balance, right-click with the mouse or click

the [[# ]] button again.

? When there are no white areas in your image

When there are no white areas in your image, you can adjust the white
balance by clicking on a grey point of the image in step 2. This has the
same adjustment result as selecting a white point.

@ The image is adjusted based on the average value of 5 x 5 pixel
range from the clicked point.
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Adjusting Contrast

Modulation and degree of contrast can be adjusted. Move the slider to
the right to make contrast stronger and to the left to make contrast
weaker.

Reverts the image to
the original settings

|Picture Style (=

|513r1dard - | | Browse... |

-10.0 8.0 460 40 -Z0 0.0 Z0 40

Contrast:(0}——7F—— Drag the slider left or
Highlight: (0) right (9 steps)
Shadow: ()

| Linear
Color tone:({0)
Color saturation: (1)

IUnsharp mask vJ
Strength:(0) 1
Fineness:{0) [
Threshold: (0) 0

Displays the value of the setting

Ay

== [Linear] - A function for advanced adjustment

Use [Linear] when you will be adjusting separately using image editing
software that has advanced editing functions. Note that when [Linear] is
checkmarked, the image will become dim.

@ The Auto Lighting Optimizer (p.61) will not function when [Linear] is
checkmarked.

Changing Color Tone and Color Saturation

Skin tone and overall color saturation can be adjusted.
If Picture Style (p.26) is set to [Monochrome], [Color tone] and [Color
saturation] switch to [Filter effect] and [Toning effect] (p.30).

== Reverts the image to
the original settings

|Picture Style

|Siﬁndard A | | Browse... |

-0.0 80 60 =40 -20 0.0 20 4.0
Contrast:(0) {
Highlight: (1) 1
Shadow: (0) {

N | Drag the sliders left or
] right

|| Linear
Color tone:{0)

Color saturation:{0)——

[Unsharp mask VI
Strength:(0) D
Fineness:{0) [
Threshold: (3) 0

Displays the values of the settings

Color tone: Mainly used for adjusting skin tones. Move the

slider to the right to make skin tones more

yellow, and to the left to make skin tones

redder.

Color saturation: The overall color depth of the image is
adjusted with color saturation. Move the slider
to the right to make the color deeper, and to

the left to make the color weaker.

@ The adjustment range is —4 to +4 (in 1-stop increments).
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Adjusting Monochrome

When the Picture Style (p.26) is set to [Monochrome], you can create
monochrome photographs with effects similar to filtering and with the
look of a single-color photograph.

Select [Monochrome] in the [Picture Style] list box.

||Pict_|re Style =

|Monochrome

Reverts the image to
the original settings

v| | Browse... |

-10.0 8.0 -H.0 4.0 -20
Contrast:(0)

Highlight: {0}
Shadow:(0) {1 I
" Eﬁect!:'&j;::)ar | Drag the sliders left or
Toning effect:(Nane) D rlght
Unsharp mask vJ
Strength:(0) [
Fineness:(0) 1
Threshold: (1) [

Displays the values of the settings

Filter effect: Creates an image where the white of clouds and the
green of trees are emphasized in the same
monochrome photograph.

Filter Example of effect
None Ordinary monochrome image without filter effect.

Blue sky is reproduced more naturally and white

Yellow
clouds emerge clearly.
Orange Blue sky becomes somewhat darker. The
9 brightness of the setting sun increases further.
Blue sky becomes quite dark. Autumn leaves
Red .
become clear and bright.
Human skin tones and lips become softer. The
Green

green leaves of trees become clear and bright.

Toning effect: You can create a monochrome photograph to which a
single color has been added.
You can choose from [None], [Sepia], [Blue], [Purple]
and [Green].

:@3 Increase the [Contrast] to emphasize the filter effect

To emphasize the filter effect, set the [Contrast] slider closer to the right.
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Adjusting Image Sharpness

You can make the overall atmosphere of an image harder or softer.
Adjustment can be made by selecting from two modes, [Sharpness] and

[Unsharp mask].

[Sharpness]:

[Unsharp mask]:

[Strength]:

[Fineness]:

[Threshold]:

Controls the sharpness of an image by adjusting the
level of emphasis for the outline of the image. The
further to the right the [Sharpness] slider is moved (the
larger the setting), the more the edges are
emphasized for a sharper image.

Adjusts the image’s sharpness more finely.

Shows the level of emphasis for the outline of the
image. The further to the right the slider is moved (the
larger the setting), the more the image’s edges are
emphasized for a sharper image.

Shows the fineness of the emphasized outline. The
further to the left the slider is moved (the smaller the
setting), the more fine detail can be emphasized.
Sets “how much contrast difference there should be
compared to surroundings before emphasizing
edges”.

Select [Sharpness] from the list box and make the

setting.
||Pict|_|re Style (=
|5Endard v| | Browse... |

Contrast:{0)
Highlight: {0}
Shadow:(0)

|_' Linear
Color tone: (D)

Color saturation:{(0)

-10.0 4.0 6.0 -0 20 0.0 Z0 <40

1
]
0
i
{

Reverts the image to
the original settings

[Isharpness -

Sharpness|

|

Select [Sharpness]

Drag the slider left or right

Displays the value of the setting

@ The adjustment range is 0 to 10 (in 1-stop increments).
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Detailed Setting of Image Sharpness

Select [Unsharp mask] from the list box and make
the setting.

|Picture Style E]

[Siandard v][ Browse... ]

-10.0 8.0 6.0 40 -20 0.0 20 a
Contrast:{0)
Highlight: {0}

Shadow:(0)
[~ Linear

Color tone:(0)
Color saturation:{0)

([Unsharp mask

) |

b )
Strength@— L[
Fineness (IT
Threshold m

== i == L e R e B N T T T

Select [Unsharp mask]

Drag the slider left or right

Displays the values of the settings

? The effects of sharpness adjustment appear unnatural

Adjust image sharpness with the window view set to [200% view],
[100% view] or [50% view]. If the view is set to [Fit to window] (full view),
the effects of adjustment may seem unnatural.
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Automatically Adjusting Brightness and Color (Tone Curve Assist)

In order to make the image a desirable standard image, automatically
adjust the image tone curve (p.127). You can select the degree of
automatic adjustment from “Standard” and “High”.

Click on the [RGB] tab sheet and click the desired
automatic adjustment button.
Standard: Standard automatic adjustment. Suitable for most
images.
High: Use when the effect achieved in standard automatic
adjustment is not strong enough.

RAW' RGE 'NF‘.ﬂ.enszLD |

|T0ne curve assist l[ [ ﬂ E+1Ebll Reverts the tone curve
[Tone curve adjustment 5] to the original settings
[R]s][e] LA
2 High
Standard

Ju}

Brightness: {1 1}
Contrast: L| 1]
Hue: U @ a
Saturation: D 100
Sharpness: (I @ 0

The tone curve changes as adjusted.

Y

=Q> Images not suitable for automatic adjustment (tone curve
assist)

The result of automatic adjustment (tone curve assist) may not be as
expected with the following images:

* Images which have been shot with the proper exposure

* Images where the brightness is unbalanced

* Images which are too dark

* Images which have extreme backlighting

@ If you click the [[iZ%]] button, the tone curve as well as the [Hue] and
[Saturation] revert to the default settings. Take care when adjusting
the [Hue] and [Saturation] individually (p.96).
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Editing Efficiently
Editing in the Edit Image Window

The thumbnail display and the edit window are combined and images can
be edited efficiently while quickly switching between images to be edited.
Images to be edited are selected beforehand in the main window.

In the main window, select the images you want to edit.

Switch to the edit image window.

Digital Photo P i =

File Edit Miew Bookmark Label Adjustment Tools Wi

== i
Folder Collection{0)
B Desktop
=8 [ Libraries .
g;:l Documents y
Click

The main window switches to the edit image window.

Edit the image.

Change the size

Select the image to be edited
The selected image is displayed as an enlargement
in the middle of the window

It may take time for the image to redraw itself.

The same tool palette as in the edit window is displayed and you
can edit the image.

To revert to the condition before the last operation performed on

the tool palette, select [Undo] in the [Edit] menu or press <Ctrl> +
<Z> keys.

ﬁl By selecting the [View] menu » [AF Point] in the edit window or edit
image window, you can display the AF points selected in the camera
at the time of shooting. However, AF points are not displayed for
images whose image size has been changed and then been
converted and saved (p.42, p.121), images for which you selected
an effect other than [Shot settings] as correction of fisheye lens
distortion aberration, or images which have had settings specified
during RAW processing on the camera for distortion correction and
chromatic aberration correction.
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Double-click the area you want to enlarge.

0 (M @

Double-
click

The area you double-clicked is enlarged to 100% (actual pixel
size).

To change the display position, drag on the image or drag the
enlargement display position (p.116) of the tool palette.
Double-click again to revert to the full view ([Fit to window]).

To return to the main window, click the [Main window] button on
the toolbar.

-Z\@E To display an image in an enlargement ratio other than 100%

Click the [50% view] or [200% view] on the toolbar.

5

You can change the way the tool palette is displayed (p.81).

You can change the enlargement ratio when you double-click
(p-80).

With the edit image window, you can only select images from one
folder. To gather images from several folders for editing, refer to
“Gathering and Editing Images in the Collection Window” (p.36).
For a list of edit image window functions, refer to p.120.
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Changing the Thumbnail Display Position to a Horizontal Position

Select the [View] menu » [Change thumbnail
position].

Digital Photo.

\\\\\\

If you select [Change thumbnail position] again, the thumbnail
display reverts to the vertical position.

Gathering and Editing Images in the Collection Window

You can gather any randomly selected images together in the
[Collection] window for viewing, comparison and editing. You can gather
images from several folders as well as from only one folder, allowing you
to work with them efficiently.

Select images from the [Folder] window in the main

window, and select the [File] menu » [Add to collection].

File

Open in Edit window Ctrl+O
Open in Edit window (enlarged)

Save Ctrl+5S
Save As... Ctrl+Shift+5
Add thumbnail to image and save Ctrl+Shift+T
Convert and save... Ctrl+D

Batch process... Ctrl+B
Create new folder...

Print... Ctrl+P
Print with detailed setting... Ctrl+Alt+P
Contact Sheet Prints... Ctrl+Shift+P
Plug-in printing 3

' Add to collection Ctrl+G
EMOVE 1T0M Collection Cirl+5hit+ G

Clear collection

Delete Del
Info Ctrl+I

Exit Alt+F4

The selected images are added to the [Collection] window and the
number of selected images is shown on the [Collection] tab sheet.
When you add RAW and JPEG images displayed as a single
image (p.22), the number of images shown on the [Collection]
tab sheet increases by 2.

You can select several images and add them to the [Collection]
window.

You can also add images to the [Collection] window by selecting
images, right-clicking with your mouse, and selecting [Add to
collection] from the menu that appears.

You can add up to 1,000 images to the [Collection] window.
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Select the [Collection] tab sheet.

Digital Photo Professi
File Edit Yiew Label Adjustment Tools Help

= i

1113

Folder Collection(14)

e

The selected images are displayed in the [Collection] window.

Bl Desktop
-+ Libraries
|ﬂl] Documents

Check displayed images in the [Collection] window.

Digital Phote P = (=
File Edit View Bookmark Label Adjustment Tools Window Help

SRGB | Adobe RGB High quality Recpe data: Yes Number of images: 7

Number of selected mages: 1

Edit the images.
You can now edit the images displayed in the [Collection]
window.
Images displayed in the [Collection] window are retained in the
[Collection] window even after exiting DPP.

Y

=@>= To remove images from the [Collection] window

Removing randomly selected images
Select the images to be removed in the [Collection] window and then
select [Remove from collection] in the [File] menu. (You can also remove
images from the [Collection] window by selecting the images, right-
clicking with the mouse, and selecting [Remove from collection] from the
menu that appears.)
Note that even if you remove an image from the [Collection] window, the
original image remains unaffected.

Removing all images
Select [Clear collection] in the [File] menu. (You can also remove all
images from the [Collection] window by selecting one image, right-
clicking with the mouse, and selecting [Clear collection] from the menu
that appears.)
Note that even if you remove all images from the [Collection] window,
the original images remain unaffected.

® Modifications to the image are applied to the original image
Modifications made to images added to the [Collection] window are
all applied to the original image.

@ You can arrange images displayed in the [Collection] window the
same way as in the [Folder] window (p.20, p.21). You can
maintain the order of rearranged images even after exiting DPP
by checkmarking [Retain sort order] on the [View settings] tab
sheet in the [Preferences] (p.80).

You cannot use the following functions in the [Collection] window.

« Starting of EOS Utility (p.7), or synchronizing of folders with
EOS Utility

» Batch change the file name of images (p.90)
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Trimming and Adjusting the Angle of an Image

You can trim only the part of an image you need, or change the
composition of an image where an image shot horizontally becomes
vertical. You can also adjust the angle of an image before trimming.

Select the image to be trimmed.

Open the trimming/angle adjustment window.
Click the [Trimming Angle] button.

-
y ® & @ 9

Rotate right Guick Stamp  Trimming Batch
check Angle process

Rating  # & & »

_——

The trimming/angle adjustment window appears.
Editing can be done once the image is displayed clearly in the
trimming/angle adjustment window.

Adjust the angle of the image as needed.
Trimming/angle adjustment window

\\\\\\\\\

— Largest
possible
trimming
range

AAAAAA

eeeeee

ﬁﬁﬁﬁﬁﬁﬁ — Click (rotate

image left
or right in
90-degree
increments)

ccccc

Drag* (0.01-degree increments;
adjustment range: -45 to +45 degrees)

Use the mouse (click A/V) to adjust the angle or
directly enter the adjustment angle* (0.01-degree
increments; adjustable range: -45 to +45 degrees)

* You cannot adjust the angle of images that exceed 9999 x 6666
pixels in size.

If you click [Center on Screen], you can display the trimming
range in the center of the window.

When correcting lens aberrations, it is recommended to perform
[Lens aberration correction] before adjusting the angle of the
image.

If you click the [OK] button after adjusting only the angle of the
image, the image will be trimmed at the largest possible trimming
range.

@ When aspect ratio information is attached to an image shot with the
EOS-1D Mark IV, EOS-1Ds Mark Ill, EOS-1D Mark Ill, EOS 7D,
EOS 60D or EOS 600D, the trimming range based on the aspect
ratio information is displayed.
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Select a ratio and drag the trimming range.

(B 1/ 1 E\Users\CANONPictures\Photobooot oc o 0LCR2

eeeeeeeeee ___Cancel
—Select a
trimming
ratio

nnnnn

—Drag the
trimming
range

(704, 362) > (2281, 1413) = (1577 x1051) [1.50]

The trimming range can be moved by dragging.

You can enlarge or reduce the size of the trimming range by
dragging the four corners of the trimming range.

List of aspect ratios (width : height)

1:1
32
23

4.5

A Size Landscape
A Size Portrait
Letter Landscape
Letter Portrait
Custom

[Free]: You can trim an image to any size, regardless of the
selectable ratio.

[Custom]: You can trim an image at the specified ratio.

Click the [OK] button to return to the main window.
The trimming range frame is displayed in the trimmed image
(p.114).

When the trimmed image is displayed in an edit window or the
edit image window, it is displayed in its timmed form.
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? About trimmed images

The trimmed range can be reverted to its original condition at
any time

A trimmed image is displayed or printed as a trimmed image.
However, since the image is not actually trimmed, you can always
revert to the original image by clicking the [Reset] button in the
trimming/angle adjustment window or performing the “Re-Editing an
Image” procedure (p.43).

Display of the trimmed image in each window

* Main window: The frame showing the trimming range is
displayed on the image (p.114).

* Edit window: The image is displayed in its trimmed condition.

» Edit image window: The thumbnail image is the same as the main
window display, and the enlarged image is the
same as the edit window display.

Printing a trimmed image
You can print as a trimmed image by printing it in DPP.

The image becomes a trimmed image when converted and saved
The trimmed RAW image actually becomes a trimmed image when
converted to a JPEG or TIFF image and saved (p.42).

Images that have aspect ratio set will be displayed as trimmed
images

When aspect ratio information is attached to a RAW image shot with
EOS-1D Mark IV, EOS-1Ds Mark Ill, EOS-1D Mark Ill, EOS 7D, EOS
60D or EOS 600D, the set trimming range based on the aspect ratio
information is displayed. Since the image is not actually trimmed, you
can change the trimming range or revert to the condition before
trimming.

However, when a JPEG image is shot in a [4:3], [16:9] or [1:1] aspect
ratio set with the EOS 60D or EOS 600D, its trimming range cannot
be changed nor reverted to the condition before trimming, since the
image is actually trimmed and saved in the set trimming ratio.

When reverting to the condition before trimming is performed based
on the aspect ratio information at the time of shooting, click the
[Reset] button. Also, if you want to cancel all the trimming range, click
the [Clear] button (p.122).

Y

Q> Convenient functions of the trimming/angle adjustment
window

Switch between screens using the keyboard
You can also switch between full screen display/normal screen
display by pressing the <Alt> + <Enter> keys or the <F11> key.

Operate using the menu
Each operation can also be performed with the menu which appears
when you right-click with the mouse on the image.

Apply the trimmed range to another image

You can apply the trimmed range to another image by clicking the
[Copy] button to copy the trimmed range, displaying another image
and then clicking the [Paste] button.

To batch apply a copied trimming range to multiple images, select the
trimmed image and the multiple images to which you want to apply
the trimmed range in the main window, and display the trimming/angle
adjustment window. With the trimmed image displayed, click the
[Copy] button and then click the [Apply All] button. This will apply the
trimming range to all the images selected when the trimming/angle
adjustment window is displayed.

To select multiple images in the main window, click the images while
holding down the <Ctrl> key. To select multiple consecutive images,
click on the first image, and then click on the last image while holding
down the <Shift> key.

© For images shot with ISO speed range expansion set, noticeable
noise may make it difficult to view image details in the trimming/
angle adjustment window, so using this function is not
recommended.

@ For a list of the trimming/angle adjustment window functions, refer
to p.122.

Introduction

Contents at
a Glance

Basic
Operation

Advanced
Image Editing
and Printing

Processing
Large Numbers
of Images

Editing
JPEGI/TIFF
Images

Reference

Index

00

40




Applying Adjustment Contents to Other Images

You can copy the image adjustment contents (recipe) adjusted with the
tool palette and apply it to other images.

You can efficiently adjust multiple images by adjusting one image and
applying the results of this to multiple images shot in similar shooting
environment.

Select the adjusted image and then select the [Edit]
menu » [Copy recipe to clipboard].
The recipe is copied.

Select the image to which the recipe is to be applied
and then select the [Edit] menu P [Paste recipe].
The recipe is applied to the image.

|§| The recipe (p.85) can be saved as a separate file from the image
and loaded and applied to another image (p.86).

Saving Editing Results
Saving Editing Contents to a RAW Image

All the contents (recipe) adjusted with the tool palette as well as the
trimmed (p.38) range information can be saved to a RAW image or to a
separate RAW image.

The adjustments made with the tool palette (p.56 to p.68) and the dust
erase processing explained in Chapter 3 (p.69 to p.73) can also be
saved in a RAW image.

Select the [File] menu » desired item.
File
Open in Edit window Ctrl+0

Open in Edit window (enlarged)

Save Ctrl+5
Save As.. Ctrl+5Shift+5
Add thumbnail to image and save Ctrl+Shift+T
Convert and save... Ctrl+D
Batch process... Ctrl+B

Create new folder...

Print... Ctrl+P
Print with detailed setting... Ctrl+Alt+P
Contact Sheet Prints... Ctrl+Shift+P
Plug-in printing 4
Add to collection Ctrl+G
Remove from cellection Ctrl+ Shift+G
Clear collection

Delete Del
Info Ctrl+I
Exit Alt+F4

Your adjustments are saved to the image.
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Saving as a JPEG or TIFF Image

To view, edit and print a RAW image with software other than DPP,
convert to a more versatile JPEG or TIFF image and save.

The image is saved as a separate image, so the RAW image remains
unaffected.

Select the image to be converted.

Select the [File] menu » [Convert and save].

File

Open in Edit window Ctrl+0
Open in Edit window (enlarged)
Save Ctrl+5
Save As... Ctrl+Shift+5
Add thumbnail to image and save Ctrl+5Shift+T

( Convert and save... Ctrl+D
Batch process... Ctrl+B
Create new folder...
Print... Ctrl+P
Print with detailed setting... Ctrl+Alt+P
Contact Sheet Prints... Ctrl+Shift+P
Plug-in printing 3
Add to collection Ctrl+G
Remove frem collection Ctrl+Shift+G
Clear collection
Delete Del
Info Ctrl+1
Exit Alt+F4

The [Convert and save] window appears.

Specify the necessary settings, and then click the

[Save] button.
By default, the image is converted and saved to a JPEG image

with the highest image quality, without changing the image size.

Change the settings according to your requirements.

(s = s
ﬁ
Save i Photo - @2 e

) =
Recent Places N

! E

Deskiop s e

— Select the save

destination

LY

Computer

@ _J

Network .

File pame: IMG_0001 - Save '— CIle and save
Save as type: Exif-JPEG(".JPG."JPEG) v‘ Cancel

Quality setting

Image quality 1 w
P Enter a file name and
Output resolution 350 dpi ¥ Embed ICC profile in image .
Rm select an image type

The RAW image is converted to a JPEG or TIFF image which is
then saved as a new image in the specified save destination.

A

-:@/5 To save the developing/editing results for the version you are
currently using

DPP’s RAW image development processing technology is continually
being improved upon so that you can perform the latest image
processing more appropriately.

Meaning that, between two differing versions of DPP, processing results may
differ very slightly even if with the same RAW image data, or the results of
significant editing of RAW image data with an attached recipe may be different.
When you want to save the developing or editing results of the version
you are currently using as it is, it is recommended that you convert and
save images as JPEG image or TIFF images.

@ By saving as explained on this page, a trimmed image (p.38) or
dust-erased image explained in Chapter 3 (p.69 to p.73) actually
becomes a trimmed image or dust-erased image.

You can reduce the noise characteristic of JPEG images which

occurs when you convert and save an image as a JPEG (p.78, p.79).

You can batch convert and save multiple images (p.88).
For a list of [Convert and save] window functions, refer to p.121.
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Re-Editing an Image

Only the image processing conditions are changed in images adjusted
with the tool palette (p.25 to p.33), so the “original image data itself”
remains unaffected.

Also, the trimming range information of a trimmed image (p.38) is simply
saved to the image.

For this reason, you can undo any adjustments saved (p.41) to the
image, trimming information, and revert to the condition when last
saved, or when the image was shot.

Select the image that is to be re-edited.

Select the [Adjustment] menu P desired item.

Adjustrent |
Rotate Left Ctrl+L
Rotate Right Ctrl+R

Apply Dust Delete Data
Work color space 3

Tone Curve Assist - Standard

Tone Curve Assist - High

Ctrl+ Alt+Z
Ctrl+ Shift+Z

Revert to last saved settings
Revert to shot settings

The image reverts to the conditions of the selected item.

Printing an Image

This section explains how to print high-resolution photographs easily
with Canon inkjet printers compatible with the Canon printing software,
Easy-PhotoPrint EX or Easy-PhotoPrint. It also explains how to print
photographs using other printers.

Proceed to the page for the printer you are using.
Printing Photographs with Canon Inkjet Printers Compatible with
Easy-PhotoPrint EX (Same page)
Printing Photographs with Canon Inkjet Printers Compatible with
Easy-PhotoPrint (p.46)
Printing Photographs with a Printer other than Canon Inkjet Printers

(p.49)

Printing Photographs with Canon Inkjet
Printers Compatible with Easy-PhotoPrint EX

You can perform the following types of photograph printing with Canon
inkjet printers compatible with Easy-PhotoPrint EX (hereinafter, “EPP
EX"):

Simple printing of RAW images

Printing with faithful colors

To perform this printing, it is necessary to first install EPP EX version 1.1
or later on your computer.
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Select the image to be printed.

Start up EPP EX.
Select the [File] menu » [Plug-in printing] » [Print with Easy-

PhotoPrint EX].

File

Open in Edit window

Open in Edit window (enlarged)

Save

Save As...

Add thumbnail to image and save

Convert and save...

Batch process...
Create new folder...

Print...

Print with detailed setting...

Contact Sheet Prints...
Plug-in printing

Add to collection
Remove from collection

Clear collection

Delete
Info

Exit

Ctrl+Q

Ctrl+5
Ctrl+Shift+S
Ctrl+Shift+T

Ctrl+D

Ctrl+B

Ctrl+P
Ctrl+Alt+P

Ctrl+Shift+P

Ctrl+G
Ctrl+5hift+G

Del
Ctrl+I

Alt+F4

Print with Easy-PhotoPrint EX

EPP EX starts up.

In the EPP EX window, select the [File] menu »

[Preferences].

File

Open... Ctrl+Q

Previous Step

Next Step

Save Ctrl+5

Save As...

[ Preferences...

Frint... Cirl+F
My Recent Files

Exit

The [Preferences] window appears.

In [Print Quality], select [Quality Priority], click the
[Option] button, and then in the dialog box that

appears, checkmark [Print with the best quality when

you select [Quality Priority]].

Eﬂt—l Advanced

[ spool print job page by page
Mumber of copies :
Printing Order :

Amount of extension of borderless printing :

Print Quality :

1

Z-| Copies

5y Date

Default =

Defaults

(

OK

] [ Cancel ] [ Help

J

Select
Quality
Priority

Click and checkmark [Print with the best quality

when you select [Quality Priority]]
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Select the [Advanced] tab, checkmark [Enable ICC

profile], and then click the [OK] button.

The [Preferences] window closes.

Specify the number of sheets to be printed, and then

click [Select Paper]
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Click

Click to
increase the
number of
sheets to be
printed

Select the paper type, and then click the [Layout/
Print] button.

New Photo Print -
Fle fdit View Help

@ Select Images ]
F F

hd

Select the printer to use, then select the sze and type of paper for printng.

Exif Print

@ select paper

3

@ Layout/print |
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Specify the layout, and then click the [Print] button.

Click

S New Photo Print -

Ele Edt View Help

@ Select Images
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Photo Print

Exif Print

Inside Pages

Select the
paper size
and type

Select the
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Click to print
Printing begins.
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? Additional information

Print up to 1000 images at a time
You can print up to 1000 images selected in DPP at a time. When
printing more than 1000 images, divide the printing into several jobs.

The printed image’s color is not what you expected

In the EPP EX window, select [Preferences] in the [File] menu and
then click the [Advanced] tab in the [Preferences] window to display
the [Advanced] tab sheet.

In the [Advanced] tab sheet, select [Enable ICC profile] in [Color
correction for printing] and try printing using the [Perceptual] setting
(p.128).

Ay

-@> Advantages of printing with EPP EX

Printing with faithful colors

When the color space (p.128) is set to sSRGB or Adobe RGB (p.73,
p.82), this color space is automatically transmitted from DPP to EPP
EX, allowing you to print with faithful colors.

When the color space is set to Apple RGB or ColorMatch RGB, the
image is printed with an sRGB color space, and when set to Wide
Gamut RGB, with an Adobe RGB color space.

Printing with a wide color reproduction

When the color space setting (p.73, p.82) is set to Adobe RGB and
the image is printed with a Canon inkjet printer, the color reproduction
range is wider, and green and blue in particular are reproduced
vividly.

|§| DPP is also compatible for printing with Easy-PhotoPrint Pro (p.76).

Printing Photographs with Canon Inkjet
Printers Compatible with Easy-PhotoPrint

You can perform the following types of photograph printing with Canon
inkjet printers compatible with Easy-PhotoPrint (hereinafter, “EPP”):
Simple printing of RAW images
High quality printing using the color reproduction range of Adobe RGB
and a Canon inkjet printer

To perform this printing, it is necessary to first install EPP version 3.5 or
later on your computer. When using an Easy-PhotoPrint EX-compatible
inkjet printer, it is recommended that you print using Easy-PhotoPrint EX
(p-43).

Select the image to be printed.

Start up EPP.
Select the [File] menu » [Plug-in printing] » [Print with Easy-
PhotoPrint].

Cpen in Edit window Chrl+O

Open in Edit window (enlarged)

Save Chrl+3
Save As... Ckrl+5hifk+5
Add thumbnail ko image and save  Cerl+Shift+T
Convert and save... Ckrl+D
Batch process... Chrl+B

Creake new folder ...
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Print... Chrl+P

Print with detailed setting. .. Chrl+Alk+P
Contack Sheek Prints. .. Ckrl+Shift+P
add ko collection Chrl+G

Remove Fram collection Ckrl+Shift+G

EPP starts up.
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In the EPP window, select the [File] menu »
[Preferences].

Preferences. ..
Exit

The [Preferences] window appears.

In [Print Quality], select [Quality Priority].

Preferences fg‘

] Spoal print job page by page

Mumber of copies : 1 2] Copies

Printing Drder : [By Date v

Amount of exterion of barderless printing: | Defaut v

Print Cuality : Select
Quality
Priority

[ 0K | [ Cancel ] [ Help ]

Select the [Advanced] tab sheet and check that the
EPP image compensation function is disabled.
If not disabled, the operation of the EPP image compensation
function may prevent images being printed with faithful color

reproduction.
Preferences [E|
_.Pr.int : i_Aavanced_|
— _ If checked,

Image [ D ptimize images autornaticaly

Apply Rotate/Trimming ta the same images in the same manner C“Ck tO

‘When landscape images are rotated depending on the selected layout : remove the

(%) Rotate Left h k
mark
) Rotate Right chec a

Layout [ &heays trim when you select the layout with the marging

Set marging to the minimum when you select the lapout with the marging

Print filznarme when vou select the index in lapout

Preview all layouts of &4 and Letter
Image
Selection .

Click to
close the
Defauts window
\
[[ 0k l I Cancel ] [ Help ]
v 4

Specify the number of sheets to be printed, and then

click [Next].

toPrint

eeeeeeee

Easy;_, hotoPrint
() 5| )

— Click

— Click to
increase the
number of
sheets to be
printed
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Introduction
Check that the image compensation function is

disabled, select the paper type and then click [Next].
If checked, click to remove the check marks

Additional information

© Print up to 1000 images at a time S
You can print up to 1000 images selected in DPP at a time. When :Gfangea
printing more than 1000 images, divide the printing into several jobs.

© The printed image’s color is not what you expected
Click Change the [Rendering intents when using Easy-PhotoPrint] (p.82) to Basic
[Perceptual] (p.128) and print. Operation

Select the "
paper type == Printing with a wide color reproduction édg{:ed
o] ion
When the color space (p.73, p.82) is set to Adobe RGB and the image is
printed with Canon inkjet printer, the color reproduction area widens,
and green and blue in particular are reproduced vividly. Imﬁd‘éaggﬁ?n
When the color space is set to Apple RGB or ColorMatch RGB, the ang Printingg
image is printed with an sRGB color space, and when set to Wide
Gamut RGB, with an Adobe RGB color space. .
Processing
= = Large Numbers
|§| DPP is al tible f inti ith E PhotoPrint P 76 STINELEE
8 Specify the layout, and then click [Print]. is also compatible for printing with Easy-PhotoPrint Pro (p.76).
@ sy Photoprint CEX Editin g
= JPEGI/TIFF
Images
Click to print
Reference
Index

=t Q0
Select the layout @

=» Printing begins.
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Printing Photographs with a Printer other than Canon Inkjet Printers

You can print one image on one sheet of paper.

Select the image to be printed.

Select the [File] menu » [Print].

File

Open in Edit window Ctrl+0
Open in Edit window (enlarged])

Save Ctrl+5
Save As... Ctrl+Shift+5
Add thumbnail to image and save Ctrl+Shift+T
Convert and save... Ctrl+D
Batch process... Ctrl+B
Create new folder...

[ Print... Ctrl+P
Print with detailed setting... Ctrl+Alt+P
Contact Sheet Prints... Ctrl+Shift+P
Plug-in printing
Add to collection Ctrl+G
Remowve from collection Ctrl+5Shift+G
Clear collection
Delete Del
Info Ctrl+1
Exit Alt+F4

The [Print] dialog box appears.

Set to photograph printing and print.
Specify the optimum settings for photograph printing in the
printer’s print settings dialog box and click the [OK] button.

Printing begins.

Organizing Images
This section explains how to delete unwanted images, create folders for
saving images, move or copy images, etc., and organize your images.

Deleting an Unwanted Image

Be aware that you cannot recover deleted images.

Select an unwanted image in the main window.

Select the [File] menu » [Delete].

File

Open in Edit window Ctrl+0
Open in Edit window (enlarged)
Save Ctrl+5
Save As... Ctrl+Shift+5
Add thumbnail to image and save Ctrl+Shift+ T
Convert and save... Ctrl+D
Batch process... Ctrl+B
Create new folder...
Print... Ctrl+P
Print with detailed setting... Ctrl+Alt+P
Contact Sheet Prints... Ctrl+Shift+P
Plug-in printing 3
Add te collection Ctrl+G
Remove from collection Ctrl+Shift+G
Clear collection

[ Delete Del
Info Ctrl+I
Exit Alt+F4

The [Confirm File Delete] dialog box appears.

Click the [Yes] button.
The image is moved to the [Recycle Bin] and is deleted from DPP.
The images are deleted completely from your computer when the
[Empty Recycle Bin] operation is performed on the [Recycle Bin]
on the desktop.
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Creating a Folder for Saving Images

You can create a folder for sorting images.

In the folder area, select the location where the new
folder is to be created.
(@) Digital Photo Professional - [E\Users\ CANON\Pictu

File kmark Label Adjustment Tools Window Help

Select the [File] menu » [Create new folder].

File
Open in Edit window Ctrl+O
Open in Edit window (enlarged)
Save Ctrl+5S
Save As... Ctrl+Shift+5
Add thumbnail to image and save Ctrl+Shift+T
Convert and save... Ctrl+D
Batch process... Ctrl+B
( Create new folder...
Print... Ctrl+P
Print with detailed setting... Ctrl+Alt+P
Contact Sheet Prints... Ctrl+Shift+P
Plug-in printing 3
Add to collection Ctrl+G
Remove from collection Ctrl+Shift+G
Clear collection
Delete Del
Info Ctrl+I
Exit Alt+F4

The [Create new folder] dialog box appears.

Enter a folder name and click the [OK] button.
The new folder is created in the folder selected in step 1.

Moving Images

You can move or copy images to a separate folder and sort by shooting
date or themes.

Drag the image to be moved or copied.
To move: Drag the image and release when the image is in the
destination folder.
To copy: Drag the image while holding down the <Ctrl> key and
release when the image is in the destination folder.

il Digital Photo Professional - [EAUsers\CANON\P

Eile Edit View mark Label Adjustme ow Help

2 @

‘ Folder Collection(0)

B Desktop
'} [ Libraries

B ®®

Info Selectall Clearal  Rotsteleft Rob)

-5 Documents
HTI,J‘t Music
== Pictures
J- . Phote

| Sample Pictures
-5 Videos
(11 # Homegroup
- B CANON
[#-78 Computer
-l Metwork

=
Travel <l

™

=

The images are moved or copied to the destination folder.

£l
2
2]
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Moving Images in Folders

You can move or copy folders that contain images, and sort the images
by folders.

Drag the folder to be moved or copied.
To move: Drag the folder and release when the folder is in the
destination folder.
To copy: Drag the folder while holding down the <Ctrl> key and
release when the folder is in the destination folder.

@ Digital Photo Professional - [EAUsers\CANON\Pict \oocx_ok_]
E\\e Edit View Bookmark Label Adjustment T Help

2 @

Tool Info Selectall  Clearal  Rolsteleft Rot|
alette

(1] #dy Homegroup
- & CANON
[#-788 Computer
- Network
-0 Travel

The folders are moved or copied to the destination folder.

Registering Frequent-Use Folders (Bookmark Registration)

You can register frequently used folders in bookmarks.
Registered folders appear by clicking the [Bookmark] menu.

Select the folder for which a bookmark is to be
registered.

B Desktop

(=i Libraries

- Documents
gl Music
=-Ji= Pictures

Select

-5 Videos

[+ Homegroup

- A CANON @ &

[#-78 Computer IMG_0001.CR2 ™
-6l Metwork

Travel

ro

Select the [Bookmark] menu » [Add].
The folder selected in step 1 is registered in the [Bookmark]
menu.

Select a registered folder from the [Bookmark] menu to display
images in the selected folder in the main window.

Organizing Bookmarks

You can change a folder name or delete a folder registered in
[Bookmark].

Select the [Bookmark] menu » [Organize].
The [Sort bookmarks] window appears and you can change
folder names or delete folders.
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3 Advanced Image Editing and Printing

Various preferences including advanced image adjustment, automatic
dust erasure processing, various printing functions for printing out work,
and color management are explained here, geared to the user who is
competent in the handling of third-party image editing software.

Adjusting While Comparing with the Original Image... 53
Changing How the Window is Split...............c.eueeee..... 53

Adjusting by Comparing Multiple Images................. 54

Displaying an Area Beyond the Set Range as a

Warning Indicator (Highlight/Shadow Warning) ....... 55

Performing Advanced Editing.............cccoevviiiiinnn. 56
Adjusting White Balance with Color Temperature ..... 56
Tuning White Balance with Color Wheel ................... 56
Adjusting Dynamic Range ............ccccvvvvvveiiiiniiinnnnnnns o7
Adjusting Brightness of Shadows/Highlights ............. o7
Tone Curve Adjustment............ccccoiiiiiiieee e, 58

Example of a Tone Curve Operation ..................... 59
Using a Picture Style File..........ccoooiiiiiiiieeee 59
About the RGB Tool Palette ..............ovvvvvviiiiiiiiiinnnnes 60

Using the Auto Lighting Optimizer................ccooeeeeee. 61

Reducing NOISE........c.iiiiiiiiiieeie e, 62

Correcting Lens Aberration ..........ccccooooiiiiineeenn. 63
Compatible Cameras..........ccccvveeeeeeeeeeeeiicccceee. 63
Compatible Lenses.......ccccooveieiiiiiiiiiiee 63
Making Corrections...........ccceeeeeeeeiieeiiiiiiiiieeeeee e 65

Effects of Distortion Aberration Correction for Fisheye
LENSES ... .t 66
About Shooting Distance Information Slider.............. 68

Correcting Multiple Images at a Time......................... 68

Performing Automatic Dust Erasure Processing ..... 69
Compatible Cameras.............ccccooeeicciiiiiiieieeee e, 69
Automatic Dust Erasure Processing in the Main Window... 70

Manually Erasing Dust (Repair Function)................ 71
Erasing Unwanted Parts of an Image (Copy Stamp
FUNCHION)....eee e 73

Transferring a RAW Image to Photoshop................ 73

Setting Work Color Space .........ccccooeevvveiiiiiiieeeeinnnn. 73

Printing with Shooting Information........................... 74

Printing a Thumbnail List (Contact Sheet Printing).. 75

Printing RAW Images on a High-End Canon Printer.. 76
Printing with a High-End Canon Inkjet Printer ............ 76
Printing with a Large-Format Canon Printer............... 77

Specifying Preferences...........cccoceeiieiiiiiiiiiieeieennnnn. 78
General SettingS.........ooooviiiiiiiiiiie e 78
View SettingS......ocooeiiiiiiiieee e 80
Tool Palette ... 81
Color Management..........cccooooiiiieeiiiiiiie e 82
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Adjusting While Comparing with the Original Image

You can display before and after versions of an adjusted image in the
same window and adjust while checking the adjustment results.

Introduction
Changing How the Window is Split NE—

You can change the display of the image to a single image split in two.

Contents at

In the edit window, select the [View] menu » [Before/ a Glance

after comparison]. In the edit window, select the [View] menu » [Display L
— mode] » [Split single image].

Basic
Operation

D

Advanced
Operation

Imaggiltmg
and Pfinting

One image is divided and displayed on the left and right or top

The image divides into a left and right window. )
: . : " and bottom. Processing
The window on the right shows the image after editing. To switch between top and bottom, and left and right, perform the Laggf‘irﬂ:mg:rs
Change the image display. same operation as step 2 on the left page. =_94
Select the [View] menu » [Change up/down/left/right] » [Up/ Editing
down]. JPEGI/TIFF
= Images
—
Reference
—
Index
The layout of the two images changes to top and bottom. @ @
The bottom window shows the image after editing. @

|§| Images can also be displayed in the edit image window by the same

operation.
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Adjusting by Comparing Multiple Images

You can synchronize the display position of multiple edit windows and
adjust images while comparing them with each other.

In the edit window, display the multiple images to be
compared.

Align the images.
Select the [Window] menu » [Arrange vertically] or [Arrange
horizontally].
The edit windows are aligned.

Select the [Window] menu » [Synchronize].

Enlarge the image.
Enlarge and display any of the edit windows.

The other edit windows will also be displayed in the same
position/enlargement ratio.

Move the display position.
If you move the enlargement display position in one of the edit
windows, the enlargement display position will also change in the
other edit windows.
To cancel synchronization, select the [Window] menu »
[Synchronize] again.

@ Synchronization only applies to the enlargement display position
and the enlargement ratio. Adjustments to the images are not
synchronized.
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Displaying an Area Beyond the Set Range as a Warning Indicator (Highlight/Shadow Warning) _
Introduction
You can set up a warning indicator in both the highlighted part and the Display the edit window.
shaded part, which is effective for checking the light and dark areas and
preventing excessive adjustment of an image. Where the area on the . . . . .
image has exceeded that set range, you can display the highlighted part Select the [View] menu » [Highlight]. Similarly, select Cg'gfa"rfgeat
in red and the shaded part in blue. [Shadow].
On the opened image, if there is an area that exceeds the value
Select the [Tools] menu » [Preferences]. entered in step 3, the highlighted part of that area is displayed in Basic
red and the shaded part is displayed in blue. Operation
Select the [View settings] tab sheet.
Advanced
Enter the warning value for [Highlight] and [Shadow]. BT atis
!7ngeral satﬁrgsil View settings ‘ Tool palette | Color management | Ad ced
Grdptch Imaggiiting
64 Pixels(8-256) and nting
[¥] images opened in Edit window remain selected in main window PrOCGSSi ng
Large Numbers
Magf’viﬁfaﬁon in Edit window - of Images
Magrification when the Edit/Edit image window is doubledicked Ed iti ng
©) 50% @ 100% ) 200% JPEG/TIFF
RAW and JPEG Images
Sor; ojr:e;ln mal: w:\dow Refe rence
Highlight/shadow Alert
Highlight 255 192-255) .
Shadow 0 0-64) . I ndex
Quick check tool display —_/
@ 50% () 100% (moiré reduction off)
——— Q0
Click the [OK] button to close the window. @

@ You can also display the warning with the same operation in the edit

image window.
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Performing Advanced Editing

This section explains how to use the advanced adjustment function on
the tool palette in the edit window.

Adjustments made using the high-level functions of the [RAW] and
[RGB] tool palettes, as well as the functions of the [NR/Lens/ALO] tool
palette are explained in this section.

Adjusting White Balance with Color Temperature

White balance can be adjusted by setting a numerical value for color
temperature.

Select [Color temperature] from the [White balance
adjustment] list box.

Set the color temperature.

RAW [RGB [ NR/Lens/ALO|
| Brightness adjustment E”
{l 0.00
White balance adjustment E”
(2] 1])(2 | Regster..
Color temperature q | Tune.: |
(ss00 k|- Displays the value of the

setting
Drag the slider left or right

|§| The adjustment range is 2500 to 10000K (in 100K units).

Tuning White Balance with Color Wheel

White balance can be tuned by moving a cursor in the color direction
shown in the color wheel.

In the [RAW] tool palette, click the [Tune] button.

Tune by dragging a point.
You can also fine-tune your adjustment by directly entering the
adjustment values.

White balance fine adjustment

Color tone:

Enter the values to set

Color saturation:

@ To register adjustment results as personal white balance (p.87),
select a setting other than [Shot settings] from the [White balance
adjustment] list box, and then tune with the color wheel. You cannot
register the adjustment results as personal white balance when you
have selected [Shot settings] from the list box and have done any
tuning.

@ The adjustment range of color tone is 0 to 359 (1 unit in numerical
value input), and the adjustment range of color saturation is 0 to 255
(1 unit in numerical value input).

Introduction

Contents at
a Glance

Basic
Operation

Advanced
Operation

Advapced
Imag iting
and Pfinting

Processing
Large Numbers
of Images

Editing
JPEGI/TIFF
Images

Reference

Index

00
©

56



Adjusting Dynamic Range

Dynamic range (width of gradation expression) from dark points to bright
points in an image can be adjusted.

Picture Style E3)

[standerd zl (oo | 16ve downwards

Output highlight points

Move to the left or rignt
Input highlight points

a

-10.0 " " o e
Contrast: (0)
Highlight: {0}
Shadow:(0)
|:| Linear
Color tone:(0)

Color saturation: (1)

(=]

Move upwards
Output shadow points

‘= i | e i B N e

[Unsharp mask v]
Strength: (0) [
Fineness: (D) 0
Threshold: (0) [}

Move to the left or right
Input shadow points

The horizontal axis shows the input level and the vertical axis
shows the output level.

Adjusting Brightness of Shadows/Highlights

You can adjust the brightness of shadows and highlights in an image.
By adjusting shadows and highlights in an image with a restricted
brightness, you can reduce the effects of clipping in shadows and
highlights.

Picture Style (=]

ISEndard VI [ Browse... I

o
'

o Bl :
-10,0 8.0 60 40 -20 0.0 20 40
Contrast: (0)
Highlight: (i0)

Shadow: (D)
|:| Linear

Color tone: (0}
Color saturation:{0)

Drag the sliders left or

}
D I
T right
@@

{l

{l

[Unsharp mask VI
Strength: (0) 1}
Fineness: (0) 1
Threshold:(0) I}
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Tone Curve Adjustment

You can adjust the brightness, contrast and color of a specific area by
changing the tone curve (p.127).

Make adjustments.

In the tool palette, select the [RGB] tab sheet.

Select the tone curve mode and interpolation

method.
RAW | RGE | NR/Lens/ALG |
| Tone curve assist @ |
|Tone curve adjustment |

Lors  J[R][c][e] 3]

255

@ Curve

Straight

@ RGERGB

Lurminance R G B

Brightness:

Contrast:

=

Hue:

Saturation:

e

Sharpness: I

255

®]o
(5] 100
B o

Right-click with the
mouse inside the graph
to display the menu

RAW | RGE | NR/Lens/ALO |

|Tor|e curve assist

([0 (I)[35)

|Tone curve adjustment

|

Ret J(r(c][8] L2

255

Brightness:

Contrast:

Hue:
Saturation:

Sharpness: M

B]o

(5] 100
(B] o

Adjusts each channel
Batch adjusts RGB

Click to add a [[] (point)
Adjust by dragging [[]

The horizontal axis shows the input level and the vertical axis
shows the output level.
The maximum number of [[] is 8.

To delete a [[1], either press the <Del> key or double-click on the [[].

The histogram display changes according to adjustment. You can
also fix the histogram display to the display before any

adjustments (p.81).

The tone curve mode and interpolation method for a tone curve
can also be changed in [Preferences] (p.81).
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Example of a Tone Curve Operation
Makes medium tones brighter

Makes medium tones darker

Makes tones harder

Makes tones softer

Using a Picture Style File

A Picture Style file is an extended function file of a Picture Style.

With DPP, you can apply to RAW images Picture Style files that you
have downloaded from Canon’s web site effective for various scenes or
Picture Style files created with “Picture Style Editor”. When using a
Picture Style file, save it to your computer beforehand.

Display the image to which the Picture Style file is to
be applied in the edit window (p.11).

Select the [RAW] tab sheet in the tool palette, and
click the [Browse] button.
Picture Style

[Siﬁndard "H Browse... I

I | i
- TRy
PR P Y L A

-10.0 80 60 40 -20 00 20 40

The [Open] dialog box appears.

Select a Picture Style file saved on your computer,
and click the [Open] button.
The Picture Style file you selected is applied to an image.

To apply a different Picture Style file, follow the procedure from
step 2 again.

@ The Picture Style files that you can apply to the camera are files with
the “.PF2” extension only. Furthermore, you cannot apply Picture
Style files with the extension “.PSE” to an image; however if such a
file is registered in the camera and the image is shot, the image will
display correctly.
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About the RGB Tool Palette

You can adjust images with the tool palette by switching between the
[RAW], [RGB] and [NR/Lens/ALO] tab sheets according to your editing
requirements.

The [RGB] tool palette functions are the same as ordinary image editing
software, such as tone curve adjustment that is explained here, with
which you can adjust RAW images.

However, because the adjustment width of the functions in the [RGB]
tool palette is wider than the [RAW] tool palette, the image color may be
saturated, or the image quality may deteriorate if you adjust too much.
Therefore we recommend for functions other than tone curve
adjustment (p.58) and automatic adjustment (p.33), that you adjust
images using the same functions available in the [RAW] tool palette.
Refer to Chapter 5 for explanations on functions of the [RGB] tool
palette other than tone curve adjustment.

5@/3 Using the tool palette

We recommend that as a general principle you edit RAW images using
the [RAW] tool palette. However, where the adjustment width with the
[RAW] tool palette is not wide enough and you wish to use the special
functions in the [RGB] tool palette, we recommend that you adjust your
images at the necessary lowest limit with the [RGB] tool palette after
having completed basic adjustment with the [RAW] tool palette.

Use the adjustment function of the [NR/Lens/ALO] tool palette (p.117)
when applying the Auto Lighting Optimizer (p.61), reducing noise (p.62)
or correcting aberration (p.63) after you have made any required
adjustments with the [RAW] and [RGB] tool palettes.

Introduction

Contents at
a Glance

Basic
Operation

Advanced
Operation

Advapced
Imag iting
and Pfinting

Processing
Large Numbers
of Images

Editing
JPEGI/TIFF
Images

Reference

Index

00
©

60



Using the Auto Lighting Optimizer
If the shooting result is dark or the contrast is low, you can use the Auto
Lighting Optimizer function to auto-correct the brightness and contrast,
and obtain a more pleasant image.

You can also change the settings of the image shot with the camera’s
Auto Lighting Optimizer function.

This function is compatible only with RAW images shot with EOS-1D
Mark 1V, EOS 5D Mark Il, EOS 7D, EOS 60D, EOS 50D, EOS 600D,
EOS 550D, EOS 500D and EOS 1100D.

* ALO stands for Auto Lighting Optimizer.

Select the [NR/Lens/ALO] tab sheet from the tool
palette in the edit window or edit image window.

RAW TRGB ‘ MR.fLens/ALO [)
| Auto Lighting Optimizer |
& 0
Low Standard Strong
Noise reduction Appl |
| MR Preview...
RAW
Luminance noise reduction:{1)
o 20
Chrominance noise reduction: (3)
o { 20
TIFF/IPEG
Lenz aberration correction Tune... | |
Peripheral ilumination 35
Chromatic aberration OFF
Color blur OFF
Distortion OFF

Checkmark the checkbox.

RAW |RcB |NRﬂensmli

| Auto Lighting Optimizer

[
Low Standard Strong

Checkmark

For images shot with the camera’s Auto Lighting Optimizer
function, the checkbox is already checked.

Change the settings according to your preferences.

| Raw | ReB |NRﬂensmli

| Auto Lighting Optimizer

T

I Low Standard Strong

Select from three levels:

Low/Standard/Strong

Auto correction is applied to the image to match the settings.
For images shot with the camera’s Auto Lighting Optimizer
function, the settings at the time of shooting are applied as the

default values.

To cancel the Auto Lighting Optimizer, remove the check mark

from the checkbox.

(D) When [Highlight tone priority] is set to [Enable] in EOS 7D, EOS
60D, EOS 600D, EOS 550D and EOS 1100D Custom Functions,
the Auto Lighting Optimizer function cannot be set.
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Reducing Noise

You can reduce noise that arises in RAW images shot at night or with a
high ISO speed.
NR is an abbreviation for “noise reduction”.

Select the [NR/Lens/ALO] tab sheet from the tool
palette in the edit window or edit image window.

Click the [NR Preview] button.

| Moise reduction Appl |

[ [ MR Preview... I

AW

The [NR Preview] window appears.

Adjust an image.

Navigator
window

—Enlargement

display
| Raw position
Luminance noise rj n:{7)
o L = Drag the
Chrominance noise, tion:(8) .
D 0 o sliders

NR check window

You can set a noise reduction level from within a range of 0 to 20.

The larger the setting, the larger the noise reduction effect.

The noise reduction effect can be checked when an image is
displayed at 100% in the NR check window.

You can change the display position of the NR check window by
dragging the enlargement display position in the navigator
window.

Click the [Apply] button.

Noise reduction is applied to the image and the image is
redisplayed.

? The noise reduction function does not work

Noise reduction cannot be applied when [Viewing and saving RAW
images] (p.78) is set to [High speed] in the [Preferences] window.
Select [High quality] to reduce noise.

Ny
== To set the same noise reduction level for several images

After selecting multiple images in the main window, you can set the
same noise reduction level for the images without displaying the [NR
Preview] window, by adjusting the noise reduction level in the [NR/Lens/
ALQ] tool palette (p.117) using the [Luminance noise reduction] and
[Chrominance noise reduction] sliders, and then clicking the [Apply]
button.

@ You can set the default noise reduction beforehand, using
[Default noise reduction settings] in the [Tool palette] tab sheet in
the [Preferences] (p.81).

* When [Apply camera settings] is selected, you can pre-set a
noise reduction level that suits the camera settings beforehand
as the default.

* When [Set as defaults] is selected, you can pre-set a preferred
default setting for the noise reduction level beforehand. This is
particularly useful for applying noise reduction to all the images
in a folder at once, such as batch noise reduction for images
with high ISO speeds.

However, for images with recipes attached, the noise level

recorded in the recipe will be applied.

If [Luminance noise reduction] has been set, resolution may be

reduced along with reduction of noise.

If [Chrominance noise reduction] has been set, color bleeding

may occur along with reduction of noise.

For a list of [NR Preview] window functions, refer to p.118.
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Correcting Lens Aberration

You can easily make corrections to drops in peripheral illumination,
distortions in the subject, and color blur which occur by the physical
characteristics of the lens or slightly remaining aberration.

Please note that you can only correct RAW images which have been
taken with the compatible cameras and lenses listed below. JPEG or
TIFF images cannot be corrected.

Compatible Lenses

Fisheye, ultra wide, and wide angle lenses
EF 14mm f/2.8L USM EF 14mm f/2.8L Il USM*3
EF 8-15mm f/4L USM Fisheye*3 EF 15mm f/2.8 Fisheye*3

Compatible Cameras

EOS-1D Mark IV EOS-1Ds Mark Il EOS-1D Mark Il
EOS-1D Mark II N EOS-1Ds Mark Il EOS-1D Mark I
EOS-1Ds EOS-1D EOS 5D Mark I
EOS 5D*1 EOS 7D EOS 60D

EOS 50D EOS 40D EOS 30D*?
EOS 600D EOS 550D EOS 500D

EOS 450D EOS 400D DIGITAL EOS 1100D
EOS 1000D — —

*1 Requires firmware version 1.1.1
*2 Requires firmware version 1.0.6

EF 20mm /2.8 USM

EF 24mm f/1.4L Il USM*3
EF 28mm /1.8 USM

EF 35mm f/1.4L USM

EF 24mm f/1.4L USM
EF 24mm /2.8

EF 28mm /2.8

EF 35mm f/2

Standard and medium telephoto lenses

EF 50mm f/1.2L USM*4
EF 50mm /1.8

EF 85mm f/1.2L USM
EF 85mm /1.8 USM

EF 50mm f/1.4 USM

EF 50mm /1.8 I

EF 85mm f/1.2L Il USM*5
EF 100mm f/2 USM

Telephoto lenses

EF 135mm /2L USM

EF 200mm f/2L IS USM*3

EF 200mm f/2.8L Il USM

EF 300mm f/2.8L IS USM

EF 400mm f/2.8L Il IS USM*3
EF 400mm f/5.6L USM

EF 500mm f/4L IS USM

EF 800mm f/5.6L IS USM*3

EF 135mm /2.8
(with Softfocus mechanism)

EF 200mm f/2.8L USM

EF 300mm f/2.8L Il IS USM*3
EF 300mm /4L IS USM

EF 400mm /2.8L IS USM

EF 400mm f/4 DO IS USM
EF 600mm f/4L IS USM
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Zoom lenses

EF 16-35mm f/2.8L USM

EF 17-35mm f/2.8L USM

EF 20-35mm /3.5-4.5 USM

EF 24-85mm /3.5-4.5 USM

EF 28-70mm f/2.8L USM

EF 28-90mm f/4-5.6 1l USM

EF 28-90mm /4-5.6 Il

EF 28-105mm /3.5-4.5 USM
EF 28-105mm /4-5.6 USM

EF 28-135mm /3.5-5.6 IS USM
EF 28-200mm f/3.5-5.6 USM
EF 55-200mm f/4.5-5.6 1l USM
EF 70-200mm f/2.8L USM

EF 70-200mm f/2.8L IS 1l USM*3
EF 70-200mm f/4L IS USM*4
EF 70-300mm /4-5.6 IS USM
EF 75-300mm f/4-5.6 11*3

EF 75-300mm f/4-5.6 USM

EF 75-300mm f/4-5.6 [l USM
EF 90-300mm f/4.5-5.6 USM
EF 100-400mm /4.5-5.6L IS USM

EF 16-35mm f/2.8L Il USM*3

EF 17-40mm f/4AL USM

EF 24-70mm f/2.8L USM

EF 24-105mm f/4L IS USM

EF 28-90mm /4-5.6 USM

EF 28-90mm /4-5.6

EF 28-90mm /4-5.6 Il

EF 28-105mm /3.5-4.5 1| USM
EF 28-105mm f/4-5.6

EF 28-200mm f/3.5-5.6

EF 28-300mm f/3.5-5.6L IS USM
EF 55-200mm f/4-5.6 USM

EF 70-200mm f/2.8L IS USM

EF 70-200mm f/4L USM

EF 70-300mm f/4-5.6L IS USM*3
EF 70-300mm f/4.5-5.6 DO IS USM
EF 75-300mm f/4-5.6 111*3

EF 75-300mm f/4-5.6 Il USM

EF 90-300mm f/4.5-5.6

EF 100-300mm f/4.5-5.6 USM

Macro lenses
EF 50mm f/2.5 Compact Macro*3 EF 100mm f/2.8 Macro USM
EF 100mm f/2.8L Macro IS USM*3 EF 180mm f/3.5L Macro USM

MP-E 65mm /2.8 1-5x Macro
Photo*3

EF-S lenses
EF-S 60mm f/2.8 Macro USM EF-S 10-22mm f/3.5-4.5 USM
EF-S 15-85mm f/3.5-5.6 IS*3 EF-S 17-55mm /2.8 IS USM
EF-S 17-85mm f/4-5.6 ISUSM  EF-S 18-55mm f/3.5-5.6
EF-S 18-55mm /3.5-5.6 I11*3 EF-S 18-55mm f/3.5-5.6 Il
EF-S 18-55mm f/3.5-5.6 USM EF-S 18-55mm f/3.5-5.6 [l USM
EF-S 18-55mm f/3.5-5.6 IS I3 EF-S 18-55mm /3.5-5.6 IS*3
EF-S 18-135mm f/3.5-5.6 1S*3 EF-S 18-200mm f/3.5-5.6 1S*3
EF-S 55-250mm f/4-5.6 1S*3 EF-S 55-250mm f/4-5.6 IS [1*3

Aberration correction will not apply to images shot with a combination
of lenses *3 *4 *5 and EOS 5D or EOS 30D with the firmware versions
below.

* You cannot attach an EF-S lens to EOS 5D.

*3 EOS 5D with firmware version 1.1.0 or earlier, EOS 30D with
firmware version 1.0.5 or earlier

*4 EOS 5D with firmware version 1.1.0 or earlier, EOS 30D with
firmware version 1.0.4 or earlier

*5 EQOS 5D with firmware version 1.0.5 or earlier, EOS 30D with
firmware version 1.0.4 or earlier

You can also correct RAW images taken with the compatible lens
even when the extender is attached.

You can also correct RAW images shot with EF 50mm /2.5
Compact Macro fitted with Life Size Converter EF.

The aberration correction function is not available for images shot
with combinations of camera/lens other than those given under
“Compatible Cameras” and “Compatible Lenses”. They are
therefore not displayed and cannot be used.
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Making Corrections

You can make corrections to any of the four aberrations as below, either
one at a time or simultaneously.
Peripheral illumination
Chromatic aberration (color fringing which occurs in the periphery of
an image)
Color blur (blue or red color blur which sometimes occurs at the edge
of the highlighted area of an image)
Distortions

In the tool palette, select the [NR/Lens/ALO] tab
sheet.
Click the [Tune] button.

RAW |RGE | NRflens/ALO |
| Auto Lighting Optimizer |
I Low Standard Strong
| Noise reduction Appl |
| MR, Preview...
RAW
Luminance noise reduction: (1)
o i
Chrominance noise reduction:(3)
0 { 20
TIFF{IFEG
Lens aberration correction l | TN
Peripheral ilumination 35
Chromatic aberration OFF
Color blur OFF
Distortion OFF

The [Lens aberration correction] window appears.

Checkmark the items to be corrected.

The image is corrected and redisplayed.

Check the results of corrections to peripheral illumination or
distortions in the full view.

Check the results of corrections to chromatic aberration and color
blur by clicking the area on the image you want to check. In the
top right of the window, the area is displayed at 200% in the
enlargement display section (p.123).

You can lessen the degree of correction by moving the slider to
the left for the item you want to correct.

You can respectively correct red chromatic aberration with the [R]
slider of the [Chromatic aberration] or blue chromatic aberration
with the [B] slider.

To correct distortion aberration of images shot with a fisheye lens
(EF 8-15mm f/4L USM Fisheye or EF 15mm /2.8 Fisheye), four
effects can be selected from the [Effect] list box in addition to
[Shot settings] normally used for distortion correction.

The level of an effect can be adjusted with the adjustment slider
located below [Distortion].

For detailed information on each effect, refer to “Effects of
Distortion Aberration Correction for Fisheye Lenses” (p.66).
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For images shot with EF 8-15mm f/4L USM Fisheye, a fine-tune
slider is also displayed when you select [Emphasize Linearity]
from the [Effect] list box.

Adjust the amount of correction for distortion aberration with the
adjustment slider, and then adjust with the fine-tune slider if more
adjustment is required.

When the list box for selecting an extender is displayed, select
the extender attached at the time of shooting from the list box.

Click the [OK] button.

The [Lens aberration correction] window closes and the result of
the corrections is applied to the image in the edit window and the
image is redisplayed.

The result of the settings of the [Lens aberration correction]
window is also displayed in the tool palette.

In the main window, the [Q))] mark is displayed on the image to
indicate the lens aberration corrections (p.114).

Effects of Distortion Aberration Correction for
Fisheye Lenses

Shot settings
By selecting this option, only distortion aberration correction for
correcting optical distortion is performed.

Emphasize Linearity
This converts the image to a “central projection” style image. This
projection method is used with general lenses.

Differing from fisheye lenses, central projection displays straight lines

as straight lines.
By selecting this option, a wide-view panoramic image can be

obtained. However, the periphery is stretched, resulting in decreased

L
7
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Emphasize Distance

This converts the image to an “equidistant projection" style image.
This projection method preserves distance relationships.

Equidistant projection displays the same distances from the center to
the periphery as the same distances.

In particular, when shooting a celestial body such as the celestial
sphere, any height above the horizon (declination) is captured at an
equal interval. This method is therefore used in such photography as
celestial photography (star maps, solar path diagrams, etc.).

Emphasize Periphery

This converts the image to a “stereographic projection” style image.
This projection method emphasizes the periphery.

Stereographic projection allows position relationships on a spherical
surface, such as N, S, E, W on a map, to be displayed correctly. It is
therefore used for world maps and monitoring cameras.

By selecting this option, the periphery is stretched and may result in
decreased resolution.

Emphasize Center

This converts the image to an “orthogonal projection” style image.
With this projection method, the center is more emphasized.

Since an orthogonal projection allows a subject of the same
brightness to be displayed as occupying the same area in the image,
this method has typical uses in photography for celestial luminance
distributions and center-emphasized animal photography.

By selecting this option, the center is stretched and may result in
decreased resolution.

® While selecting any of the options [Emphasize Linearity],
[Emphasize Distance], [Emphasize Periphery], or [Emphasize
Center] will yield results similar to each of the projection methods,
the conversion does not exactly apply each projection method in
their precise sense.
Accordingly, care should be taken since they are not suited to
scientific or other such purposes.
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About Shooting Distance Information Slider

When correcting RAW images shot with the cameras in the table below,
if shooting distance information has been saved to the image, the slider
is set automatically according to this shooting distance information.
However, if no shooting distance information is saved to the image, the
slider is set automatically to the right end at infinity position and a [<!>]
appears above the slider.

If the image’s shooting distance is not infinite, you can minutely adjust
the distance by operating the slider while looking at the screen.

EOS-1D Mark IV EOS-1Ds Mark Il EOS-1D Mark Il
EOS 5D Mark Il EOS 7D EOS 60D

EOS 50D EOS 40D EOS 600D

EOS 550D EOS 500D EOS 450D

EOS 1100D EOS 1000D —

When correcting RAW images shot with the cameras in the table
below, it is set automatically to the right end at infinity position. You
can then minutely adjust the distance by operating the slider while
looking at the screen if the shooting distance is not infinite.

EOS-1D Mark II N EOS-1Ds Mark Il EOS-1D Mark I
EOS-1Ds EOS-1D EOS 5D
EOS 30D EOS 400D DIGITAL —

For RAW images shot with MP-E 65mm /2.8 1-5x Macro Photo or EF
50mm /2.5 Compact Macro with Life Size Converter EF, the slider
indicator changes to [Magnification factor].

[Shooting distance information] slider is applied to all the correction
items with check marks.

Correcting Multiple Images at a Time

Select multiple images to correct in the main window. Display tool
palette by clicking the [Tool Palette] button (p.112) in the toolbar. If you
perform correction procedures (p.65) when tool palette is displayed, you
can apply the same corrections to all the images selected in the main
window.

Also, you can apply same corrections by copying the recipe of the
corrected image and pasting it onto the multiple images (p.41).

? Additional information

Some noise appeared in the periphery of an image after
correcting [Peripheral illumination]

You can reduce the noise by using luminance and/or chromatic noise
reduction of the noise reduction function (p.62). However, if you had
applied high amount of [Peripheral illumination] correction to the
images that have been shot at night or with a high ISO speed, the
noise might not be reduced.

The image appears with less resolution after correcting
[Distortion]

You can make the image similar to the one before correction by
applying more sharpness with the sharpness adjusting function
(p.31).

The colors of the image became weaker after correcting [Color
blur]

You can make the image similar to the one before correction by
adjusting the color tone (p.29) and/or the color saturation (p.96) to
make the color deeper.

The result of [Color blur] correction cannot be detected
[Color blur] correction is effective for correcting blue or red color blur

which occurs at the edge of the highlighted area of an image. If
conditions do not match, correction cannot be made.

@ The periphery of the image may be truncated when [Distortion]
correction is made.

@ For a list of the [Lens aberration correction] window functions, refer
to p.123.
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Performing Automatic Dust Erasure Processing

The Dust Delete Data that is appended to images shot with the camera
that can attach this data, can be used to automatically erase dust spots.

Compatible Cameras

EOS-1D Mark IV EOS-1Ds Mark 11l EOS-1D Mark 11l
EOS 5D Mark I EOS 7D EOS 60D

EOS 50D EOS 40D EOS 600D

EOS 550D EOS 500D EOS 450D

EOS 400D DIGITAL EOS 1100D EOS 1000D

In the main window, select an image appended with
Dust Delete Data.

Click the [Stamp] button.

I
y ® & @ 2

Rotate right Batch

Quick Stamp Trmming
c process

Angls

[

The copy stamp window appears.

When the image has redrawn itself, click the [Apply
Dust Delete Data] button.

2/ 3 EAUsers\CANON\Pictures\Photol

\\\\\\\\\

RRRRRR

100%view to perform stamp operation

Dust spots are erased in a single operation.

Click the [OK] button to return to the main window.

The [8,] mark (p.114) is displayed on an image from which dust
spots have been erased.
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? Additional information

The dust-erased image can be reverted to its original condition
at any time

A dust-erased image is displayed or printed as a dust-erased image.
However, since the dust on the image is not actually erased, you can
always revert to the original image by clicking the [Undo] button in the
copy stamp window or performing the “Re-Editing an Image”
procedure (p.43).

Check dust erasure in the copy stamp window

Check dust erasure in the copy stamp window. Images before dust
erasure are displayed in other windows and you will be unable to
check them.

Printing dust-erased images
You can print as a dust-erased image by printing it in DPP.

The [Apply Dust Delete Data] button cannot be clicked

Even with an image that has Dust Delete Data attached to it in the
camera, if there is no dust to remove by DPP from the image, the
[Apply Dust Delete Data] button will be disabled.

To erase dust spots that cannot be erased with the automatic
dust erasure processing

In automatic dust erasure processing, dust spots are erased based on
information relating to dust saved in the Dust Delete Data. However,
there may be cases where you will not be able to erase dust spots
depending on the type of dust. If this occurs, erase those dust spots
using the repair function (p.71) or the copy stamp function (p.73).
The image becomes a dust-erased image when converted and
saved

The dust-erased RAW image actually becomes a dust-erased image
when converted to a JPEG or TIFF image and saved (p.42).

Y

~
-

= Useful functions of the copy stamp window

Checking the dust erased spots

After step 3, you can display and check in detail the erased dust spots
one by one by pressing the <Shift> + <F> keys. (Press the <Shift> +
<B> keys to return to the previous dust spot.)

Canceling a specified erased dust spot only

After step 3, you can press the <Shift> + <F> keys or the <Shift> +
<B> keys to display the erased dust spot, and then press the <Shift>
+ <Del> keys to cancel only the erased dust spot displayed.

Switch between full screen display/normal screen display using
shortcut keys

You can also switch between full screen display/normal screen
display by pressing the <Alt> + <Enter> keys.

Applying the dust erasure result to another image

You can apply dust erasure to the same place in another image by
clicking the [Copy] button to copy the dust erasure results and then
displaying the other image to which you want to apply the results and
clicking the [Paste] button.

ﬁl For a list of the copy stamp window functions, refer to p.124.

Automatic Dust Erasure Processing in the Main Window

In the main window, you can also automatically erase dust spots in
multiple images appended with Dust Delete Data.

Select multiple images appended with Dust Delete
Data, and then select the [Adjustment] menu »
[Apply Dust Delete Data].
Dust spots in all the selected images are erased in a single
operation.
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Manually Erasing Dust (Repair Function)

You can erase dust spots in an image by selecting them one by one.

In the main window, select the image you want to
erase dust spots.

Click the [Stamp] button.

|
vV & @ & @

Rotate right Quick Stamp Trimming Batch
check process

Rating

The copy stamp window appears.

When the image has redrawn itself, double-click the
point from where dust is to be erased.

2/ 3 E\Usera\CANONAP IR e POt OO 0 eIMG 00507 R (3456 X 2300 ]

eeeeeeeeeee

o - Double-

click

The display changes to 100% view.
The display position can be changed by dragging.

Click the button that matches the dust spot to be
erased.
If the dust spot is dark in color, click the [[@*+_]] button, and if
the dust spot is light in color, click the [[O»O)]] button.
When you move the cursor over the image, the dust erasure
range appears as [O].
Place the dust spot to be erased within the [O] and

Brush Pendl

fJ = Click

Circle the dark spot to repair

The dust spot within the [Q] is erased.

Click on another part of the image to continue erasing dust spots
in the image.

To erase dust in another part of the image, either right-click with
the mouse, or click the button clicked in step 4 again to cancel dust
erasure processing and perform the operation again from step 3.
When the dust spot cannot be erased, [§)] is displayed.

Click the [OK] button to return to the main window.
The [8,] mark (p.114) is displayed on an image from which dust
spots have been erased.
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? Additional information

Click several times when dust spots are not erased completely
Where unwanted dust spots are not erased even after performing
step 5 once, they may be erased completely when you click several
times.

Mainly spots of dust can be erased with the repair function
Spots of dust can be erased with the repair function. You may be
unable to erase lines of dust. In this case, use the copy stamp
function (p.73).

The dust-erased image can be reverted to its original condition
at any time

A dust-erased image is displayed or printed as a dust-erased image.
However, since the dust on the image is not actually erased, you can
always revert to the original image by clicking the [Undo] button in the
copy stamp window or performing the “Re-Editing an Image”
procedure (p.43).

Check dust erasure in the copy stamp window

Check dust erasure in the copy stamp window. Images before dust
erasure are displayed in other windows and you will be unable to
check them.

Printing dust-erased images

You can print as a dust-erased image by printing it in DPP.

The image becomes a dust-erased image when converted and
saved

The dust-erased RAW image actually becomes a dust-erased image
when converted to a JPEG or TIFF image and saved (p.42).

Y

-@> Useful functions of the copy stamp window

Checking the dust erased spots

After step 5, you can display and check in detail the erased dust spots
one by one by pressing the <Shift> + <F> keys. (Press the <Shift> +

<B> keys to return to the previous dust spot.)

Canceling a specified erased dust spot only
After step 5, you can press the <Shift> + <F> keys or the <Shift> +

<B> keys to display the erased dust spot, and then press the <Shift>

+ <Del> keys to cancel only the erased dust spot displayed.

Switch between full screen display/normal screen display using

shortcut keys

You can also switch between full screen display/normal screen
display by pressing the <Alt> + <Enter> keys.

Applying the dust erasure result to another image

You can apply dust erasure to the same place in another image by
clicking the [Copy] button to copy the dust erasure results and then

displaying the other image to which you want to apply the results and

clicking the [Paste] button.

To apply dust erasure to the same place in several other images, you

can efficiently erase dust spots by clicking the images while holding
down the <Ctrl> key in the main window, or, by selecting multiple
images by clicking the first image and then clicking the last image
while holding down the <Shift> key, and then displaying the copy
stamp window.

@ For images shot with ISO speed range expansion set, noticeable
noise may make it difficult to view dust spots in the copy stamp
window, so using this function is not recommended.

@ For a list of the copy stamp window functions, refer to p.124.
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Erasing Unwanted Parts of an Image (Copy Stamp Function)

You can correct an image by pasting a section copied from another part
of the image to an unwanted part of the image.

Follow steps 1 to 3 in “Manually Erasing Dust (Repair
Function)” (p.71).

Specify the section to be copied.
Click on the section that is to be the copy source while holding
down the <Alt> key.
To change the section that is to be the copy source, perform the
operation above again.
To fix the position of the copy source, checkmark [Fix Copy
Source position].

Correct the image.
Click or drag on the section you want to correct on the image. [+]
in the window indicates the copy source and [Q] indicates the
copy destination.
The copied image is pasted in the position to which it was
dragged.
For [Pen type], you can select from [Brush] (the pasted image’s
borders simulate a brush) and [Pencil] (the pasted image’s
borders are sharp).

Click the [OK] button to return to the main window.
The [8,] mark (p.114) is displayed on a corrected image.

Transferring a RAW Image to Photoshop

A RAW image can be converted to a TIFF image (16bit) and transferred
to Photoshop.

Select the [Tools] menu P [Transfer to Photoshop].
Photoshop starts up and the transferred image is displayed.

? A single image can be transferred at a time

Only one image can be transferred at a time. To send multiple images at
a time, refer to p.89.

@ Compatible versions of Photoshop are 7.0 or later.
Transferred images are automatically converted to TIFF images
(16bit) to which an ICC profile (p.127) is added. The ICC profile
contains information about [Preferences] (p.82) or work color
space set for each image as described below and the appropriate
color information is relayed to Photoshop.
When you exit Photoshop, only the original RAW image remains,
and the transferred image will disappear. Saving the transferred

image as a separate image in Photoshop is highly recommended.

Setting Work Color Space

A different work color space (p.128) from the default settings (p.82) can
be set for each image.

Select the [Adjustment] menu » [Work color space] »
color space to be set.

? A color space set individually does not change even when the
default setting is changed

If you set an image with a color space different to the default setting and
then subsequently change the default color space setting (p.82), this
default setting will not be applied and the individually set color space will
remain.

5@/3 The color space of a RAW image can be changed freely as
many times as required

Since only the image processing conditions information changes, the
color space of a RAW image can be changed at any time.
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Printing with Shooting Information

You can freely lay out one image on one sheet of paper and print
together with titles and shooting information, etc.

Introduction
=g To maintain the settings

—_—

Select one image to be printed.

) - : e a Glance
settings can be applied to another image when printing.
Select the [File] menu » [Print with detailed setting]. P
@ You can set printer profiles (p.82). Opea:zltfon
click the [Print] button. colors (p.82). .
Switches the settings tab sheet op‘é?:ggn

[ @ £:sers\ CANON\PicturesiPhotobooo o
.t

P””‘P" Image | Text | Settings
> 4

Printer:
[ Ganon PRAUS s -

Media: 297.0mm x 210.0mm
A4 -

Media orientation:

() Portrait (@ Landscape

Media type:

Plain Paper

Print Quality:
Standard

Borderless:
off

Print profile:
CMYK profile:

CMS settings...

Print preview

The image can be moved by dragging.

Drag the four corners of the image to change the size.

For the shooting information, click [E]] on the [Text] tab sheet
and select the necessary items in the window that is displayed.

Print Cancel Apply

The settings of each tab sheet in step 3 are memorized when the [Apply]
button is clicked (excluding the contents of the [Text] tab sheet). The
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Printing a Thumbnail List (Contact Sheet Printing) o
You can print rows of multiple images on one sheet of paper. @ To maintain the settings
Select images to be printed in a thumbnail list. The settings of each tab sheet in step 3 are memorized when the [Apply] S
button is clicked (excluding the contents of the [Text] tab sheet). The : r(';fa"nzea
. . settings can be applied to another image when printing.
Select the [File] menu » [Contact Sheet Prints]. 9 PP 9 P 9
; ; ; P @ You can set printer profiles (p.82) NS
Specify the required settings for printing, and then =L printer p p-c2). S Operation
. . If CMYK simulation has been set, the image is printed in the set )
click the [Print] button. slons (502
Switches the settings tab sheet Advanced
Operation
rirfi:nnn PLAUS s vl
Imaggiltmg
and Pfinting
e Il:q Zm.nmm)cZQT.nmr'nl
Media orientation: ProceSSing
(@ Portrait () Landscape Lal'ge Numbers
Media type: of Images
Prlnst;!:::rt: Editing
JPEGI/TIFF
Borderless: Images
Off
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Printing RAW Images on a High-End Canon Printer

Printing with a High-End Canon Inkjet Printer

For high-end Canon inkjet printers that are compatible with the printing
software Easy-PhotoPrint Pro, you can print with DPP by a simple
operation that has the following features:

Simple printing of RAW images

Printing in faithful colors

High quality printing using a wide color space of Adobe RGB, etc. and
the wide color reproduction range of a high-end Canon inkjet printer

To print with DPP, first install Easy-PhotoPrint Pro version 1.3 or later on
your computer.

Select the [File] menu » [Plug-in printing] » [Print
with Easy-PhotoPrint Pro].
Easy-PhotoPrint Pro starts up.

Match on-screen image colors and printing result

colors.
Select [Custom] in [Print Quality], click the [Set] button, and in the
window that appears, drag the slider to [1] at the right end, and
then click the [OK] button to close the window.
Next, click the [Color Adjustment] button to display the [Color
Adjustment] window and display the [Color Management] tab
sheet. Set [Color Mode] to [Enable ICC Profile] and [Printer
Profile] to [Auto], and then click the [OK] button to close the
[Color Adjustment] window.

Specify any other required settings for printing, and

then print.

? Additional information

Print up to 1000 images at a time

You can print up to 1000 images selected in DPP at a time. When
printing more than 1000 images, divide the printing into several jobs.
Function set in DPP that is not applied to printing

Specified CMYK simulation (p.82) is not applied.

The printed image’s color is not what you expected

In the Easy-PhotoPrint Pro window, click the [Color Adjustment]
button to display the [Color Management] tab sheet, set [Rendering
Intent] to [Perceptual] (p.128), and try printing.

1/

-@> Advantages of printing with Easy-PhotoPrint Pro

Printing with faithful colors

When a color space is set (p.73, p.82), it is automatically transmitted
from DPP to Easy-PhotoPrint Pro, allowing you to print with faithful
colors.

Printing with a wide color reproduction
When the color space setting (p.73, p.82) is set to a color space wider
than sRGB (such as Adobe RGB), the image is printed with a wider

color gamut than an image that has an sRGB color space, with green
and blue in particular being reproduced vividly.
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Printing with a Large-Format Canon Printer

You can use DPP to print with the DPP-compatible Canon large-format
imagePROGRAF printer. To print with DPP, first install imagePROGRAF
Print Plug-In for Digital Photo Professional on your computer.

Select the [File] menu » [Plug-in printing] » Plug-In
for the printer you use.
The Plug-In starts up.

Specify the required settings for photograph
printing, and then print.

? Additional information

A single image can be printed at a time

You can print a single image selected in DPP at a time. When printing
multiple images, perform printing for each image individually.
Functions set in DPP that are not applied to printing

Specified output resolution (p.78) and CMYK simulation (p.82) are not
applied.

/

< Advantages of printing with imagePROGRAF Print Plug-In

Printing with faithful colors
When a color space is set (p.73, p.82), it is automatically transmitted
from DPP to the Plug-In, allowing you to print with faithful colors.

Printing with a wide color reproduction

When the color space setting (p.73, p.82) is set to a color space wider
than sRGB (such as Adobe RGB), the color reproduction range of the
imagePROGRAF printer is fully utilized and the image is printed with
a wider color gamut than an image that has an sRGB color space,
with green and blue in particular being reproduced vividly.
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Specifying Preferences

You can change the various functions of DPP in the [Preferences]
window. Check the contents of each window and set.

Also, depending on the item, a detailed explanation may be available,
so refer to each window.

Select the [Tools] menu » [Preferences].
The [Preferences] window appears.

Select the tab sheet, specify the settings, and then
click the [OK] button.

Preferences

General settings | View settings I Tool palette I Color management |

Startup folder
@ Last displayed folder
() Specified folder

Browse. ..

Save redpe
@ Display message when adding file

(71 add to file automatically

Viewing and saving RAW images

‘iewfsave RAW images at high quality

@) High quality {recommended
B Hictquakty ) Moire is reduced and the NR. tool palette can be used

View images at high speed (moire reduction
[y

JPEG image quality

[ Remove block noise and mosquito noise

Default value of output resolution

350 dpi(1-60000)

At EOS Utility startup

|l [ Edit image window enabled at EOS Utility startup

[ e

General Settings

You can specify the folder that opens when DPP is started up, image

quality of displayed and saved RAW images, etc.

General settings Wiew settings I Tool palette

Color management

Startup folder
(@ Last displayed folder
(7) Specified folder

Browse...

Save recpe
(@) Display message when adding file

() Add to file automatically

Viewing and saving RAW images

View/zave RAW images at high quality

(@ High quality (recommended)
Moire iz reduced and the NR. tool palette can be used

View images at high speed (moire reduction
[l off)

JPEG image quality

[ remove block noise and mosquito noise

Default value of output resolution

350 dpi{1-60000)

ALEOS Uity startup
[ Edit image window enabled at EOS Utility startup

[ ox Jf

Cancel
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Viewing and saving RAW images

You can select from two types of image quality for displaying/saving
RAW images: high image quality with false color reduction processing
and noise reduction function (p.62) used, or high speed without false
color processing and noise reduction function used.

[High quality]
False color reduction processing is automatically applied, and the
image can be displayed/saved as a false color reduced-high quality
image. Furthermore, you can use the noise reduction function (p.62)
to reduce the luminance noise and chrominance noise.
Because the effects of the false color reduction processing and noise
reduction function are difficult to see in the [50% view] or [Fit to
window] display of the edit window and edit image window, use
[100% view] or [200% view] to check.
We recommend that you normally set [High quality] for a balance
between image quality and display speed.

[View images at high speed (moiré reduction off)] of [High quality]
If you checkmark [View images at high speed (moiré reduction off)],
when the image is displayed in the edit window or the edit image
window, false color reduction processing is not applied. However, you
can use the noise reduction function.

As the setting is the same as [High quality] other than for image
display, the image undergoes false color reduction processing when it
is saved.

[High speed]
Since false color reduction processing is not applied, the display
speed of a RAW image in the edit window or the edit image window,
and the time it takes to save a RAW image is shorter than with [High
quality].
You cannot use the noise reduction function (p.62).
Depending on the image, it may be displayed/saved with false color
or noise being noticeable.

® For images shot with ISO speed range expansion set, the difference
in image quality between [High quality] and [High speed] becomes
remarkable. To check the image quality of images shot with ISO
speed range expansion, make sure to set [High quality] and check
the images in the edit window or edit image window.

JPEG image quality

[Remove block noise and mosquito noise]
You can improve the quality of a JPEG image by reducing the noise
particular to JPEG images.
This setting is also effective when RAW images are converted to
JPEG images and saved (p.42, p.88) and for JPEG images that have
been saved with a different name.

? The extent of the improvement in noise reduction

The higher the JPEG image’s compression rate, the more noise is
reduced. When the compression rate is low, the effect of noise reduction
is negligible.

Default value of output resolution

You can set the resolution for RAW images converted and saved as
JPEG or TIFF images (p.42, p.88).
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View Settings

You can specify settings relating to the display.

| General settings View settings Tool palette I Color management

Grid pitch

64 Pixels{8-258)

Image selection status

[¥] tmages opened in Edit window remain selected in main window

Magnification in Edit window

@) Fit to window () 50% ©) 100% () 200%

Magnification when the Edit/Edit image window is double-clicked

@ 50% @ 100% ©) 200%

RAW and JPEG

[CIDispiay onty CR2 mages for CR2 and JPEG files of the same name:

Sort order in main window

[ Retain sort order
Highlight/shadow Alert

Highlight 255 {192-255) .

Shadow 1] (0-64) .

Quick check tool display

@ 50% (71 100% (moiré reduction off)

[ oK. ] [ Cancel

Sort order in main window

You can set the order of images which have been rearranged in the
main window to be maintained or not maintained (p.21).

If you checkmark the checkbox, the order of the rearranged images is
maintained even if you exit DPP or select another folder in the folder
area.

If you remove the check mark, the order of the rearranged images is not
maintained and reverts to the previous order when you exit DPP or
select another folder in the folder area.

Highlight/shadow warning

Highlighted/shaded areas that exceed the set range can be displayed
on the image as warning indicators (p.55).
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Tool Palette

You can specify settings for the tool palette.

Preferences

| Coormanagement |

General settings View settings | Tool palette

Default settings of RGE tool palette
Tone curve mode Tone curve interpolation method
@ RGBERGE @) Curve
Luminance R G B Straight
Histogram display
Before adjustment
@) After adjustment

Tool palette display in Edit Image Window
'@ Docking display

Floating display

Modified Picture Style settings

|¥| Retain settings of each Picture Style

Tool palette display mode

| same for Main window and Edit window

Default noise reduction settings
@ Apply camera settings

_) Set as defaults

TIFF/IPEG luminance noise reduction:{0) o [} 20

TIFF/IPEG chrominance noise reduction:(0) o [} 20

Cancel

Default settings of RGB tool palette

You cannot apply changes to the settings until you re-open the folder.

? Changes are not applied to the edited image

Even if the default setting is changed, the new default setting is not
applied to edited (i.e., adjusted using the tool palette, trimmed, dust-
erased) images. Change each one individually.

Modified Picture Style settings

You can select whether the [Color tone], [Color saturation], [Contrast],
[Unsharp mask] and [Sharpness] settings will be changed or retained,
when you change the Picture Style.
If you checkmark the checkbox, the [Color tone], [Color saturation],
[Contrast] and [Sharpness] settings will be changed to match the
camera’s preset settings, when you change the Picture Style.
If you remove the check mark, the [Color tone], [Color saturation],
[Contrast] and [Sharpness] settings will be retained, even if you
change the Picture Style.

Default noise reduction settings

You can set a default beforehand for the noise reduction level.
RAW Images
* When [Apply camera settings] is selected, you can pre-set a noise
reduction level that suits the camera settings beforehand as the
default.
* When [Set as defaults] is selected, you can pre-set a preferred
default setting for the noise reduction level beforehand.
JPEG/TIFF Images
* You can set a desired default noise reduction level beforehand.
For images not having a recipe attached, the default set here for noise
reduction level is applied. However, if you want to apply settings to
images in the opened folder, you need to re-open the folder after making
settings here. For images with a recipe attached, the noise level
recorded in the recipe remains as it is and the default for noise reduction
level set here is not applied.

=@> Advantages of setting a noise reduction default

In instances where the same level of noise occurs in several images,
such as images shot with high ISO speed, setting an appropriate default
noise reduction setting enables you to apply a batch noise reduction
default to all the images displayed in DPP (excluding images with a
recipe attached). This eliminates the need to apply noise reduction to
each individual image. And, since you always shoot with the same
conditions, it is also useful when you want to set the same noise
reduction level for all shot images.
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Color Management

You can specify settings relating to color management, such as settings
for work color space, conditions for color matching, etc.

l | General settings | View settings | Tool palette | Calor management |_

Default settings of Wark colar space
@ sRGE () Apple RGB
() Adobe RGE (T ColorMatch RGB
* Wide Gamut RGB

Color matching settings
For display

@ sRG8
Use the OS settings

~1 Monitor profile

Printing profile
Perceptual

None. —. >

(@ Relative Colorimetric

CMYK simulation profile

Perceptual
— None — =

@) Relative Colorimetric

Rendering intents when using Easy-PhotoPrint
" Perceptual

@ Relative Colorimetric

_ Cancel

Default settings of Work color space

You can select from five types of color space (p.128) that is applied as a
default setting in RAW images. Color space that has been set is applied
as the color space when a RAW image is converted and saved (p.42,
p.88) or printed (p.43, p.46, p.49, p.74 to p.77).
If you have changed the setting, and you restart DPP, the new setting
is applied as the default setting color space.
You can check color space that has been set in an image in the main
window (p.112, p.113), the edit window (p.115), and the edit image
window (p.120).

? Changes are not applied to the edited image

Even if the default setting is changed, the new default setting is not
applied to edited (i.e., adjusted using the tool palette, trimmed, dust-
erased) images. Change each one individually.

@ You can set a color space that is different from the default settings
for each image (p.73).

Display setting (color setting of the monitor)

Where a profile (p.127) is attached to the monitor you are using, you can
display an image in more faithful colors by setting the profile.
If you select [Use the OS settings], the color profile set in Windows
will also be applied in DPP.
If you are using multiple monitors, only the profile of the primary
monitor is applied to DPP.
Select the [Monitor profile], click the [Browse] button and in the dialog
box that appears, select a profile for your monitor.

Ny

=@> Precise coloring with a third-party monitor color reader

If you use a profile created using a third-party monitor color reader,
images can be displayed in even more precise colors.
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Setting of printing profile (color setting of the printer)

Where a profile (p.127) is attached to the printer you are using to print
images, you can print an image and simulate the colors displayed on
screen by setting the profile. The profile that has been set is applied to
all printing (p.49, p.74, p.75) except for printing using a Canon inkjet
printer (p.43, p.46) or linked printing (p.76, p.77).

? The adjustment function of the printer driver should not be
used

Even if you set a printer profile, if you use the color adjustment function
of the printer driver, the image may print in colors different from those
displayed on screen.

5@/3 Automatic settings for printing using EPP EX, EPP, and
linked printing

If you are printing using a Canon inkjet printer (p.43, p.46) or using
linked printing (p.76, p.77), a profile is set automatically even when the
[Printing profile] setting is not performed. This allows you to print faithful
colors easily.

Setting of CMYK simulation profile

You can select the color when printing in the CMYK environment of a
printing machine, etc. from four types of profiles (p.128) and perform
simulation on screen.
When CMYK simulation has been set, [CMYK] appears (p.112, p.113,
p.115, p.120) in the bottom of the main window, edit window and edit
image window, and colors can be checked.

To temporarily cancel CMYK simulation, press the <Ctrl> + <Y> keys.

Rendering intents when using Easy-PhotoPrint
You can set a rendering intent (matching method) (p.128) for printing
using Easy-PhotoPrint (p.46).

The rendering intent is ordinarily set to [Relative Colorimetric].

When colors with [Relative Colorimetric] are not satisfactory, set to
[Perceptual].
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4 Useful Functions for Processing Large Numbers of RAW Images

For users shooting a large amount of RAW images, the convenient
function of batch processing large amounts of RAW images is explained
here.
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Utilizing Adjustment Contents (Recipe)

All the adjustment contents (recipe) made using the tool palette can be
saved as an individual recipe file (extension “.vrd”) and loaded and

applied to another image.

You can edit images efficiently by selecting and adjusting one image
from images shot with the same shooting environment and batch
applying the adjustment results to a large number of images.

e I

[ RaW  [Res | NRjLens/ALO

| Brightness adjustment |
0 0.00

|White balance adjustment |
I 2 3 Register...

IShot settings V] [ Tune... J

| Picture Style |

Ismndard

-10.0 8.0 60 40 -20 00 20 40
Contrast:(0) {1
Highlight: (0) 0
Shadow:{0) 0

[ILinear
Color tone: (1) I

Color saturation: (0) 0

[Unsharp mask - I
Strength:(0) ]
Fineness:(0) [
Threshold: (1) {1

hiage -data'

I \N
Lvid)

Contents adjusted using the tool
palette can be handled
individually as a recipe file
(extension “.vrd”).

|§| The adjustment contents of JPEG or TIFF images (p.92) can be
saved as a recipe file (extension “.vrd”) and loaded and applied to
another image in the same way as with RAW images.

? Additional information

Recipe data includes tool palette contents

Recipe data includes adjustments made with the tool palette ([RAW],
[RGB] and [NR/Lens/ALO]). For this reason, other editing content
such as trimming or dust-erasure (copy stamp) is not included in the
recipe data.

Recipes adjusted with the [RAW] tool palette can only be applied
to RAW images

Adjustments in the [RAW] tool palette, which can only be made for
RAW images, are not applied to a JPEG or TIFF image even if they
are pasted.
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Introduction

Saving Recipes as a File

Select an edited image, and then select the [Edit]

Copying a Recipe and Applying to Another Image

You can copy a recipe of an edited image and then apply it to another
image. Contents at

menu » [Save recipe in file].
The [Save recipe in file] dialog box appears.

Select the destination folder, enter a file name, and

and then select the [Edit] menu » [Copy recipe to Basic
then click the [Save] button. clipboard]. Operation
The recipe is copied.
? Check the contents of a recipe file by pasting to an image Select the image to Whi_Ch the recipe is to be' applied Sg‘é?Q{i’ﬁﬂ
o . _ and then select the [Edit] menu » [Paste recipe to
When you do not know the contents of a recipe file, paste it to an image .
L : selected image].

and check the settings in the tool palette. When only a few settings are o ) _ Advanced
adjusted, we recommend you use a file name that describes the The recipe is applied to the image. Image Editing
contents or that you separately record the adjustments as text and Printing

information.

Select the image from which a recipe is to be copied

a Glance

Procefsing
Largbers
of Images
Loading and Pasting Recipes -
iting
Select the image to which a recipe is to be applied, J'TES“;EF
and then select the [Edit] menu » [Read and paste J
recipe from file].
The [Open] dialog box appears. Reference
Select a recipe and click the [Open] button.
The recipe is applied to the image.
Index

00
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Batch Apply White Balance to Images (Personal White Balance)

The white balance adjustments made to a RAW image shot in a specific
shooting environment can be registered as personal white balance. You
can then perform efficient white balance adjustment by applying this
personal white balance to a large number of RAW images shot in the

Introduction

Applying Personal White Balance

In the main window, select the image to which white

Contents at

, : balance is to be applied. a Glance
same shooting environment.
Click the [Tool Palette] button on the toolbar.
- - - The tool palette appears. Basic
Registering Personal White Balance patetie app Operation

Click the personal white balance number button that
is to be applied.

Adjust the white balance (p.27, p.28, p.56).

To adjust white balance, select a setting other than [Shot . _ Advanced

settings] from the [White balance adjustment] list box (p.27). You RAW [RGB | NR/Lens/ALO | Operation

will be unable to register the adjustments if you select [Shot | Brightness adjustment =]

settings]. U 0.00 Advanced
In the [RAW] tool palette, click the [Register] button. White balance adjustment X Image Editing

. . . — = and Printing
The [Register personal white balance] dialog box appears. (MJ sl e
. Daylight - | Tune... | i

Select the button number to be registered from the | l LProc SIgg
list and click the [OK] button. e o g 0T

Register personal white balance |5'3”da"d
Editing
Register current setting in personal white balance JPEG/TIFF
Images
Current setting: Click white balance
|l o Reference
-10.0 -8.0 -6..[] 4.0 -20 0.0 20 40
Contrast:(0) 1
Highlight: () 1 Index
Shadow: (0) 1
I_- Linear T
. . Color tone:(a) {1
"2 To use the registered personal white balance on another corfene
ter Color saturation: (1)
compu |Unsharp mask v‘
In step 3, click the [Export] button to write as a file. Strength:(0) l
Copy the file to another computer. Fineness:(0) I @
In DPP on the other computer, display the window of step 3. Bl 0

Click the [Import] button and in the window that appears, select the
copied file.

Personal white balance is applied to all the selected images.
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Batch Save as JPEG or TIFF Images (Batch Processing)

You can batch convert and save edited RAW images to highly versatile
JPEG or TIFF images.

The images are saved as separate images, so the RAW images remain
unaffected.

In the main window, select multiple images to be
converted.

Click the [Batch process] button on the toolbar (p.112).

The [Batch settings] window appears.

Specify the required settings, and then click the
[Execute] button.

IMG_0001.CR2 7| save folder

IMG_D002.CR2
IMG_0003.CR2 E:\Users\CANON Pictures |E
IMG_D004.CR2
IMG_D005.CR2 File format
IMG_D006.CR2
IMG_0007.CR2 Kind of file
IMG_D00B.CR2
IMG_D00S.CR2
IMG_0010.CR2
IMG_D011.CR2
MG 0012.CR2 Output setting
IMG_D013.CR2
MG D014.CR2 Outputresalution 350 dpi [J]Embed ICC profle
IMG_D015.CR2

Exif JPEG -

Image quality 10

©@) New file name
String Sequence number

DPP_ 0001
Save sequence number

Ex.: DPP_0001.JPG, DPP_0002.JPG...

Image transfer settings

Open image using software

Browse...

The batch processing dialog box appears and saving begins.
When all the images are saved, the [Exit] button appears in the
batch processing dialog box.

In the processing dialog box, click the [Exit] button.

"2 [Save] cannot be performed

In the [Batch settings] window, you cannot perform [Save] or [Save As]
(p.41, p.107) to edited RAW images.

5@/3 To save the developing/editing results for the version you are currently using

DPP’s RAW image development processing technology is continually
being improved upon so that you can perform the latest image
processing more appropriately.

Meaning that, between two differing versions of DPP, processing results
may differ very slightly even if with the same RAW image data, or the
results of significant editing of RAW image data with an attached recipe
may be different.

When you want to save the developing or editing results of the version
you are currently using as it is, it is recommended that you convert and
save images as JPEG image or TIFF images.

Q% Skillful batch saving

While saving is being performed, you can continue working in
another window

Since the saving function operates independently in the background,
you can continue with an operation in another window such as the
main window or the edit window during the saving process.

To convert all images and save, do not select an image in the
main window

If you do not perform step 1 and perform step 2 with no image
selected in the main window, all the images displayed in the main
window will be converted and saved.

@ If the message [Insufficient memory.] appears, too many images are
selected at the same time. Decrease the number of selected images.

@ If you have selected [New file name] in [File name], [Sequence
number] has to be set.
By saving as explained on this page, a trimmed image (p.38,
p.100) or dust-erased image (p.69 to p.73, p.103 to p.107)
actually becomes a trimmed image or dust-erased image.
For a list of [Batch settings] window functions, refer to p.125.
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Batch Transfer Images to Image Editing Software

You can transfer multiple images to image editing software. Unlike
[Transferring a RAW Image to Photoshop] (p.73), you transfer images
that have first been converted and saved as a seperate image, so the
transferred image will not disappear after exiting the destination
software. The software used here as an example is Adobe Photoshop
CS.

In the main window, select multiple images to be
transferred.

Click the [Batch process] button on the toolbar (p.112).

The [Batch settings] window appears.

Perform settings required for transferring (e.g. file
format).

Click the [Browse] button.

MG_0001.CR2 Save folder

IMG_0002.CR2

IMG_0003.CR2 E:\Users\CANON Pictures [ browse.. |
MG_0004.CR2

MG_0005.CR2 i Format

IMG_0006.CR2

MG_0007.CR2 fand of file Exif-JPEG -
MG_0008.CR2

IMG_0009.CR2 . "

! 10
MG_0010.CR2 Image quality 0
MG_0011.CR2
IMG_0012.CR2 Output setting
IMG_0013.CR2 s
MG_0014.CR2 Output resalution 350 dpi  [V]Embed ICC profile
IMG_0015.CR2

Resize setting
| Resize
Lock aspec
File nams
_) Current it file name
@ New file name
String Sequence number
DPP_ 0001
[ save sequence number
Ex.: DPP_0001.JPG, DPP_0002.JPG. ..
Image transfer settings
Open image using software
Browse...
Execute Cancel

The [Open] dialog box appears.

Select Photoshop CS.
In the [Open] dialog box, select a Photoshop CS file or a shortcut
and click the [Open] button.
The [Open] dialog box closes and [Image transfer settings] in the
[Batch settings] window is set to Photoshop CS.

Checkmark [Open image using software].

Image transfer settings

Dpen image using software

E:\Program Files\Adobe\Adobe Photoshop CS5\Photoshop Browse. ..

[ Execute ] I Cancel I

Click the [Execute] button.
The processing dialog box appears and batch transfer begins.
When the first image has been transferred, Photoshop CS starts
up and transferred images are displayed in transferred order.

© If the message [Insufficient memory.] appears, too many images are
selected at the same time. Decrease the number of selected
images.
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Batch Change the File Name of Images .
Introduction
In the main window, select multiple images of which . . . . .
the file names are to be changed. Changing the File Name of Images in the Order in the Main Window
When you change the order of the images in the main window, you can Contents at
Select the [Tools] menu » [Start Rename tool]. change in one operation the names of the files for the images, in the a Glance
The rename window appears. order they were rearranged.
ify the r ir in .126) and click th . . s -
Specify the required settings (p.126) and click the Change the order of the images in the main window Basic
[Execute] button. (0.21) Operation
a wmwwmmmgi I o
e Em— E— N In thfe main window, select multiple images of which L N
Basic Settings Format settings the flle names are to be Changed- operation
e s Select the [Tools] menu » [Start Rename tool].
Shooting Date/Time Shh”:‘:;my - Advanced
Same file name for RAW +IPEG images - - - Ima e Editin
I Copy and Rename _— d Select [Flt to main WIndow]. an(? Printingg

[¥] Insert underbar

-

E:\Users\CANONPictures % . .
@ E:\Users\CANON\Pictures\Photoloso: ot Z
— : ' Procefsing
OmfG,c‘l;clquz L MDS:,;GZQ:LUUULCM File name Larg bers
MG_0001.JPG DPP_D6-08-13_0001.1PG DFP » Shooting Date/Time of Im es
IMG_0002.CR2 DPP_06-09-13_0002.CR2
IMG_0002.JPG DPP_06-09-13_0002.JPG A i
IMG_0003.CR2 DPP_06-09-13_0003.CR2 Basic Settings
00082 "~ [ Sort Editing
MG_0004. PG DPP_05-09-12_0004.IPG g S Window J PEG/TIFF
- Images
File name
[ [ Ereate ] Cancel | w ") Shooting Date/Time
: : . Specify the required settings (p.126). Reference
Processing begins and the file names are changed. P y i q gs (p )
To copy an image, checkmark [Copy Rename].
? i is dupli .
¢ Changes cannot be made when the file name is duplicated Click the [Execute] button.
If a file name in red text has appeared in [Modified File Name], the file name The file names are changed and the order in the main window is Index
has been duplicated. Changes cannot be made if even one file name has maintained.

been duplicated. Change the settings so that duplication does not occur.

® The name of the movie files cannot be changed in DPP.

|§| You cannot start up the rename tool from the [Collection] window
(p.36, p.113).
For a list of the rename window functions, refer to p.126.

© If the message [Insufficient memory.] appears, too many images are

selected at the same time. Decrease the number of selected
images.
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5 Editing JPEG and TIFF Images

Trimming and Adjusting the Angle of an Image..... 100

Introduction
a DPP is software mainly aimed for advanced RAW image editing, but it —
also has JPEG and TIFF image editing functions. Here, the editing and
saving of JPEG and TIFF images are explained. C:rcl;tfan;(s:eat
Editing JPEG and TIFF Images..........cccccceveiin. 92 B
About the RGB Tool Palette .........cccoooevveveieeiiiinnnnnn.n. 92 Operation
Automatically Adjusting Brightness and Color (Tone —
Curve AsSISt) ........coocciiiiii i 93 Advanced
Adjusting Brightness and Contrast ............c.c.cc.c........ 94 SEsTatloy
Adjusting Color Tone Using Click White Balance........ 95
L . Ad d
Adjusting Hue, Saturation and Sharpness.................. 96 ,mag‘éaggﬁing
Tone Curve Adjustment...........ocoeeeeeeeeeeieeeeeeeeeee. 97 |gEudisiating
Adjusting Dynamic Range ..............cccceevvciivrveeeenenn... 98 Processing
: : Large Numb
Reducing NOISE ........ccoiiiiiiiiiiiiiiiiiieieeee 99 ggfelmg’;ese’s

Performing Automatic Dust Erasure Processing ... 103 J%Eﬁ’:,:
Compatible Cameras...............cceceuveeeeeeeeeecnnnne.. 103 Im#Ges
Automatic Dust Erasure Processing in the Main
WINAOW ..., 104 Reference

Manually Erasing Dust (Repair Function).............. 105
Erasing Unwanted Parts of an Image (Copy Stamp
FUNCHON). ..., 107 Index

Saving Editing ReSUILS...........ccooveveeeeeeeceeeeeeee 107
Saving Editing Content to an Image......................... 107
Saving as a Separate Image .........cccccvvvveeeeeeeiiie, 108 @ @

Applying Editing Contents to Another Image......... 108 @

Printing ...cooeee e 108

Re-Editing an Image........cccccooeeiviiiiiiii i, 108
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Editing JPEG and TIFF Images

With DPP, you can adjust JPEG and TIFF images in the same way as
RAW images using the [RGB] and [NR/Lens/ALQ] tool palettes.
Because adjustment made with the tool palette (recipe) only changes
the image processing conditions, the “original image data itself” remains
unaffected. Therefore, there are no problems with image deterioration
that arise with editing and you can readjust your images any number of
times.

Tone curve assist

Tone curve adjustment

[Res J(r](c][5]

255

| i | I |
LT LR P
Ll ! .1 R
i, P I \N
:
0 255 .vrd ]
Brightness: { 0 ——

Contrast: {} 0 I

Contents adjusted using the tool
palette can be handled

Hue: D @ 0
Sl 0 o0 individually as a recipe file
s 0 e || (extension “.vrd”) (p.85, p.108).

In DPP all the adjustments (image processing conditions information)
made with the tool palette can be saved in the image as data called a
“recipe” (p.107), or can be saved, downloaded and applied to other
images as a separate recipe file (extension “.vrd”) (p.85, p.108).

About the RGB Tool Palette

With the functions in the [RGB] tool palette, you can adjust JPEG and
TIFF images with the same functions as ordinary image editing
software.

However, because the adjustment width of the adjustment functions in
the [RGB] tool palette is wider than the [RAW] tool palette, the image
color may be saturated, or the image quality may deteriorate if you
adjust too much. Therefore, take care not to adjust your images to an
excessive degree.

You can adjust RAW images with the functions in the [RGB] tool palette.

However, for functions other than tone curve adjustment (p.97) and
automatic adjustment (p.93), we recommend adjusting RAW images
using the same functions available in the [RAW] tool palette.
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Automatically Adjusting Brightness and Color (Tone Curve Assist)

In order to make the image a desirable standard image, automatically
adjust the image tone curve (p.127). You can select the degree of
automatic adjustment from “Standard” and “High”.

Click the desired automatic adjustment button.
Standard: Standard automatic adjustment. Suitable for most
images.
High: Use when the effect achieved in standard automatic
adjustment is not strong enough.

B 3 D)
|Tnne curve adjustment =

[](c](e]
255 High

[raw | re8  [nRpLens/ao]

Reverts the tone curve
to the original settings

‘Tnne curve assist

N

Standard

0

Brightness: 1 ]
Contrast: U a
Hue: U a
Saturation: D 100
Sharpness: [ @ i]

The tone curve changes as adjusted.

=Q< Images not suitable for automatic adjustment (tone curve
assist)

The result of automatic adjustment (tone curve assist) may not be as
expected with the following images:

» Images which have been shot with the proper exposure

* Images where the brightness is unbalanced

* Images which are too dark

» Images which have extreme backlighting

@ If you click the [[[Z%]] button, the tone curve as well as the [Hue]

and [Saturation] revert to the default settings. Take care when
adjusting the [Hue] and [Saturation] individually (p.96).
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Adjusting Brightness and Contrast

The brightness and contrast of an image can be adjusted.

Brightness: Move the slider to the right to make an image
brighter and to the left to make an image darker.

Contrast: Used to adjust modulation and degree of contrast

RAW | RGB  |NR/Lens/aLO|

| Tone curve assist | |
‘Tone curve adjustment |
(] |

Brightness:

Contrast:

Hue:

Saturation:

Sharpness:

(5] 100
(B] o

of color. Move the slider to the right to make
contrast of an image stronger and to the left to
make contrast weaker.

Drag the sliders left or
right
Enter numerical values

@ The adjustment range is —100 to +100 (in 1-stop increments when
entering a value).
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Adjusting Color Tone Using Click White Balance

You can adjust white balance using a selected part of an image as the
standard for white to make the image appear natural. Using click white
balance is effective when using it in parts of an image where white color
tone has changed under the influence of a light source.

Click the [[.~]] button.

RAW | RGB  |NR/Lens/ALO |

|T0r1e curve assist

() 1z 28]

|Tor1e curve adjustment -] ”

e JmE)

Brightness: [ ]
Confrast: i [ i}
Hue: [ @ i}
Saturation: @ 100
Sharpness: [ @ ]

?

Click on a point that is to be the standard for white.

1632 B44): 220224235 RAw [ AdobeRGE CMYK High quality

The coordinates of the cursor position and
the RGB values (8-bit conversion)

The color of the image is adjusted with the point you selected as
the standard for white.

If you click on another point in the image, the white balance is
adjusted again.

To finish click white balance, right-click with the mouse or click

the [[ .~ ]] button again.

When there are no white areas in your image

When there are no white areas in your image, you can adjust the white
balance by clicking on a grey point of the image in step 2. This has the
same adjustment result as selecting a white point.

5

The image is adjusted based on the average value of 5 x 5 pixel
range from the clicked point.

The histogram display changes according to adjustment. You can
also fix the histogram display to the display before any
adjustments (p.81).

J
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RAW | RGE  |NR/ens/aLO |

|T|:une curve assist

() 1z 28]

|T0ne curve adjustment

3]

ks J[R][c][e] (2]

255

Brightness:

Confrast:

Hue:

Saturation:

Sharpness:

Bo

(5] 100

Bjo

Adjusting Hue, Saturation and Sharpness

You can adjust hue (tone) and saturation and make the overall
atmosphere of an image harder or softer.

Enter numerical values

Drag the sliders left or right

Hue: Move the slider to the right to make color tones
more yellow, and to the left to make color tones
redder.

Saturation: Move the slider to the right to make the color
deeper, and to the left to make the color weaker.

Sharpness: Move the slider to the right to make an image
harder, and to the left to make an image softer.

? Sharpness is unnatural

Adjust sharpness with the window view set to [100% view], [50% view]
or [200% view]. If the view is set to [Fit to window] (full view), the
sharpness will seem unnatural.

|§| The adjustment range is —30 to 30 for hue, 0 to 200 for saturation,
and 0 to 500 for sharpness (in 1-stop increments when entering a
value).
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. Introduction
Tone Curve Adjustment Make adjustments. S
You can adjust the brightness, contrast and color of a specific area by RAW | RGB  |NR/Lens/ALO|
changing the tone curve (p.127). [ Tone urve assist (D[ 25)] Contents at
- a Glance
|Tone curve adjustment |
Select the tone curve mode and interpolation et J(r](c][B] |
. Batch adjusts RGB Opsration
RAW | RGE  |NR/Lens/ALO | —
‘Tnne curve assist |
|T0ne curve adjustment | deantc_:ed
peration
o] (2) (] (5] ; . Click to add a [[] (point) -
= ' Adjust by dragging [[]
Advanced
Image Editing
and Printing
—
@ Curve A
. . . Processing
Straight R'ght'd_'Ck_W'th the g Large Numbers
mouse inside the graph of Images
© RGBRGB to display the menu Brightness: { 0
Luminance RG B
Contrast: I I 0 E (¢]
: JP:ElFF
Hue: I @ 0 I e
w Saturation: |:| @ 100
il 0 0 Sharpness: [ @ i} Reference
Contrast: : {l 0 The horizontal axis shows the input level and the vertical axis
' " shows the output level.
e : The maximum number of [[]] is 8. Index
el N cN; U A To delete a [[]], either press the <Del> key or double-click on the [[(J]. “—r’
Sharpness: [ i]

|§| The histogram display changes according to adjustment. You can
also fix the histogram display to the display before any @
adjustments (p.81).
The tone curve mode and interpolation method for a tone curve

can also be changed in [Preferences] (p.81). 9
7



Introduction
Adjusting Dynamic Range @ The setting range of shadow points is 0 to 247 (in 1-stop -
D . idth of aradati ion) f dark points to bright increments when entering a value).
yhamic range (width of gra ation expression) from dark points to brig The setting range of highlight points is 8 to 255 (in 1-stop Contents at
points in an image can be adjusted. . ;
increments when entering a value). a Glance
The histogram display changes according to adjustment. You can T ——
Move downwards also fix the histogram display to the display before any
Output highlight points adjustments (p.81). Basic
Operation
RAW | RGB  |NRALens/ALD |
|Tone curve assist @|
‘Tone curve adjustment -— Reverts the Advant_:ed
s 1ol 2| image to the Operation
Output 259 original
hlghllght point settings Advanced
numerical Image Editing
value and Printing
p .
Move to the Move to the Lar;;%crﬁarsr:ggfs
right left of Images
Input shadow Input highlight
points points E g
JP%IFF
| es
Output shadow .
pointnumerical a55-1- Input highlight
value i 6 pointnumerical Reference
value .
Contrast: 1]
Input shadow
point numerical ®) 0 Index
value €
Saturation: @ 100
Sharpness: [} @ ]

Move upwards
Output shadow points

The horizontal axis shows the input level and the vertical axis shows

the output level.
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Reducing Noise

You can reduce noise that arises in JPEG and TIFF images that have
been shot at night or with a high ISO speed.

Introduction

Click the [Apply] button.

Select the [NR/Lens/ALO] tab sheet from the tool
palette in the edit window or edit image window.

Click the [NR Preview] button.

|
| Moise reduction App |

[ [ MR, Preview... I

AW

The [NR Preview] window appears.

Adjust an image.

NR Preview

Navigator
window

— Enlargement

display
TIFF/JPEG pOSition
Luminance noise on:(7)
° Gj = Drag the
Chrominance no ise geduction: (8) .
0 é” i sliders

NR check window

You can set a noise reduction level from within a range of 0 to 20.

The larger the setting, the larger the noise reduction effect.

The noise reduction effect can be checked when an image is
displayed at 100% in the NR check window.

You can change the display position of the NR check window by
dragging the enlargement display position in the navigator
window.

Noise reduction is applied to the image and the image is
redisplayed.

To set the same noise reduction level for several images

After selecting multiple images in the main window, you can set the
same noise reduction level for the images without displaying the [NR
Preview] window, by adjusting the noise reduction level in the [NR/Lens/
ALQ] tool palette (p.117) using the [Luminance noise reduction] and
[Chrominance noise reduction] sliders, and then clicking the [Apply]
button.

5

If [Luminance noise reduction] has been set, resolution may be
reduced along with reduction of noise.

If [Chrominance noise reduction] has been set, color bleeding
may occur along with reduction of noise.

You can set the batch processing settings for noise reduction
beforehand, using [Default noise reduction settings] in the [Tool
palette] tab sheet in the [Preferences] (p.81). This is particularly
useful for applying noise reduction to all the images in a folder at
once, such as batch noise reduction for images with high ISO
speeds. However, where images have a recipe attached, the
noise level recorded in the recipe is applied.

For a list of [NR Preview] window functions, refer to p.118.
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Trimming and Adjusting the Angle of an Image

You can trim only the part of an image you need, or change the
composition of an image where an image shot horizontally becomes
vertical. You can also adjust the angle of an image before trimming.

Select the image to be trimmed.

Open the trimming/angle adjustment window.
Click the [Trimming Angle] button.

|
y ® O @ 2

Rotate right Quick Stamp  Trimming Batch
check Angls process

Rating # » » & =»

The trimming/angle adjustment window appears.
Editing can be done once the image is displayed clearly in the
trimming/angle adjustment window.

Adjust the angle of the image as needed.
Trimming/angle adjustment window

(@ 1/ 1 E\Users\CANON\Pictures\Photoboooc o odIMG_0001JPG

\\\\\\\\\

— Largest
possible
trimming
range

AAAAAA

eeeeee

RRRRRRR +— Click (rotate

image left
or right in
90-degree
increments)

ccccc

\
Drag* (0.01-degree increments;
adjustment range: -45 to +45 degrees)

Use the mouse (click A/V) to adjust the angle or
directly enter the adjustment angle* (0.01-degree
increments; adjustable range: -45 to +45 degrees)

* You cannot adjust the angle of images that exceed 9999 x 6666
pixels in size.
If you click [Center on Screen], you can display the trimming
range in the center of the window.
If you click the [OK] button after adjusting only the angle of the
image, the image will be trimmed at the largest possible trimming
range.

@ When aspect ratio information is attached to an image shot with the
EOS-1D Mark IV, EOS-1Ds Mark Ill, EOS-1D Mark Ill, EOS 7D,
EOS 60D or EOS 600D, the trimming range based on the aspect
ratio information is displayed.
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Select a ratio and drag the trimming range.

(@ 1/ 1 EAUsers\CANON\Pictures\Photovo e 0L.CR2 [

eeeeeeeeee —— Cancel
y— Select a
trimming
ratio

nnnnn

~— == Drag the
trimming
range

(704, 362) > (2281, 1413) = (1577 x1051) [1.50]

The trimming range can be moved by dragging.

You can enlarge or reduce the size of the trimming range by
dragging the four corners of the trimming range.

List of aspect ratios (width : height)

1:1
32
23

4.5

A Size Landscape
A Size Portrait
Letter Landscape
Letter Portrait
Custom

[Free]:  You can trim an image to any size, regardless of the
selectable ratio.

[Custom]: You can trim an image at the specified ratio.

Click the [OK] button to return to the main window.
The trimming range frame is displayed in the trimmed image
(p.114).

When the trimmed image is displayed in an edit window or the
edit image window, it is displayed in its timmed form.
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"2 About trimmed images

The trimmed range can be reverted to its original condition at
any time

A trimmed image is displayed or printed as a trimmed image.
However, since the image is not actually trimmed, you can always
revert to the original image by clicking the [Reset] button in the
trimming/angle adjustment window or performing the “Re-Editing an
Image” procedure (p.108).

Display of the trimmed image in each window

* Main window: The frame showing the trimming range is
displayed on the image (p.114).

 Edit window:

» Edit image window: The thumbnail image is the same as the main
window display, and the enlarged image is the
same as the edit window display.

Printing a trimmed image
You can print as a trimmed image by printing it in DPP.

The image becomes a trimmed image when saved as a separate
image

The trimmed JPEG or TIFF image actually becomes a trimmed image
when saved as a separate image (p.108).

Images that have aspect ratio set will be displayed as trimmed
images

When aspect ratio information is attached to a RAW image shot with
EOS-1D Mark IV, EOS-1Ds Mark Ill, EOS-1D Mark Ill, EOS 7D, EOS
60D or EOS 600D the set trimming range based on the aspect ratio
information is displayed. Since the image is not actually trimmed, you
can change the trimming range or revert to the condition before
trimming.

However, when a JPEG image is shot in a [4:3], [16:9] or [1:1] aspect
ratio set with the EOS 60D or EOS 600D, its trimming range cannot
be changed nor reverted to the condition before trimming, since the
image is actually trimmed and saved in the set trimming ratio.

When reverting to the condition before trimming is performed based
on the aspect ratio information at the time of shooting, click the
[Reset] button. Also, if you want to cancel all the trimming range, click
the [Clear] button (p.122).

The image is displayed in its trimmed condition.

Ny

> Convenient functions of the trimming/angle adjustment
window

Switch between screens using the keyboard
You can also switch between full screen display/normal screen
display by pressing the <Alt> + <Enter> keys or the <F11> key.

Operate using the menu

Each operation can also be performed with the menu which appears
when you right-click with the mouse on the image.

Apply the trimmed range to another image

You can apply the trimmed range to another image by clicking the
[Copy] button to copy the trimmed range, displaying another image
and then clicking the [Paste] button.

To batch apply a copied trimming range to multiple images, select the
trimmed image and the multiple images to which you want to apply
the trimmed range in the main window, and display the trimming/angle
adjustment window. With the trimmed image displayed, click the
[Copy] button and then click the [Apply All] button. This will apply the
trimming range to all the images selected when the trimming/angle
adjustment window is displayed.

© For images shot with ISO speed range expansion set, noticeable

noise may make it difficult to view image details in the trimming/
angle adjustment window, so using this function is not
recommended.

@ For a list of the trimming/angle adjustment window functions, refer

to p.122.
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Performing Automatic Dust Erasure Processing

When the image has redrawn itself, click the [Apply
Dust Delete Data] button.

(@ 2/ 3 EUsers\CANONPictures Photoooo: o xIMG 00506 [5164 x 34361

The Dust Delete Data that is appended to images shot with the camera
that can attach this data, can be used to automatically erase dust spots.

Compatible Cameras

EOS-1D Mark IV EOS-1Ds Mark 11l EOS-1D Mark 11l
EOS 5D Mark I EOS 7D EOS 60D

EOS 50D EOS 40D EOS 600D

EOS 550D EOS 500D EOS 450D

EOS 400D DIGITAL EOS 1100D EOS 1000D

In the main window, select an image appended with
Dust Delete Data.

Click the [Stamp] button.

I
vy ®

S & 2

Rotate right Quick Stamp  Trimming Batch
check Angls process

Rating # » » & =»

The copy stamp window appears.

Set to 100% viewto perform stamp operation

Dust spots are erased in a single operation.

Click the [OK] button to return to the main window.
The [8,] mark (p.114) is displayed on an image from which dust
spots have been erased.

@ Dust Delete Data is not attached to images having settings specified
during RAW processing on the camera for distortion correction,
chromatic aberration correction, etc. As a result, you cannot perform
automatic dust erasure processing on such images.
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? Additional Information

The dust-erased image can be reverted to its original condition
at any time

A dust-erased image is displayed or printed as a dust-erased image.
However, since the dust on the image is not actually erased, you can
always revert to the original image by clicking the [Undo] button in the
copy stamp window or performing the “Re-Editing an Image”
procedure (p.108).

Check dust erasure in the copy stamp window

Check dust erasure in the copy stamp window. Images before dust
erasure are displayed in other windows and you will be unable to
check them.

Printing dust-erased images
You can print as a dust-erased image by printing it in DPP.

The [Apply Dust Delete Data] button cannot be clicked

Even with an image that has Dust Delete Data attached to it in the
camera, if there is no dust to remove by DPP from the image, the
[Apply Dust Delete Data] button will be disabled.

To erase dust spots that cannot be erased with the automatic
dust erasure processing

In automatic dust erasure processing, dust spots are erased based on
information relating to dust saved in the Dust Delete Data. However,
there may be cases where you will not be able to erase dust spots
depending on the type of dust. If this occurs, erase those dust spots
using the repair function (p.105) or the copy stamp function (p.107).

The image becomes a dust-erased image when saved as a
separate image

The dust-erased JPEG or TIFF image actually becomes a dust-
erased image when saved as a separate image (p.108).

Ny
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> Useful functions of the copy stamp window

Checking the dust erased spots

After step 3, you can display and check in detail the erased dust spots
one by one by pressing the <Shift> + <F> keys. (Press the <Shift> +
<B> keys to return to the previous dust spot.)

Canceling a specified erased dust spot only

After step 3, you can press the <Shift> + <F> keys or the <Shift> +
<B> keys to display the erased dust spot, and then press the <Shift>
+ <Del> keys to cancel only the erased dust spot displayed.

Switch between full screen display/normal screen display using
shortcut keys

You can also switch between full screen display/normal screen
display by pressing the <Alt> + <Enter> keys.

Applying the dust erasure result to another image

You can apply dust erasure to the same place in another image by
clicking the [Copy] button to copy the dust erasure results and then
displaying the other image to which you want to apply the results and
clicking the [Paste] button.

@ For a list of the copy stamp window functions, refer to p.124.

Automatic Dust Erasure Processing in the Main Window

In the main window, you can also automatically erase dust spots in
multiple images appended with Dust Delete Data.

Select multiple images appended with Dust Delete
Data, and then select the [Adjustment] menu »
[Apply Dust Delete Data].

Dust spots in all the selected images are erased in a single
operation.
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Manually Erasing Dust (Repair Function)

You can erase dust spots in an image by selecting them one by one.

In the main window, select the image you want to
erase dust spots.

Click the [Stamp] button.

|
vV & @ @ @

Rotate right Quick Stamp Trimming Batch
check process

Rating

The copy stamp window appears.

When the image has redrawn itself, double-click the
point from where dust is to be erased.

(@ 2/ 3 E\Users\CANONPitures\PhotoVooor e sIMG 0050.PG 3184 x 3456)

Double-
click

The display changes to 100% view.
The display position can be changed by dragging.

Click the button that matches the dust spots to be
erased.
If the dust spot is dark in color, click the [[@»(]] button, and if the

dust spot is light in color, click the [+ ]] button.
When you move the cursor over the image, the dust erasure
range appears as [O].

Place the dust spot to be erased within the [O] and

click.

Brush Pendl

aaaaaa

() —— Click

Circle the dark spot to repair

The dust spot within the [Q] is erased.

Click on another part of the image to continue erasing dust spots
in the image.

To erase dust in another part of the image, either right-click with
the mouse, or click the button clicked in step 4 again to cancel dust
erasure processing and perform the operation again from step 3.
When the dust spot cannot be erased, [§)] is displayed.

Click the [OK] button to return to the main window.
The [8,] mark (p.114) is displayed on an image from which dust
spots have been erased.
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? Additional information

Click several times when dust spots are not erased completely
Where unwanted dust spots are not erased even after performing
step 5 once, they may be erased completely when you click several
times.

Mainly spots of dust can be erased with the repair function
Spots of dust can be erased with the repair function. You may be
unable to erase lines of dust. In this case, use the copy stamp
function (p.107).

The dust-erased image can be reverted to its original condition
at any time

A dust-erased image is displayed or printed as a dust-erased image.
However, since the dust on the image is not actually erased, you can
always revert to the original image by clicking the [Undo] button in the
copy stamp window or performing the “Re-Editing an Image”
procedure (p.108).

Check dust erasure in the copy stamp window

Check dust erasure in the copy stamp window. Images before dust
erasure are displayed in other windows and you will be unable to
check them.

Printing dust-erased images

You can print as a dust-erased image by printing it in DPP.

The image becomes a dust-erased image when saved as a
separate image

The dust-erased JPEG or TIFF image actually becomes a dust-
erased image when saved as a separate image (p.108).

Ny
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> Useful functions of the copy stamp window

Checking the dust erased spots

After step 5, you can display and check in detail the erased dust spots
one by one by pressing the <Shift> + <F> keys. (Press the <Shift> +
<B> keys to return to the previous dust spot.)

Canceling a specified erased dust spot only

After step 5, you can press the <Shift> + <F> keys or the <Shift> +
<B> keys to display the erased dust spot, and then press the <Shift>
+ <Del> keys to cancel only the erased dust spot displayed.

Switch between full screen display/normal screen display using
shortcut keys

You can also switch between full screen display/normal screen
display by pressing the <Alt> + <Enter> keys.

Applying the dust erasure result to another image

You can apply dust erasure to the same place in another image by
clicking the [Copy] button to copy the dust erasure results and then
displaying the other image to which you want to apply the results and
clicking the [Paste] button.

To apply dust erasure to the same place in several other images, you
can efficiently erase dust spots by clicking the images while holding
down the <Ctrl> key in the main window, or, by selecting multiple
images by clicking the first image and then clicking the last image
while holding down the <Shift> key, and then displaying the copy
stamp window.

@ For images shot with ISO speed range expansion set, noticeable

noise may make it difficult to view dust spots in the copy stamp
window, so using this function is not recommended.

@ For a list of the copy stamp window functions, refer to p.124.
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Saving Editing Results .
Introduction
Erasing Unwanted Parts of an Image (Copy Stamp Function) Saving Editing Content to an Image
You can correct an image by pasting a section copied from another part All the contents (reci . .
X ) pe) adjusted with the tool palette (p.92 to p.99) as Contents at
of the image to an unwanted part of the image. well as the trimmed range (p.100) and dust-erasure (p.103 to p.107) a Glance
. . ) information can be saved to a JPEG or TIFF image, or to a separate
Follow steps 1 to 3 in “Manually Erasing Dust (Repair JPEG or TIFF image.
Function)” (p.105). o Basic
. . . Select the [File] menu » desired item. peration
Specify the section to be copied. _
Click on the section that is to be the copy source while holding e e o
down the <A|t> key Open in Edit window (enlarged) (A)g‘é?:t‘:gg
To change the section that is to be the copy source, perform the — p—
operation above again. Sove e CirleShiftes
To fix the position of the copy source, checkmark [Fix Copy Add thumbnail to image and save | ClrkShifteT Advanced
Source pOSition]. Convert and save... Ctrl+D Iranna(?eprElgng]ngg
. Batch process... Ctrl+B
Correct the image. Croste et
Click or drag on the section you want to correct on the image. [+] Processing
. . L oL Print... Ctrl+P Large Numbers
in the window indicates the copy source and [Q] indicates the it detaled st Clenfep of Images
copy destination. Contact Sheet Prints... ” Ctrl+Shift+P
The copied image is pasted in the position to which it was Plug-in printing 5 E g
dragged' Add te collection Ctrl+G JP§IFF
For [Pen type], yOU can SeIeCt from [BrUSh] (the paSted image,s Remove from collection Ctrl+Shift+G I s
borders simulate a brush) and [Pencil] (the pasted image’s Clear collection
borders are sharp). Delete Del Reference
Click the [OK] button to return to the main window. fnfe crt
The [ %] mark (p.114) is displayed on a corrected image. Exit Alt-F4
Your adjustments are saved to the image. Index

00
©

107



Saving as a Separate Image

If a JPEG or TIFF image is adjusted with the tool palette (p.92 to p.99)
and then saved in the same way as a RAW image as described below,
the image can be saved as a separate image with the adjustments
(recipe) applied to it.
Furthermore, if a trimmed image (p.100) or dust-erased image (p.103 to
p.107) is also saved in the same way, it actually becomes a trimmed or
dust-erased image.

Saving as a JPEG or TIFF Image (p.42)

Batch save as JPEG or TIFF images (batch processing) (p.88)
By saving as a separate JPEG or TIFF image as explained above, the
adjustments made with the tool palette are applied, and some image
deterioration that accompanies editing/saving occurs as when editing
with ordinary image editing software.

Applying Editing Contents to Another Image

You can copy the adjustment contents (recipe) of JPEG and TIFF
images that have been adjusted with the tool palette and apply them to
another image with the procedures below, in the same way as with RAW
images.

Applying adjustment contents to another image (p.41)

Utilizing adjustment contents (recipe) (p.85)

Printing
Edited JPEG and TIFF images can be printed with the procedures
below as with RAW images.

Printing (p.43)

Printing with shooting information (p.74)

Printing a thumbnail list (contact sheet printing) (p.75)

Printing RAW images on a high-end Canon printer (p.76)

Re-Editing an Image

Only the image processing conditions are changed in images adjusted
with the tool palette (p.92 to p.99), so the “original image data itself”
remains unaffected. Also, the trimming range or dust-erasure
information of a trimmed image (p.100) or dust-erased image (p.103 to
p.107) is simply saved to the image.

For this reason, you can undo any adjustments saved (p.107) to the
image, trimming range and dust-erasure information, and revert to the
condition when last saved, or when the image was shot.

Select the image that is to be re-edited.

Select the [Adjustment] menu » desired item.

Rotate Left Ctrl+L
Rotate Right Ctrl+R

Apply Dust Delete Data
Work color space 3

Tone Curve Assist - Standard

Tone Curve Assist - High

Ctrl+Alt+Z
Ctrl+Shift+Z

Revert to last saved settings

Revert to shot settings

The image reverts to the conditions of the selected item.
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Reference

This reference section has been provided to enhance your experience
using DPP.

It contains various troubleshooting solutions, how to delete DPP from
your computer, explanations of the various windows and a glossary.
An Index is provided at the end of the chapter for you to easily find
information you are looking for.

Troubleshooting.........ccueiiiiiiiii 110
Deleting the Software (Uninstalling) ...................... 111
List of Main Window (Folder Window) Functions .. 112
List of Main Window (Collection Window) Functions... 113
Image Frame Information in the Main Window and Edit

Image Window...........cooeiiiiiiiiiic e 114
List of Edit Window Functions ...............cccceeeennnn... 115
List of Tool Palette Functions ............ccccveeeeennnnn... 116
List of NR Preview Window Functions................... 118
List of Quick Check Window Functions ................. 119
List of Edit Image Window Functions .................... 120

List of Convert/Save One Image Window Functions 121
List of Trimming/Angle Adjustment Window Functions... 122
List of Lens Aberration Correction Window Functions 123

List of Copy Stamp Window Functions.................. 124
List of Convert/Save Multiple Images Window (Batch
Processing) Functions............ccccooviiiiiiiiiiiiiciiiiiinnns 125
List of Rename Window Functions........................ 126
GlOSSANY oo 127
INAEX . i 129
About This Instruction Manual.............................. 133
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Troubleshooting

If DPP is not operating correctly, refer to the items below.

Introduction

Installation could not be completed correctly

Select an administrator-level privilege ([Computer administrator],
[Administrator], etc.) as a user setting. You cannot install the software
if a user setting other than an administrator-level privilege is selected.
For detailed information on selecting an administrator-level privilege,
refer to your computer User’s Manual.

DPP does not work

DPP does not operate correctly on a computer if its system
requirements are not met. Use DPP on a computer with compatible
system requirements (p.3).

Even if your computer has the RAM capacity (memory) described in
the system requirements (p.3), if other applications are running at the
same time as DPP, you may not have sufficient RAM (memory). Exit
any applications other than DPP.

The card reader does not detect the SD card.

Depending on the card reader and computer OS used, SDXC cards
might not be correctly detected. In such a case, connect your camera
and computer with the provided interface cable, and transfer the
images to your computer using EOS Utility (provided software).

Images do not display properly

Images that are not supported by DPP do not display. There are
various types of JPEG and TIFF images, so JPEG images other than
Exif 2.2, 2.21 or 2.3 compatible images and TIFF images other than
Exif compatible images may not display properly (p.3).

When a dust-erased image (p.69 to p.73, p.103 to p.107) is displayed
in a window other than the copy stamp window, it is displayed as it
was before dust erasure was performed. Check dust-erased images
in the copy stamp window.

An image could not be adjusted

The JPEG and TIFF images cannot be adjusted using the image
adjustment function of the [RAW] tool palette. Adjust these images
with the [RGB] tool palette (p.116).

PowerShot Pro1 RAW images cannot be adjusted with the image
adjustment function of the [RAW] tool palette. Adjust these images
with the [RGB] tool palette (p.116).

A recipe could not be pasted (applied) to another image

You cannot paste (apply) rotation (p.10, p.25, p.112, p.119, p.120),
trimming (p.38, p.100), dust erasure (copy stamp) (p.69 to p.73, p.103
to p.107) of an image to another image as a recipe. Trim the image or
erase dust of the image using the copy/paste function in each window
and rotate each image individually.

The adjustment contents (recipe) of RAW images that has been
adjusted with the [RAW] tool palette cannot be applied to JPEG or
TIFF images (p.116).

The Auto Lighting Optimizer (p.61) is a function that is only available
for RAW images shot with EOS-1D Mark 1V, EOS 5D Mark I,

EOS 7D, EOS 60D, EOS 50D, EOS 600D, EOS 550D, EOS 500D
and EOS 1100D. You cannot apply the Auto Lighting Optimizer’s
adjustment contents to RAW images shot with other cameras.

Color appears weak in the image when viewed with
other software

A RAW image which has a color space other than sRGB set (p.73,
p.82) and is then converted and saved as a JPEG or TIFF image will
appear weak in color when viewed in software that is only compatible
with sRGB color space. In this case, set the RAW image color space
to sRGB, convert again to a JPEG or TIFF image and save, and then
view this image.
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The colors of the image displayed on screen and
the colors of the printed image do not match

If the color of the monitor that displays an image is not adjusted
correctly, or if a profile for a printer that is to print images, has not
been set up, the color of the image displayed on screen and the color
of the printed photograph may differ greatly. If the color of the monitor
that displays images is corrected (p.82) and a profile for a printer is
set up correctly (p.82), the color of a printed photograph and the color
of an image on screen can be more closely matched. Using a Canon
printer (p.43, p.46) or linked printing (p.76, p.77) automatically sets up
printer profiles, so you only need to set the color of the monitor to
bring the colors closer together.

When printing using Easy-PhotoPrint and the Easy-PhotoPrint
automatic compensation function and the various types of image
adjustment functions are operating, colors are not printed correctly.
Cancel all Easy-PhotoPrint image adjustment functions (p.47).

Even if you set a printer profile, if you use the color adjustment
function of the printer driver, the image may print in colors different
from those displayed on screen. Do not use the color adjustment
function of the printer driver.

Printing a large number of images in batches cannot be performed

If a large number of images are printed in batches, printing may stop
in the middle or the images may not be printed. Reduce the number of
images to print or increase the memory on your computer.

A file remains in the folder after images are deleted

Delete [CRW_YYYY.THM] (camera index display image) if it remains
in the folder from which images have been deleted (p.49).
* Numbers are entered for [YYYY] in the file name.

The image information does not display

A JPEG image set to Adobe RGB and shot with EOS 10D, EOS 300D
DIGITAL and PowerShot Pro1 may not display image information
(p.10, p.23).

Deleting the Software (Uninstalling)

Exit any applications before uninstalling the software.

Log in under an administrator-level privilege when uninstalling the
software.

To prevent computer malfunctions, always restart your computer after
you have uninstalled the software. Re-installing the software without
first restarting your computer is particularly likely to result in computer
malfunctions.

Select the [ @) ] button ([Start] button in Windows XP)
» [All Programs] » [Canon Utilities] » [Digital Photo
Professional] » [Digital Photo Professional
Uninstall].

Proceed with the uninstallation as directed by the

on-screen messages.
The software is uninstalled.
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List of Main Window (Folder Window) Functions (.10

Shows/hides the tool palette (p.116) Image information (p.23)  Cancels selection of all images Displays the trimming/
Shows/hides the folder area Selects all images ‘ Displays the quick check window (p.119) angle adjustment window
Switches to the edit image Displays the copy stamp window (p.124)  (p.122)
window (p.120)
Folder path

ifjital Photc|
Edit Vielv B

Toolbar*!

. Batch conversion/
[Collection] tab sheet*>

s saving
[Folder] tab sheet*> — roe | commo | (p.88, p.89, p.125)
- Desktop )
Bt Image rotation
&g Music (90 degree units)
E‘“‘Tnl Pictures
Check mark (p.19) T
§ Samp\e_Pi(_tures
@--E Videos
- Homegrou 1
I...'Ecmoi P a @ - -~ Rating (p.19)
%2 48 Computer i IMG_0002.CR2 @3 [MG_0003.CR2 EN  [MG_0004.CR2 |l@m  MG_ooos.cr2
Folder area fi- 6 Network
i E g b Sl
IMG_0007.CR2 IMG_0008.CR2 _ IMG_0009.CR2
i -
_ IMG_0011.CR2 . IMG_0012.CR2 __ IMG_0013.CR2 ) _ MG_0014.CR2 . _ IMG_0015.CR2
e i . .
Imgge CE|OI" ISDace sRGE [/ Adobe RGB High quality Redipe data: Yes Number ofimages: 15 Nlilmber of selected images: 1 oMYk ———————— @~ CMYK SImUIatlon
and work color — ' . '
%3 (573, p.82 . | —— Number of selected images display (p.82)
space™ (p.73, p.82) Display mode*4 Nurmber of displaved i
. umber of displayed images
Recipe attachment status (p.85) play 9
*1 To switch between show/hide, select the [View] menu » [Toolbar]. *4 The item selected in [Viewing and saving RAW images] (p.78) of the
*2 The images inside the folders selected here are displayed in a [Preferences] window is displayed.
thumbnail list on the right. *5 You can switch between the [Folder] and [Collection] windows.

*3 Displays the coordinates of the cursor position and the RGB values (8-bit
conversion) when click white balance was performed with the tool palette.
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List of Main Window (Collection Window) Functions 3¢ o
Image information Cancels selection of all images Displays the quick check window
Shows/hides the tool palette Selects all images ‘ ,
. . Displays the copy
Switches to the edit image stamp window Contents at
window a Glance
—
Toolbar =3 2 B ©® DD Batch conversion/ Oza:zit?on
[CoIIection] tab sheet*1 = i) A = = saving
[Folder] tab sheet _
Displays the Advanced
trimming/angle Operation
adjustment window -
Rating Advanced
Image Editing
and Printing
IMG_0002.CR2 IMG_0004.CR2 T IMG_0006| CR2 . —
B - ] Image rotation
(90 degree units) Processing
Large Numbers
of Images
—— Check mark
Editing
JPEG/TIFF
NG ODISCR2 Images
Reference
Image 00|0r Space and sRGB [ Adobe RGB High quality Recipe data: Yes Number of images: 7 Number of selected images: 1 CMYK CMYK Slmulatlon -
work color space*? = : ; disol
(p.73, p.82) ] . | | . isplay
p.-19, P. Display mode Number of selected images
Recipe attachment status Number of displayed images @ @
*1 The total number of images added to the [Collection] window is *2 Displays the coordinates of the cursor position and the RGB values (8- @
displayed in the () in the [Collection] tab sheet. Accordingly, when an bit conversion) when click white balance was performed with the tool
image is added that is displayed as a single image (p.22), twice the palette.
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Image Frame Information in the Main Window and Edit Image Window (.10, p.34)

Information displayed when [Large thumbnail] (p.10) is selected

File Edit View Bookmark Label Adjustment Tools

2 @

Edit image Folder Tool

Info Select all

H Yy ®m & & 2D

X

Clear all Rotate left  Rotste right Cuick Stamp Trimming Batch

window wiew Palatte chack Angle process
Folder | Collection(D) | Ched: mark “’1 Rating dedrdr »
Deskt
Check mark z--:SLisiries | ol i Copy stamp mark
(p.18, p.19) [ Documents (p.69top.73,p.103
- g Music to p.107)
|'—:|---.__=.| Pictures
Et-Jd Photo Lens aberration
e = mlﬂf_;éc_zﬂc correction mark
o . 2dMmple FICtures
ra---E Videos (p65)
4@ Homegroup Trimming range*6
Rating mark - @ CANON (p.38, p.100)
1 1 [-78 Computer
(.18.p19) 122 }
Brightness adjustment | | Aperture
value*! (p26) ‘l‘ +0.5 Fi3 F14
- P 3 E—1/400 : 1/400 ’
White balance icon™ — . MeoooncRz | 4 BAN MG 0002.CR2. =

(p.27)

*1 Does not display with [Small thumbnail].

*2 Displays in RAW+JPEG images displayed as a single image (p.22).

[RAW] is displayed in RAW images.
(In [Small thumbnail] (p.10), [R] is displayed.)

In PowerShot Pro1 RAW images, [RAW] is not displayed.
*3 Does not display with [Medium thumbnail] or [Small thumbnail].

RAW adjustment mark*! *4

RGB adjustment mark*! *°
Unsaved editing content mark
Shutter speed*3

File name

Image type*?

*4 Displays in an image edited with the [RAW] tool palette in the edit
window and the edit image window.

*5 Displays in an image edited with the [RGB] tool palette in the edit
window and the edit image window.

*6 When aspect ratio information is attached to an image shot with
EOS-1D Mark IV, EOS-1Ds Mark Ill, EOS-1D Mark IIl, EOS 7D,

EOS 60D or EOS 600D, the image is displayed as a trimmed image.
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List of Edit Window Functions .11, p.25)

Path and file name of image Tool palette*! (p.116, p.117)

Introduction

|

[ mG_ooo1.cR2 Contents at
File Edit View Label Adjustment Tools Window Help RAW [pGE | NRjLens/alo] a Glance
( | Brightness adjustment J S —
¥ 0.00
|White balance adjustment Eﬂ Basic
I 2 3 Register... Operatlon
[shot settings v [ Tune.. | D
| =) Advanced
[Smndard v] [ Browse. .. ] Operation
1 E 1 H ; H
Advanced
: Image Editing
= and Printing
- S —
-10.0 8.0 6.0 40 -20 0.0 20 <0
Contrast:(0) - 1 .
Highlight:(0) 1 Processmg
Shadow:(0) 0 Large Numbers
[tinear of Images
Color tone:(0) {1 —_—
Color saturation:{0) 0
[Unsharp mask. v] Editing
Strength:(0) [ JPEG/TIFF
Fineness:(0) [ Images
_

Threshold: (o) I
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(1155,1688) : 42, 44,28  RAW [ Adobe RGE CMYK High quality

“

Information display*2 Display mode*4

Image color space*3 and work CMYK simulation display (p.82)
color space (p.73, p.82)

*1 To switch between show/hide, select the [View] menu » [Tool palette]. *3 RAW images are displayed with [RAW].
*2 Displays the coordinates of the cursor position and the RGB values (8- *4 The item selected in [Viewing and saving RAW images] (p.78) of the
bit conversion). [Preferences] window is displayed.



List of Tool Palette Functions

RAW Tool Palette (p.25)

Brightness adjustment (p.26)

i— White balance adjustment

(p.27, p.28, p.56)

Picture Style settings (p.26, p.59)

Dynamic range adjustment (p.57)

Contrast adjustment (p.29)

IMG_0001.CR2 e
RAW {|reB | NRfens/ALO |
Brightness adjustment
0 0.00
White balance adjustment ]'

1 (23 Register...

[Shotsettings v] [ Tune... ]

|Picture Style =)

Standard - Browse...

' N !
| e
T
i Al i,
! Wi b &

-10.0 80 -6.0 40 -20 0.0 2.0 40
Contrast:(0) il
Highlight: (0) [
Shadow: (0) {1

[ Linear,

Shadow/highlight adjustment (p.57)

Color tone:(0)

Linear setting (p.29)

Color saturation:(0)

z

IUnsharp mask 'J
Strength:(0) [
Fineness:(0) I H

Threshold: (1) ]

Color tone and color saturation
adjustment (p.29)

— Sharpness adjustment (p.31)

[ [Sharpness hd ] J
Sharpniess: (1) {1

Enlargement display position*

*

If an image is displayed enlarged, the enlargement display position can

be moved by dragging. The enlargement display position appears
when [Docking display] (p.81) has been set and the editimage window

(p.120) has been enlarged.

RGB Tool Palette (p.60)

| IMG_0001.CR2 ,
Raw 7G| miLensiato)]
|T0ne curve assist Ea
|Tor|e curve adjustment
! |[r][c][e]

255

0

Brightness:

Contrast:

Hue:

Saturation:

Sharpness: [}

-
H

Automatic adjustment
(tone curve assist) (p.33, p.93)

Click white balance (p.95)

Tone curve adjustment
(p.58, p.97)

Dynamic range adjustment (p.98)

Brightness and contrast
adjustment (p.94)

Hue and Saturation adjustment
(p.96)

Sharpness adjustment (p.96)

Enlargement display position*
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NR/Lens/ALO Tool Palette
(When a RAW image is selected)

mcooncre M [
RAW [RGB | NRAens/ALO |
| Auto Lighting Optimizer |
U It Auto Lighting Optimizer (p.61)
Low Standard Strong J
[ Noise reduction o —f— Apply noise reduction button (p.62)
- [ MRPreview... Displays the [NR Preview] window
Luminance noise reduction: (1) (p62’ p1 1 8)
g il 2 Luminance noise reduction for

RAW images (p.62)

Chrominance noise reduction:(3)

0 0 ) Chrominance noise reduction
TIFF[PEG for RAW images (p.62)
Lens aberration correction Tune... H Lens aberration correction tuning
Peripheral illumination 35 ) bUtton (p65)
Chromatic aberration OFF
Color blur OFF

H— Lens aberration correction (p.65)

Distortion OFF

Enlargement display position*

* If animage is displayed enlarged, the enlargement display position can
be moved by dragging. The enlargement display position appears
when [Docking display] (p.81) has been set and the editimage window
(p.120) has been enlarged.

NR/Lens/ALO Tool Palette
(When a JPEG or TIFF image is selected)

IMG_0001.JPG

Raw [Ree | /MRfens/ALG |

[ oise reduction i: Apply noise reduction button (p.99)
[ MRPreview.. Displays the [NR Preview] window
o (p.99, p.118)
TIFFfIPEG
e Luminance noise reduction for

o [l 20

JPEG and TIFF images (p.99)

Chrominance noise reduction for
JPEG and TIFF images (p.99)

Chrominance noise reduction: (1)

o [ 20

Enlargement display position*
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List of NR Preview Window Functions (62 p.99)

Introduction

|

Contents at
‘ a Glance

' NR Preview

|

; e Apply noise reduction Basic
| Opeiaton
—_—
. Advanced
Enlgrgement display Operation
Navigator window Advanced
Image Editing
and Printing
S —
Image type*
_ : — < Processing
[Lumlnance noise reduction: (7) ‘ ‘ Luminance noise Lar%(-i Numbers
L 0 = reduction __or'mages |
Chrominance noise reduction: (8)
Chrominance noise Editing
0 i 20 ) reduction JPEGITIFF
Images
_
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NR check window

* When you select a JPEG or TIFF image and display the [NR Preview]
window, [TIFF/JPEG] appears and you can reduce luminance noise
and chrominance noise for the JPEG and TIFF images.



List of Quick Check Window Functions .16 p.18)

50% view/100% view (moiré reduction off)/full view*'
Path and file name of image Displays the image in full screen*?

Check mark display "'Ew [EEEN Removes check

*** e ” marks (p.18)

Check marks (p.18)
Rating mark display ——

_ 5 - _ o - Rating (Reject)
7 e o T - (p-18)
B : Rating (p.18)
H Switches between

displayed images
Displays the AF
poins (p.16)
Displays the image
| Roateirt || motterin | information window
(p.24)

Image rotation
(90 degree units)

Image Information ]

*1 You can select 50% view/100% view (moiré reduction off) by selecting
[Preferences] in the [Tools] menu and using [Quick check tool display]
in the [View settings] tab sheet. You can also move the display
position in the enlarged display by dragging the image.

*2 To return to the normal screen, press the <Esc> key.
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List of Edit Image Window Functions (.34 p.36)

Shows/hides tool palette
Shows/hides thumbnail display area
Switches to main window (p.112)

Image path and file name i e P

Edit View Label |Adjustmept Tools | Help

Toolbar

|
|
|
’_]g —eomion |
|
|
Thumbnail display area*3 ’
|

o
-

®
| \em msooacz

LEm . MG omscR2

-

(998, 984) : 99,118,162  RAW [ Adobe RGE CMYK High quality

Information display*2

Shows/hides grid*4
Image information (p.23)

Enlargement ratio of displayed image

Displays the copy stamp window

angle adjustment window
(p.69 to p.73, p.103 to p.107, p.124) (p-38, p.100, p.122)

- (=)

( Displays the trimming/

Batch conversion/
saving
(p.88, p.89, p.125)

H v & @ P

Rotzte left Rotste right Stamp Trimming Batch

Angle process
RAW |RGB | NR/Lens/ALO

‘ Brightness adjustment

{0 0.00

Image rotation
(90 degree units)

‘Whib& balance adjustment

Register...

[5hut settings '] [ Tune...

Switches between
displayed images

[Picture styke il

[5Iandard 'H Browse... ]

; ’t /i | 31— Tool palette
DLk ocd AR (p.116)
-10.0 80 60 40 -20 0.0 20 40
Contrast:(0) i}
Highlight: (0) ¥
Shadow:(0) ¥
[ Linear
Color tone:{(0) {}
Calor saturation:{0) {}
[Sharpﬂess ']
Sharpness: (1) {

Image color space*! and work 4
color space (p.73, p.82)

*1 RAW images are displayed with [RAW].

*2 Displays the coordinates of the cursor position and the RGB values
(8-bit conversion).

*3 Displays images selected in the main window. The image selected
here is enlarged and displayed on the right.

\— Display mode*>

CMYK simulation display (p.82)

*4 You can set the grid spacing with [Grid pitch] in the [Preferences]
(p.80).

*5 The item selected in [Viewing and saving RAW images] (p.78) of the
[Preferences] window is displayed.
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List of Convert/Save One Image Window Functions (.42 .
—
&Y Convert and save
L - Contents at
. Sever|| B Photo o2 o a Glance
Types of image —
l' -
Type of image Extension || ot Basic
Exif-JPEG JPG Recent Places Operation
Exif-TIFF 8bit TIF i
TIFF 16bit .TIF T g J000K_XK_30K . Advanced
Exif-Tiff 8bit+Exif-JPEG | .TIF/.JPG = Save destination Operation
TIFF 16bit+Exif-JPEG | .TIF/.JPG Fibiarie —
' Advanced
"l'! Image Editing
Computer and Printing
D
W
File name : N%rk C I Processing
File name: IMG_0001 - Save La;gfe"ﬁ:rgng:rs
Saveastpe:  |Edf-JPEG(JPG."JPEG) +) [ Cancel |
JPEGITIE
mage quali ! i *3
Resolution*! Image quality 0 w JPEG compression rate Images
Output setting |
Output resolution 350 dpi [¥] Embed 1CC profile in image
Embeds of ICC profiles*2 (p.127) | Reference
Resize setting A
DResize
Size changing*4 . .pixel
Lodk aspect ratio
*1 The setting range is 1 to 60,000 dpi. *3 The setting range is 1 to 10. The higher the numerical value, the higher @ @

*2 Color space (p.73, p.82) information that is set in an image is attached
to an ICC profile.
Even if you remove the check mark from images that have been set to
Apple RGB, ColorMatch RGB or Wide Gamut RGB color space (p.73,
p.82), the ICC profiles are embedded automatically. 121

the image quality becomes.
*4 The larger of the two values set in [Width] and [Height] is applied to the
longer edge of an image and change its size.
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List of Trimming/Angle Adjustment Window Functions .3z, p.100)

Cancels all the trimming (aspect ratio) information

T
—]

Full screen

= 1/ 1 EAUsers\CANOMN\Pictul _ . . i ——

l Clear

Aspect ratio
Free
1.50 i

Reset

X
04 362

idt Heigl
1577 x 1051

Angle 10.10 =

‘ Rotate left Rotate right

| Copy

/] Show borders

|
Cpadty l

5]

[] Show Grid
Grid Dltd'l

| Center on Screen

Cancel

(704, 362) -» (2281, 1413) = (1577 x 1051) [ 1.50]

. - I—

Trimming range
it to another image*2

Full screen display/returns to normal screen

Reverts to the condition when the image was shot

Ratio of trimming range (you can also enter
numerical values if you have selected [Custom])*1

Upper left coordinates of trimmed range (you
can also enter numerical values)

Size of trimmed range (you can also enter
numerical values)

Angle of image adjusted

(Drag bar, use the mouse to click A/V or enter
numerical values to set angle)

Applies the copied trimming range to all other
images*2
Switches between displayed images*?

Displays borders around a trimmed range
Level of opacity outside a trimmed range
Shows/hides grid lines

(Drag bar to set distance between grid lines)

Displays the trimming range in the center of the
window

Copies the trimmed range and applies (pastes)

Image rotation (90-degree increments)

“1 If [Free] has been selected in the [Aspect ratio] list box, you can also
drag the borders of the trimmed range to change its range.

*2 Operates when you have selected multiple images and the trimming/
angle adjustment window is displayed.

Introduction

Contents at
a Glance

Basic
Operation

Advanced
Operation

Advanced
Image Editing
and Printing

Processing
Large Numbers
of Images

Editing
JPEGI/TIFF
Images

Reference

00
©

122



List of Lens Aberration Correction Window Functions 65

When the list box for selecting an extender is displayed in the To correct distortion aberration of images shot with a fisheye lens,
[Lens aberration correction] window, select the extender four effects can be selected from the [Effect] list box in addition to
attached at the time of shooting from the list box. [Shot settings] normally used for distortion correction.

e
i Lens aberration correction - [IMG_0001.CR2]

Enlargement display section*!

Reverts to the condition when the
image was shot

Shooting distance information
slider*? (p.68)

Peripheral illumination correction

[7] Peripheral illumination

| Chromatic aberration

Chromatic aberration correction

)( Corrects blue chromatic aberration

Color blur correction
Distortion correction

Distortion

Shows/hides position of
enlargement display section
>

jad. ) Grid display

| OK | | Cancel

Enlargement display position
(Navigator display)

Corrects red chromatic aberration
*1 The area you clicked on the image (Enlargement display position) is *2 For RAW images shot with MP-E 65mm /2.8 1-5x Macro Photo or EF
displayed at 200%. 50mm /2.5 Compact Macro with Life Size Converter EF, the slider
indicator changes to the zoom magnification.
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List of Copy Stamp Window Functions (.69t p.73,p.103 to p.107)

| 100% view H Full screen

[ Apply Dust Delete Data

Repair

(Dark)

Repair
{Light)
OO | @O

Select Copy Source

[] Fix Copy Source position

Pen type
@ Brush

Radius
=

[Undo

Copy

Paste

[ Previous

J{

MNext

1

Full screen display/returns to normal screen
Applies Dust Delete Data (p.69, p.103)

Types of dust to be erased (p.71, p.105)

Specifies the copy source (p.73, p.107)
Fixes the copy source position (p.73, p.107)

Types of stamps (p.73, p.107)

Sets the size of the dust erasure range (p.71,
p.105) or copy range (p.73, p.107) in a range of
5to 100 (in one pixel units) (you can also enter
a numerical value)

Restores/redoes the image

Copies the dust erasure range or copy range
and applies (pastes) it to another image

[ ok

J(

Cancel

]

Set to 100% view to perform stamp operation

"

* Operates when you have selected multiple images and the copy
stamp window is displayed.

Switches between displayed images*
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List of Convert/Save Multiple Images Window (Batch Processing) Functions (v.ss) .
—
 Batch settings (S|
. . v IMG_0001.CR2 Save folder ‘ Contents at
Flle names Of Images to be '! mg‘ggg%gg% E:\Users\User'\Pictures Save deStination a Glance
batch saved }:giggg‘;gsi . H SRR
_ . File format
IMG_0006.CR2 )
mg:ggg;:gsi (lqnd of file Exif-JPEG -] H Types of image 5 Basitg
IMG_0003.CR2 : ration
| B . i Type of image Extension L
Embeds ICC profiles™? (p.127) —jebocaz St e 1 Exif-JPEG JPG
IMG_0014.CR2 Output resolution 350 dpi [¥] Embed 1CC profile - N
Resolution*1 1MG0015.CR2 ! Exif-TIFF 8bit TIF Advanced
s ) TIFF 16bit TIF Operation
. _— °id ; Exif-Tiff 8bit+Exif-JPEG | .TIF/.JPG
Size changing*4 pixel : ;
TIFF 16bit+Exif-JPEG | .TIF/.JPG Advanced
. Image Editing
L Lock aspect ratio | and Printing
i N\ . S —
= — JPEG compression rate*3
' Processing
Large Numbers
e of Images
- String Sequence number File name
DPP_ 0001 Edlting
El Save seguence number JPEG/TIFF
Ex.: DPF_0001.JPG, DFP_0002.JFG... Images
f Image transfer settings
Openimage using software Batch transfer to other image editing Reference
software (p.89)
|mageS tO be Converted are |[ Convert RAW images only ] [ Execute ] I Cancel ]
limited to RAW images*>
Save
*1 The setting range is 1 to 60,000 dpi. *3 The setting range is 1 to 10. The higher the numerical value, the higher
*2 Color space (p.73, p.82) information that is set in an image is attached the image quality becomes. @ @
to an ICC profile. *4 The larger of the two values set in [Width] and [Height] is applied to the
Even if you remove the check mark from images that have been set to longer edge of an image and change its size. @‘
Apple RGB, ColorMatch RGB or Wide Gamut RGB color space (p.73, *5 Appears when you click the [Batch process] button (p.112, p.120) S—
p.82), the ICC profiles are embedded automatically. without an image selected in the main window or the edit image

window. To convert RAW images only, instead of clicking the [Execute]
button, click this button. 125



Order in which images are sorted

Check mark to apply the same
name to RAW images and JPEG
images recorded simultaneously

Check mark to copy the images
Click the [Browse] button and set
the save destination

List of Rename Window Functions .20

\

(File name Extension
DPP  Shooting Date,Time » Sequence number ~ | Do not change -

( Basic Settings

Sort
(@) Fit to main window
() File name

() Shooting Date/Time

Same file name for RAW +JPEG images )

( Format settings
Sequence number

ool [ save sequence number

Shooting Date/Time

[Year Month Day

[rv4mo0

( [ copy and Reename

Browse...

E:\Users\CANON'Pictures

Original File Name

Insert underbar

.

\

Modified File Name

IMG_0001.CR2
IMG_0001.JPG
IMG_0002.CR2
IMG_0002, PG
IMG_0003.CR2
IMG_0003.JPG
IMG_0004.CR2
IMG_0004.JPG

DPP_06-09-13_0001.CR2
DPP_06-09-13_0001.JPG
DPP_06-09-13_0002.CR2
DPP_06-03-13_0002. PG
DPP_06-09-13_0003.CR2
mp | DPP_06-03-13_0003.JPG
DPP_06-09-12_0004.CR2
DPP_06-09-12_0004.JPG

(Beae ] |

Cancel

Sets the new file name

Sets the format of information
in the file name

J
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Glossary
RAW image

EOS DIGITAL camera RAW images are recorded in an uncompressed
14bit or 12bit format.

Because RAW images are special images in an undeveloped status,
you need software with development processing functions such as DPP
in order to view them. The advantage of the undeveloped RAW images
is that you can make a variety of adjustments to RAW images with
almost no deterioration of the image.

* “RAW” meaning “in a natural condition” or “not processed or refined”.

JPEG image

The most ordinary image in non-reversible compressed 8bit format.
The advantage of this is that by saving at a high compression rate, the
file size can be small, even for image data that has a high pixel count.
Because during saving and compression part of the data is thinned out
to make the file size small, every time you edit or save, the image
deteriorates.

With DPP, even if you repeat editing/saving, only the recipe data is
modified, and no overwriting or compression occurs so the original
image data does not deteriorate.

* JPEG is an abbreviation of “Joint Photographic Experts Group”.

TIFF image

Bitmap-format image recorded in a 8bit/16bit uncompressed format.
Because TIFF images are in uncompressed format, they are suitable for
saving an image while maintaining the original high image quality.

* TIFF is an abbreviation of “Tagged Image File Format”.

Recipe

The “Image processing conditions information” for RAW images that can
be edited in DPP is called a “recipe”.

Further, in DPP, you can perform image editing on JPEG and TIFF
images that use “recipes” as with RAW images.

bit number

Binary unit of information volume in the color of an image. The number
shows the number of bits per pixel.

The larger the number of bits, the more the color numbers and the
gradation becomes smoother. A one-bit image is a black-and-white
image.

Color Management System (Color Matching)

Digital cameras that shoot images, monitors that display images, and
printers that print images each have a different way of creating color. For
this reason, there may be a difference between the color of an image
when viewed on a monitor and when printed.

A color management system is a system for managing color in order to
bring these colors closer together. With DPP, you can more closely
match color between different devices using ICC profiles between
different devices.

ICC profiles

ICC profiles are files containing color information such as color
characteristics and color space for various devices, set by the ICC
(International Color Consortium). Most devices such as the monitor we
use to view images or the printer we use to print images can be
managed (color management) using these ICC profiles and the color
between different devices can be more closely matched.

DPP has color management that uses these ICC profiles.

Tone Curve

A tone curve shows values before adjustment (input) as the horizontal
axis on a graph, and the values after adjustment (output) as the vertical
axis. Since the values of before adjustment and after adjustment are the
same before any adjustment is made, the tone curve displays as a
straight line from bottom left to top right, and by changing this tone
curve, you can adjust in detail the image’s brightness, contrast and
color. The more you go right on the horizontal axis, the more the plus
value it becomes, and the higher you go on the vertical axis, the more
the plus value it becomes.
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Introduction
Color space CMYK simulation profiles
A color space is the reproducible color range (color gamut A profile that simulates colors when printing in a CMYK environment
characteristics). DPP supports the following five kinds of color space. (printing machine, etc.). With DPP, you can simulate color with four Contents at
sRGB : Standard color space for Windows. Widely used for types of profile. a Glance
the standard color space of monitors, digital Euro Standard : Profile normally used for book printing in
cameras, and scanners. Europe, suitable for simulation of standard
Adobe RGB : A wider color space than sRGB. Mainly used for European printing. Basic
printing for business purposes. JMPA : Profile normally used for book printing, etc. in RpSiatel
Apple RGB : Standard color space for Macintosh. A slightly Japan, suitable for simulation of magazine
wider color space than sRGB. advertising standard color printing. Advanced
ColorMatch RGB : A slightly wider color space than sRGB. Mainly U.S.Web Coated : Profile normally used for book printing in Operation
used for printing for business purposes. North America, suitable for simulation of
Wide Gamut RGB : A wider color space than Adobe RGB. North American standard printing.
Refer to the color chart below for the color area of each color space. JapanColor2001 type3 : Profile becoming a standard in the Japanese Advanced
TN ; ; ; Image Editing
printing industry, swtablg fpr simulation of B siabinG
Color chart of color spaces compatible with DPP JapanColor standard printing.
Processing
y . .
o Rendering intent Lazgf?rﬂ:';‘é’i =
E— Adobe RGB Rendering intents are color conversion methods when printing an image.
p— %E’f’iﬁ{fgs The conversion method of each rendering intent is shown below. Editing
06 Perceptual : Before and after conversion, all colors are JPEG/TIFF
Color range that can be converted to maintain the relationship between LTEES
seen by the human eye colors. Even where colors slightly change, you
04 can print a natural-looking image which has
maintained color harmony. However, Reference
depending on the image, the saturation may
02 change overall.
Relative Colorimetric : There will not be much conversion to colors
which are similar before and after conversion,
0 02 04 08 08 X but colors which are not similar are converted
appropriately. Because there are little changes
Gamma White point to similar colors which comprise most of an @ @
value (color temp.) image, you can print a natural-looking image in
—— | sRGB 2.2 6500K(D65) which the saturation has not changed greatly.
R Adobe RGB 2.2 6500K(D65) However, depending on the image, there are
............ Apple RGB 1.8 6500K(D65) cases where the overall tone of an image
————- ColorMatch RGB 18 5000K(D50) chapges somewhat as colors which are not
______ Wide Gamut RGB 292 5000K(D50) similar and highlights change. 128
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AdJUSt JPEG IMAQgES.....ceiiiiiiiiiiiiiiieee et 92

Adjust RAW IMaAgES .. .. eeeeeeeeeeeneeeeees 25

AdJUSE TIFF IMageS......uueiiiiiiiiiiiiiiii e 92

Adjusting (JPEG or TIFF Image)
Automatic Adjustment (Tone Curve AsSist)........ccoceviiiiiiiiiccnnnnnns 93
BrGNINESS ..o 94
Click White BalanCe ..........coooiiieiiiiieeeeeeeeeee e 95
CONEFAST ... 94
DynamiC RanQe......coooeiiiiiiiiiiiiiiieiii e 98
HUEB e 96
RGB Tool Palette .....oovveeiiieeieeeeeeeeeeeeeeeeeeeeeeee e 116
SaAtUratioN ... 96
SNAIPNESS ...oiiiiie e 96
Tone Curve Adjustment..........ccciiiiiiii e 97

Adjusting (RAW image)
Apply AdJuStMENts. ... 86
Automatic Adjustment (Tone Curve AsSist)........ccccoeiiiiiiiiiinnnnns 33
BrGhINESS ... 26
Brightness of Highlights............coooiiiiiii 57
Brightness of Shadows............cciiiiiii e 57
Click White BalancCe ............cccvvvveiiiiiiiiiiiiiiiiiiiiiiiiiviieeeeevveenneennens 28
Color SAturation ...........ceeeiiiiiiie e 29
(070] (ol gl =10 0] o 1=T =1 (01T 56
COlOr TONE....ueeiiei bbb abrsaasaasesssssasssasssnnes 29
Color WHEE ... 56
CONrast... .o 29
Copy AdJUSTMENTS ....oeiiiiiieiii e 86
DynamiC RanNQe......couuuuiiiii e 57
Filter Effect ... 30
MONOCAIOME ... 30
Personal White Balance ...........ccccovvvvviiiiii 87
Picture Style ... 26
Picture Style File ... 59
RAW Tool Palette..........oeieiiiiiieeeeeeeeeeeeeeeeeeeeeeeeeee e 116
Save AdJUSIMENTS .......uvviiiiiiiiiiiiiiiiiiiiet e 86
Tone Curve Adjustment..........ccciiiiiiiie e 58
ToniNg EffeCt ... 30
TOOI Palette ....c.eeeeeeeeeeee e 116, 117

White BalanCe.........oooooiiiii e 27
Adjustment Contents (ReCIPe).........coviuiiiiiiiiiiiiice e 85, 127
AdODE RGB ... 128
Y o] o] L= 21 = TP 128
AIrange IMagES ....covvuuiiii i e e e e e e e e eeees 20, 21
Auto Lighting Optimizer .........c.ouviiiiii e 61
Automatic Adjustment (Tone Curve AsSist)....ccccccccvveeviiiiiininnl. 33, 93
Automatic Dust Erasure Processing.......ccccccvvveveevveeneenn. 69, 70, 103, 104
B
Batch Apply White Balance to Images (Personal White Balance)....... 87
Batch Change the File Name of Images.........cccccccviiiiiiiiiiiieiiie, 90
Batch Convert/Save Images (Batch Process) .........ccccoeevveeeiiiiiinneen. 88
Batch Process (Batch Save JPEG and TIFF Images)................. 88, 125
Batch Process of Multiple Images

Change File Name .........ooiiiiiii e 90

Convert/Save (Batch Process)........ccccvvvvvvvevivviiiiiieeeeeveeeeeee. 88, 125

Personal White Balance...........ccccooiiiiiiii e 87

Recipe Data ........ccooiiiiice e 85

LI = 1015 1= U RRPRR 89
Batch Settings WIindow..........coooiiiiies 88, 89, 125
Batch Transfer IMages ..........cuviiiiiiiiiiiiiiiiiiiiiiiieeeeeveeee e 89
Batch Transfer Images to Image Editing Software ...............cccoonnin. 89
Before/After Comparison Display ..............euvviiieevieirieiiieieeeeeeeeeeeeeeeeeee 53
DIt NUMDEr ... 127
BOOKMAIK ... 51
BrghINESS. ... 26, 94
C
Change File Name..........oooiiiiiiiiee e 90
Changing the File Name of Images in the Order in the Main Window. 90
Check Mark ........c.ooiiiiiie e 18, 19, 114, 119
Chromatic Aberration Correction ..o, 65
Chrominance Noise Reduction (JPEG, TIFF Images)......c.....ccccuvvveee. 99
Chrominance Noise Reduction (RAW Images) .........ccccuvveeeeeeiiiiiiinnen. 62
Click White BalanCe.........oeeeeeeeee e 28, 95
CMYK Simulation .......c.eoveiiiiiieiiiee e 82, 83, 128
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Collection WINAOW ......coeeeeeee e 6, 36, 113
Color Blur Correction .........coceeiveiiiiieeeeeee e, 65
(©70] o] g @1 o F- T SRR 128
Color Management (Color Matching).........cooocuviiieiiiie e 127
Color Setting of the Monitor (Profiles) ........ccccccevviciiiiiieeceiie 82
Color Setting of the Printer (Profiles)..........cccccciiiiiiiieen. 82, 83
COlOr SPACE......ci ittt 128
ICC ProfileS ..coooveieieeeeee . 127
Color Management (Preferences)........cccccceoviiiii, 82
Color Saturation ... 29
Color Setting of the Monitor (Profiles)................ccccccl, 82
Color Setting of the Printer (Profiles) ..., 82, 83
Color SPaCe ....ccooveiiiiiii 128
AdODE RGB ... 128
APPIE RGB ... 128
Color Space Setting for Each Image ..........cccccoviiiiiiiinieiiine 73
ColorMatch RGB .......ooiiiieeeeiee e 128
Default Setting of Color Space ..........cooccvviiiieeeiiiiee e 82
SRGB ... e a e 128
Wide Gamut RGB........coooii 128
Color Space Setting for Each Image...........coocuvviiiiiiiiiiiiiiiieeeee e 73
Color Temperature..........ccccoooeiiiiii 56
ColOr TONE .o, 29
(O] (o] YA Lo PSRRI 56
ColorMatch RGB.........ccooieiie e, 128
Compatible Cameras with the Lens Aberration Correction Function.. 63
Compatible Lenses with the Lens Aberration Correction Function..... 63
Contact Sheet Printing (Printing a Thumbnail List)............ccccceeeennes 75
[076] 011 7= 1) AUUTT TP 29, 94
Convert to JPEG or TIFF Image and Save................... 42,88, 121, 125
Convert/save One Image Window ..............cccoeeeeeeeeeeee e, 42, 121
Copy Stamp (Image Correction) ........ccceeeeeeeeiiiiiiiiiieee e 73,107
Copy Stamp Window ... 69, 71, 103, 105, 124
Copying and Pasting (Applying) ReCIipes.........ccccvvvieeeiiiiiiiiiiieeeee e 86
Correct Images (Copy Stamp Function) ............................ 73, 107
Creatinga Folder ... 50

D

Default Noise Reduction Settings...........ooovciiiiiiiiiiiiiiie 81
Default Setting of Color SpPace ..........ccvevviiiiiiiiiee e 82
Delete IMages ... ... 49
Deleting

Delete IMagesS.......ooo v 49

Delete the Software ...............ccc 111
Deleting DPP (Uninstalling) .........cccccceeiiiuiiiniiiiiiiiiiiiiiiievveevveseresveeeene. 111
Detailed Setting Printing (Printing with Shooting Information)............. 74
Display

Before/After Comparison Display..........ccccooeeeieiii 53

Enlarged Display (Edit WiNdOW) .........c.ceuviiieiiiiiiiiieeeeeeee 11, 115

Enlarged Display (Quick Check Window) ...........ccceeeveeeennnes 16, 119

Shooting Information Display .........cccccccvviivviiiiiiiniiiiiiiiiinnenns 10, 23

Single Image Display .........cooooiiiiiiiieee e 22

Synchronize Edit WINAOW ...........oveiiiiiiiiiieeee e 54

Thumbnail Display (Main Window).............cccuveeeeiiiinniiienee. 10, 112

Thumbnail Display and Enlarged Display

(Edit Image WindOoW)........ccuueiiiiiieeiiiiiieee e 34,120
Distortion COrreCtion ............eviiiiiiiii i 65
Downloading an Image to Your Computer ............ooccuviiiieeiiiiiiiiiiieeeee. 7

Downloading Images froma Camera .................cccoeeeeeee . 7

Downloading Images from a Card Reader..............ccooeciiiiveneennnnns 9
Downloading IMages ......ccuuiiiiiiiiiieeeie e 7
Downloading Images from a Camera............ccccuvvvvivvniinninnniiirinineninnnnnn, 7
Downloading Images from a Card Reader ............coccviiieiiiiiiiiiiiiiee.
Dust Delete Data ..........ccccoveiiiiiieeeeee e
Dust Erasure Processing

Automatic Dust Erasure Processing .......cccccvvvvveeiiiieieeeeeennns

Image Correction (Copy Stamp Function)

Manual Dust Erasure (Repair Function) ...........ccccccvvveeeeinns
DynamiC RANGe ........c.cuuiiiiiiiiiiie e 57, 98
E
Edit Image WindOW.........cooveeviiiiiee e e e e 34,120
Edit WINAOW.......e e 11, 115
Editing. ..o —Adjusting
Enlarged Display (Edit WiNAOW) ........coooiiiiiiiiiiiiiiiieeceeeeeee 11, 115
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Enlarged Display (Quick Check Window) ..........cccccceeeiiiiiiiiniiinncenns 119
EOS Uiy . .eeeeeeeeee e 7
EXItING DPP ...t 14
F
False Color REAUCHION .......oeeeeeee e 78,79
Filter Effect.....ooo 30
Folder WINAOW ... 6, 112
G
General Settings (Preferences) .........cccciiiiiiiiiiieee e 78
H
L1 Cover
Highlight Area Warning Indicator ...........cooooi oo, 55
HUE s 96
|
[CC PrOfileS ...t 127
Image Frame Information (Image Marks) ........cccccoiiiiiiiiiiiiiniiiiinne. 114
Image Marks (Image Frame Information) .........ccccccvveviiviiiniinniinnnnn.. 114
Image Quality
Default Noise Reduction Settings............cccccoe, 81
False Color ReAUCHION ........e e 78,79
Improve the Quality of an Image (Main Window) ............cccceeeeee.. 23

Noise Reduction of a JPEG Image (Luminance, Chrominance).. 99
Noise Reduction of a RAW Image (Luminance, Chrominance) ... 62

View and Save aRAW Image...............ccco, 78,79
Image Shooting Information Display .............ueeveviiiieiieiiiiiiieeieeenee, 10, 23
Improve the Quality of an Image (Main Window)..........cccccoiiviiiennnn. 23
J
N LG [ 4= o = SRS 127
L
Lens Aberration CorreCtion ...........c.uvveeeiieeiiiicieeeee e 63
Lens Aberration Correction Window ..........ccoooevviiiiiiiiiiiieiieeeees 65, 123
LN e 29
Loading and Pasting (Applying) ReCIPes .........cccceiviiiiiiiiiiiiieiie 86
Luminance Noise Reduction (JPEG, TIFF Images).........cccccccvvvunnnnnn. 99

Luminance Noise Reduction (RAW IMages) ......cccccoevvvvveeeeeeeeeeicnnnnen. 62
M
MaIN WINAOW ... e e e 10, 112
Manual Dust Erasure (Repair Function) ..........ccccccooviiiiieenennnnne 71,105
MONOCNIOME. ...t 30
Filter EffecCt......oov i 30
ToniNg EffeCt ... 30
MoVe Or COPY FOIAEIS .....cooiiiiiiiieieeee e 51
MoVe Or COPY IMAGES ...eevveeeiiiiiiiiiiiee et 50
N
Noise Reduction (JPEG or TIFF Image)........cccccvvvvvvieveeeeieiieeeeeeeeeeeeee, 99
Noise Reduction (RAW IMage) ........cccooiiiiiiiiiiiiiiiiieeeeeee e 62
Noise Reduction of a JPEG Image (Luminance, Chrominance) ......... 99
Noise Reduction of a RAW Image (Luminance, Chrominance) .......... 62
NR Preview WIiNdOW .........occviiiiiiiiiieeee e 62, 99, 118
NR/Lens/ALO Tool Palette ... 117
o
Organize IMages .....coooeiiieiieee et 49
Organizing IMagES .......uuuiiiieeiiiiiie e 49
Create @ FOIder ... 50
Delete IMages.......oovii i 49
Move or Copy FOIAErS..........uiiiiiiiiiiiieeeee e 51
Move Or COPY IMAGES .......uuviiiieeiiiiiiiiiiiiee e 50
Register Folders as Bookmarks.........cccoooeevvvviiiiiiciiiieeceeeeeen, 51
P
Peripheral lllumination Correction .............cccevveeviieeiiiieeiieieieeeeeeeeeeeee, 65
Personal White BalancCe ...........ccooviiiiiiiieiiici e, 87
PiCture SEYIE ...ooeeeeeeeeee e 26
Picture Style File...........oeeieeiii e 59
PreferenCes ....oooo oo 78
Color Management ... 82
General Settings .......ovvi i 78
TOOI Palette......cocoeiii e 81
VIEW SEHHNGS ..eeeieiiiiiieeeee e 80
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Printing
Printing a Thumbnail List (Contact Sheet Printing) ...................... 75
Printing One Sheet of Paper ..., 14, 49
Printing Using Easy-PhotoPrint ..o 46
Printing Using Easy-PhotoPrint EX ... 43
Printing with a High-End Canon Printer............occvviiiiniiinee. 76
Printing with a Large-Format Canon Printer............cccccccoeeiinnnee. 77
Printing with a Printer other than Canon Printers ......................... 49
Printing with Canon Inkjet Printers ..........coovvvviviiiiiiiiiieeniennnen, 43, 46
Printing with Easy-PhotoPrint Pro ..o 76
Printing with Shooting Information (Detailed Setting Printing)...... 74
Rendering Intents when Using Easy-PhotoPrint .................... 82, 83
Printing a Thumbnail List (Contact Sheet Printing) ..........cccccccoviinneeen. 75
Printing One Sheet of Paper...........cccvveiviiiiiiiee e 14, 49
Printing Using Easy-PhotoPrint............coooi e 46
Printing Using Easy-PhotoPrint EX..........ccooiiiiiiiiee 43
Printing with a High-End Canon Printer...........cccocoviiiiii e 76
Printing with a Large-Format Canon Printer ............cccccoivieeiiiinnee. 77
Printing with a Printer other than Canon Printers..............ccccceeinne 49
Printing with Canon Inkjet Printers............cccovveeeiiiiiiieee e 43, 46
Printing with Easy-PhotoPrint Pro..........ccoooo e 76
Printing with Shooting Information (Detailed Setting Printing) ............ 74
Q
QuUICk Check WINAOW........cuuuiiiiieie e 16, 119
R
RaAtING. ..o 18, 19, 119
RAW IMAQE....couieii ittt e e e 127
RAW ToOl Palette ..........ooeiiiiiiiiiieee e 116
Re-Adjusting an Image .........ccoviiiiiiieeeicccr e, 43, 108
RECIPE ... e 85, 127
RECIPE FilE ..o 85
Re-Editing an Image ... 43, 108
Registering Folders as Bookmarks..........cccooovvviiiiiiiciiieeeceen, 51
ReNamMe WINAOW ... 90, 126
Rendering Intent (Matching Method) ...........ccccvvviiiiiiiiiiiiiiieeeeeeeee, 128
Rendering Intents when Using Easy-PhotoPrint .................... 82, 83

Rendering Intents when Using Easy-PhotoPrint ........................... 82, 83
Repair (Manual Dust Erasure).........cccccovviiiiiiiiieeiiiiiiiiceeee e 71,105
RGB Tool Palette. .........coviiiiiiiiiieeeee e 116
Rotate Images ......cccoovvvvvivieiiicii e, 10, 25, 112, 113, 119, 120
S
SatUratioN ..o 96
Save
Batch Convert/Save Images (Batch Process)..........cc.c........ 88, 125
Convert to JPEG or TIFF Images and Save .........cccceeeveee.ee. 42, 121
SV e 41, 107
SAVE Ao ——— 41, 107
Save JPEG or TIFF Image as a Separate Image ..........cc........... 108
View and Save RAW IMages.......cccceeveeeeiiiiiiiiiiieee e 78,79
S AV AS e 41, 107
SaViNg RECIPES.....cco i 86
SeleCt IMages......cooooieiie s 10, 16, 34
Shadow Area Warning Indicator............cccoooiiiiiiiiiiiiiis 55
SNAIPNESS ...t 31, 96
Shooting Information Display..............ccccciii, 10, 23
SHOMCUL KEYS ... Cover
Single Image Display ..., 22
Single Image Display of RAW and JPEG Image..........ccccccceeeviiiinnnen. 22
Sorting Images
CheCK Marks ......cooeeiiiie e 18, 19
RatiNgS .o 18, 19
SRGB ... e e e e e e e e e 128
Starting UP DPP ... 6
Supported IMages ..., 3
Synchronization (Edit WindOW)............coooiiiiee e 54
Synchronize Edit WIiNdOWS ..o, 54
SYNCroNiZE IMAGES .......uviiiiiieiiiiiie e 54
System Requirements ..., 3
T
Thumbnail Display (Main WindOW) ..o 10, 112
Change the Display..........cccccuuiuuiiiiiiiiiiiiiiiieiiieeieereeeeeeeeree e 10
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Thumbnail Display and Enlarged Display (Edit Image Window)......... 34
Thumbnail Display of Images (Main Window)...........cccccooiiiiiiennennnns 10
Change the Display .........ccouiiiiiiiiieeeeeceee e 10
TIFF IMAGE ... 127
TONE CUMVE ... 127
Tone Curve Adjustment ..........cooiiiiiiiiiiiiiiiiieeeeeeeeeeeeee e 58, 97
Tone Curve Assist (Automatic Adjustment) ..........ccccccovevin. 33,93
ToniNG EffeCt.....eeeeeee 30
Tool Palette
NR/Lens/ALO Tool Palette ..........covvvevveeiiiiiiiiiiiiiieeee 117
RAW ToOl Palette.........coieiieiieecce e 116
RGB Tool Palette .....oovvieiiieeiieeeeeeeeeeeeeeeeeeeeeeeeeeeeee e 116
Tool Palette (Preferences).......vvvvveevieiiiiiiiiiiiiiee 81
Transfer
Batch Transfer Images to Image Editing Software...................... 89
Transfer an Image to Photoshop ..o 73
Transfer an Image to Photoshop ..........ccccoeeeiiiiiiiiiieeeee e 73
Trimming and Adjusting the Angle of an Image........................... 38, 100
Trimming/Angle Adjustment Window .............ccccccvviveeennnnns 38, 100, 122
U
L g E g F= T o T 1Y = T 32
\'
View Settings (Preferences) ... 80
w
White BalanCe.......c..ooviviiiiiiieiieieee e 27
Click White BalanCe .......ccouoveeeeeeeeeeeeeeee e 28, 95
(070] (ol gl =10 0] o 1=T =1 (0 [T 56
(O70] o] T4 L= SRR 56
Personal White Balance ... 87
Wide GamuUt RGB ..........ouiiiiiiiiiiieeeeeeee e 128
WOrK COlOr SPACE.......uuuuiiuiiiiiiiiiiiiiiiitiiesrierrrressrssressresrserrrrrereereeer————— 73

About This Instruction Manual

It is prohibited to reproduce, in whole or part, the contents of this
Instruction Manual without permission.

Canon may change without notice the software specifications and
contents of this Instruction Manual.

The software screens and displays printed in this Instruction Manual
may differ slightly from the actual software.

The content of this Instruction Manual has been reviewed thoroughly.
However, if you should notice any errors or omissions, please contact
a Canon Service Center.

Please note that irrespective of the above-mentioned, Canon does
not take responsibility for the outcome of the operation of the
software.

Trademark Acknowledgments

Microsoft and Windows are registered trademarks or trademarks of
Microsoft Corporation in the United States and/or other countries.
Adobe and Photoshop are registered trademarks or trademarks of
Adobe Systems Incorporated in the United States and/or other
countries.

Other names and products not mentioned above may be registered
trademarks or trademarks of their respective companies.
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